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Overview 
This reference guide was designed to supplement a hands-on, instructor led session. Pictures of various screens 
have been included in order to show general information placement. Please note that these are standard screens 
and may not match exactly to those at your site. 

Learning Objectives 

At the end of this session, class participants will become proficient in the following processes: 
Specimen Management 
Organize Work 
Result Entry 
Order/Result Inquiry 
Management Review 

Course Length 

The System Validation Session is designed for 4 days. 

Course Audience 

The target audience for this course will consist of Cerner clients who will be responsible for: 

Testing PathNet General Laboratory  
Writing PathNet General Laboratory test scripts  
Training PathNet General Laboratory super users  

Prerequisites 

All participants are expected to be competent in the following areas: 

Computer basics  
Microsoft WindowsPowerChart  

Information Security and Confidentiality 
When dealing with computerized health care records, specific confidentiality and security issues must be followed to 
protect the patient. There are increasing HIPAA and JCAHO regulations that dictate how these records are handled. 

When selecting a password, don't choose anything obvious, such as your birth date, social security number, or 
spouse and children's names. 

Do not tell anyone your password. 

Your system may require you to change your password at regular intervals. 

When you open a chart you will be asked to identify your relationship to the patient, for example primary RN, 
consulting physician, etc. The system keeps an audit trail, or record, of who enters each chart and when. It records 
who read the chart and who recorded each piece of information in the chart. 

Security should be designed so that employees can only perform functions within the system that are necessary for 
their position/role. Also, employees should only be able to view data that is necessary to perform their job. For 
example, a lab technician should have the ability/security to utilize all of the functions within the PathNet® 
solution, but an ED Nurse should not have that ability. 

Do not leave the computer while still signed on. 

Do not access any charts that do not apply to your current job and caseload. 
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Each facility has its own specific confidentiality and information security policy. It describes the repercussions of not 
following these rules. 

Tips and Tricks 

Cerner Solution 

1. Press and release the secondary (usually right) mouse button and see if any of the menu items apply.  
2. Use your cursor to hover over the buttons to see if any of the button names jog your memory.  
3. If a single mouse click doesn't work, try a double mouse click.  

Help Files 

Complete one of the following steps to access Help for the application: 

1. Locate the Help file in the winintel folder where the Millennium applications are stored. The Help file 
shares the same name as the EXE file, except the file extension is .HLP. For example, the Help file for 
PowerChart.exe is PowerChart.hlp.  

2. With the application open and running from the appropriate domain, select HNA Topics or Help Topics in 
the Help menu, or press F1 on your keyboard.  

Solution Terms 

In the Help table of contents, located in the left pane of the application's Help viewer, expand the Glossary book, 
and then select the Glossary topic to display the glossary in the main pane of the Help viewer. Select the first letter 
of the term you want defined, then click the term to display the definition. 

Throughout Help, words in green font with a dotted underline indicate terms with definitions. Click on a term in 
green, dotted underlined text to display the term's definition. 

Solution Icons 

Solutions use unique icons to designate buttons that have specific functionality. To view the icons and their 
meanings for a particular application, open the table of contents, located in the left pane of the application's Help 
viewer. Expand the Menus and Toolbars book, and then select the Toolbar topic to display the application's icons in 
the main pane of the Help viewer. 

Getting Started 

Logging In 

Follow this procedure to log into the system: 

1. At the Main Menu window, double-click on the General Laboratory icon.  
2. At the Cerner log-in window, type your user name in the User Name field.  
3. Press the Tab key to move to the next field and type your password into the Password field.  
4. Click on the OK button or press the ENTER key.  

 

Logging Out 
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When you have completed your activities, remember to log out of the application you are working on for security 
purposes. Logging out can be done in one of the following three ways: 

1.  If you are exiting the application temporarily, but planning on returning to that computer shortly, 

click on the suspend user icon on the toolbar. This will return the screen to the log on window and place 
the cursor in the password field.  

If you want to shut down the application completely, you can click on the exit icon from the toolbar or the X in the 
upper right hand corner of your screen. Keep in mind that shutting down the application will require the next user 
to re-launch the application, which requires a greater amount of time. 

 
If you choose the icon displayed below, you will enter the Exit Application window. This first option available allows 
you to prepare the application for the next user. This will return the screen to the log on window and place the 
cursor in the user name field. The second option will completely shut down the application and the third option will 
allow you to suspend the application. 

  

 
 
 
 
 
 
 
 

Appbar Customization 

1. If you are unsure of whose appbar is in use, place the cursor over the  icon. Doing so reveals the 

Appbar's Username.  
2. Right-click on the Appbar to reveal options. The following menu appears:  

 

 
Suspend: When you step away from the terminal for a period of time and do not want another user to open 
applications during your absence 
Change User: If the previous user has left and you want to log in under your own Username select this option 
Auto Hide: Selecting this option hides the Appbar when it is not actively used. Moving the cursor to the area of the 
screen where the Appbar resides will reveal the Appbar again. To undo this option, right-click on the Appbar and 
re-select the Auto Hide option 
Always on Top: Selecting this option causes any other application open to not cover the Appbar. Attempts to 
Maximize application screens will maximize around the Appbar, not cover it. To undo this option, right-click on the 
Appbar and re-select the Always on Top option 
Allow Floating: Selecting this option allows you to move the Appbar to various locations on the screen. To undo 
this option, right-click on the Appbar and re-select the Allow Floating option. This locks the Appbar into one place 
on the screen. 
Large Buttons: Selecting this option increases the size of the icons on the Appbar. To undo this option, right-click 
on the Appbar and re-select the Large Buttons option.  

1. Clicking on the  icon reveals more options, some of which are repeated from the steps mentioned 

above. The following menu appears:  
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Change Password: Should not be used unless otherwise specified. Changing passwords frequently increase the 
chance of not remembering it! 
Applications: Selecting this option allows you to view applications for which you currently have security to access. 

Double-clicking on the  icon reveals more information regarding applications you have access to. 

Double-click on the  icon to reveal all applications for which you have access. 

Double-click on any one of the  icons to open that particular application on-demand. 

When finished, click Cancel or click the close button ( X ) in the upper-right corner of the screen. 
Customize: Selecting this option allows the user to choose Launch Bar States previously described in the above 
steps. 

Click on the  tab. This tab allows you to add/remove icons from your AppBar by clicking on the open box 

next to the application name. 
Once you select the desired applications, you can arrange those applications in any order using the Move arrows. 
The Insert Space option allows you to spatially separate icons on the Appbar according to how you choose to 
separate them. You can insert as many spaces as desired. 
When finished, click OK to save changes. To exit without saving, click Cancel.  
AppBar Example: 

 

General Lab Overview 

Definitions (Adding to your AppBar) 

Pending Inquiry: Use Pending Inquiry to view the list of ordered procedures, for a specific test site or subsection, 
that have not been completed. You have the option to view only the ordered procedures that have been received or 
all ordered procedures for the selected test site 
Worklist Request: Worklist Request is used to print a worklist or worksheet using a predefined worklist name. An 
existing worklist can be printed, or an adhoc worklist can be created. 
Accession Result Entry: Use Accession Result Entry to enter results for General Laboratory procedures ordered 
on a single accession number. You can select a specific ordered procedure and a test site to limit the information 
displayed for the selected accession number. 
Batch Result Entry: The Batch Result Entry application is used to enter results for a specific orderable item for 
multiple accession numbers. 
QC Inquiry: QC Inquiry displays QC results for a selected Test Site and Control for a specified date range, or for a 
select Control across all test sites. QC results can be marked as reviewed or corrected with QC Correction. On 
demand QC Reports can be printed from QC Inquiry. 
Order Result Viewer: Order Result Viewer is used to display the list of ordered items with access to results for a 
selected patient for a specified date/time range. 
Multiple Accession Review and Verification: Use Multiple Accession Review and Verification to quickly review 
and verify the results for one or more accession numbers. To edit a result, you can transfer the results for that 
accession number to Accession Result Entry. 
Point of Care Result Entry: This application is used for service resources that have been identified in the system 
as Point Of Care and enables a user to enter an order at the same time that the result is entered. 

Common General Laboratory Tasks 
Enter Results Manually by Accession Accession Result Entry 

Verify Results from an Instrument Accession Result Entry 

Enter Results by Worklist Accession Result Entry 

 Batch Result Entry 

Result a Differential Accession Result Entry 

Enter Results by Batch Mode for One Test Batch Result Entry 

Enter QC Results Accession Result Entry 

Error Correct Results Accession Result Entry 
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Department Order Entry 

Overview 

Departmental Order Entry (DOE) enables you to place laboratory and radiology orders. You also may add on an 
order to a previous order, cancel an order, and register a patient prior to entering orders. This application is utilized 
by laboratory and radiology personnel. Powerchart enables non-ancillary departments (i.e. Nurses, Physicians, etc) 
to place orders for the laboratory and radiology departments. 

Signing on to DOE 

From the AppBar, click on the  icon. 

Searching for a Patient by Name 

Complete the following steps to search for information about a patient by name: 

1. When signing onto DOE go to the View menu, select Patient and then select By Name.  
2. In the Client box, click the down arrow and select an organization from the list provided. (Selecting an 

organization is optional). Selecting the Client box limits your search to only patients associated to the 
client. The cursor defaults here when signing on. Press Tab to move to the Person Name box if not 
identifying any clients.  

3. In the Person Name box, enter the patient's last name. If you want to select the patient from a list of 
registered patients, you can enter the first few letters of the patient's last name. Press ENTER  

4. The Encounter Search dialog box is opened, in which you can select the appropriate encounter. If more 
than one encounter exists for the patient, they're listed in the Encounter Search dialog box. If multiple 
patients are listed, select a patient and encounter then press OK. The window now displays the 
patient's full name and demographic information.  

Searching for a Patient by Medical Record Number 

Complete the following steps to search for a patient by medical record number: 

1. When signing onto DOE go to the View menu, select Patient and then select by Medical Record Number.  
2. In the Medical Record Number box, enter the patient's medical record number. If you want to select the 

patient from a list, you can enter the first few digits of the medical record number (excluding leading 
zeroes).  

3. The Encounter Search dialog box is opened, in which you can select the appropriate encounter. If more 
than one encounter exists for the patient, they're listed in the Encounter Search dialog box. If multiple 
patients are listed, select a patient and encounter then press OK. The window now displays the 
patient's medical record number and demographic information.  

Searching for a Patient by Financial Number 

Complete the following steps to search for a patient by financial number: 

1. When signing onto DOE go to the View menu, select Patient and then select by Medical Record Number.  
2. In the Financial Number box, enter the patient's financial number. If you want to select the patient 

from a list, you can enter the first few digits of the financial number (excluding leading zeroes).  
3. The Encounter Search dialog box is opened, in which you can select the appropriate encounter. If more 

than one encounter exists for the patient, they're listed in the Encounter Search dialog box. If multiple 
patients are listed, select a patient and encounter then press OK. The window now displays the 
patient's financial number and demographic information.  

Transfer Procedures Pending Inquiry 

Add to an Existing Accession Departmental Order Entry 

View Test Results Order Result Viewer 

Review and Verify Results Multiple Accession Review and Verification 

Result Point of Care Testing POC Result Entry 

Create and Modify Worklists Worklist Request 

Review QC Results, Graphs QC Inquiry 

View Pending Work Pending Inquiry 

Note 
If a patient has not been registered prior to ordering a procedure, click the Patient Registration icon 

 to open the Registration window or from the Task menu, select Patient Registration.
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Registering a Patient 

Complete the following steps to register a patient: 

1. Click the Patient Registration toolbar button  . The Registration window opened.  

2. Enter all requested information. The system displays the message, Registration complete. New person 
and encounter added.  

3. Click OK to return to the previous window.  

Modifying an Encounter 

Complete the following steps to modify an encounter for a patient: 

1. Select a patient and encounter.  
2. Click Patient Registration, which opens the Registration window.  
3. Make modifications as necessary.  
4. To return to the previous window without saving your entries, click Cancel.  
5. To save your entries and return to the previous window, click OK. The message, "Registration 

complete. Person and encounter information modified" is displayed. Click OK.  
6. To exit the application, click the X in the upper right corner of the window.  

Selecting an Orderable 

Complete the following steps to select an orderable: 

1. You must first select the department from which you are placing orders from. From the menu, select 
View -> Orderable Filter -> Laboratory or Radiology. Once selected, this setting remains for all 
subsequent signons to this application for your username.  

2. Once a patient has been selected, the cursor is located in the Orderable Selection box.  
3. Enter the first few characters of the orderable, and press ENTER.  
4. the Find Catalog Item dialog box opens with a list of matching orderables (Figure A)  
5. To arrange the order of how the orderables are displayed, click on any one of the headers (Mnemonic, 

Description, Mnemonic Type).  
6. From the list, select the appropriate orderable and press OK.  

 

 
Figure A 

Figure A Description 

Orderable: Identifies the orderable procedure 
Description: Orderable description 

 

Ordering a Procedure 

1. From the Client box, click the down arrow to display a list of organizations. (Selecting an organization is 
optional). Selection applies to the Encounter Search and Patient Registration functions.  

Note 
You can display the Description and Display on the scratchpad for ease of Ordering. To display these 
fields go to the Customize Menu and select Scatchpad. Then on the display Preferences tab add the 
Description and Display fields to the Selected Columns.
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2. Enter a patient's last name in the Person Name box. If there is more than one person with that last 
name, or if the person has more than one encounter, the Encounter Search dialog box is opened. Use 
the scroll bar, if necessary, to locate the correct patient or patient encounter.  

3. Select the patient, and click OK to return to the previous window where information about the selected 
patient is displayed.  

4. In the Orderable Selection list box, enter the first few letters of the procedure you want to order. The 
list box is populated with valid orderables which you can view by clicking the down arrow. Select the 
appropriate orderable from the list and press OK.  

5. The fields that are displayed in the order details section vary depending on the orderable selected. 
Listed below are fields and instructions to complete them. Each department may have unique fields 
present.  

 

Collected Y/N: Indicates whether the specimen has been collected or not. 
Requested Date/Time: The requested date and time should default. If you need to enter information in this field, 
enter T for today's date, N in the Time field for the current time. If the specimen was collected several days ago 
perform the following: 

Click on the up or down buttons from the  button. Alternately you can select the  button to display a 

calendar. Select the appropriate day from the calendar. 

To enter a time in the past, press the up or down buttons from the  button. 

Collection Priority: Select the appropriate collection priority from the drop-down list by clicking on the  button 

or press the first letter of the priority and the value will display in the drop-down 

Reporting Priority: Select the appropriate reporting priority from the drop-down list by clicking on the  button 

or press the first letter of the priority and the value will display in the drop-down. 

Specimen Type: Select a specimen type from the drop-down list by clicking on the  button or press the first 

letter of the specimen type and the value will display in the drop-down list. 
Collected By: Enter the username of the person who collected the specimen. 
Order for Future Visit: Indicates whether the ordered procedure is a future order. 
Special Instructions: This field pertains to Powerchart such that it supplies on-screen instructions to the nurse for 
ordered procedures. Disregard this field for Department Order Entry. 

Collection Method: Select the collection method by entering the first letter of the method or clicking on the  

button. 
Print Label: Indicates whether or not to print a specimen label upon executing the order. 
Label Comment: Free text field which prints on the specimen label. 
Printer: Select the printer by entering the first letter of the printer. 
Specimen Received Date and Time: The received date and time should default. If you need to enter information 
in this field, enter T for today's date, N in the Time field for the current time. If the specimen was collected several 
days ago perform the following: 

Click on the up or down buttons from the  button. Alternately you can select the  button to display a 

calendar. Select the appropriate day from the calendar. 
Specimen Received By: Your username should default in this field. If not, enter your username. 
Specimen Login Location: Select the login location by entering the first letter of the method or clicking on the 

 button. 

Ordering Physician (Name): Enter the physician's last name. If you want to select the physician from a list, you 

can enter the first few letters of the physician's last name. To initiate a search, press the  button. 

Order Date/Time: the order date and time should default. If you need to enter information in this field, enter T 
for today's date, N in the Time field for the current time. If the specimen was collected several days ago perform 
the following: 

Click on the up or down buttons from the  button. Alternately you can select the  button to display a 

calendar. Select the appropriate day from the calendar. 
Order Communication Type:

1. Click Add Orderable to Scratch Pad  . The orderable is added to the scratch pad at the bottom on 

the screen. Alternately you can press and hold <Ctrl> then press a.  

2. When you are finished adding orderables to the scratch pad, click Submit Orders  . Alternately you 

can press and hold <Ctrl> then press o.  

 

Ordering a Batch of Procedures 

Batch Orders mode allows you to select one or more orders and place them for a series of patients in the same 
ordering session. You can define order details that are common for all orders, which prevents you from having to 
enter duplicate order information for each order. You then have to enter only the information that is specific to that 
patient or order. 

To create and place a batch of orders for a series of patients, complete the following steps: 

1. Select the Batch Orders Mode from the Task Menu, or click the Batch Orders Icon.  
2. In the Client box, enter the name of the facility associated with the first patient for whom you are 

Note 
Required fields are highlighted yellow.
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placing orders, or make a selection from the list.  
3. Select a patient and an encounter.  
4. Enter an orderable item in the Orderable Box. If you are not sure of the name of the order, enter a 

partial name, and then click the ellipsis button to display a list from which you can select.  
5. Either press Enter or click OK in the Find Orderable dialog box. The order is added to the scratch pad. 

The order details will not be displayed until you chose to start the batch.  
6. Repeat Steps 4 and 5 for all orders you want to add to the batch.  
7. When you have added all the orders you want in the batch to the scratch pad, click Start. The order 

details common to all orders are displayed and the orders in the scratch pad are selected. Entries or 
changes in common order details will be applied to all selected orders.  

8. Complete the order form. Some boxes may contain defaulted data such as the current date and time. 
Others may be inactive. As you make selections, your choices influence the remaining elements.  

9. If you want to indicate that the patient will not be charged for the procedures you are ordering, select 
No Charge from the Order Menu. Orders that are marked as No Charge have an icon displayed next to 
the order on the scratch pad.  

10. If you want to add a comment to the Batch, select Comments from the Order Menu. The comment is 
then associated with all selected orders on the scratch pad and an icon is displayed next to each 
selected order. 

* Once you have entered the information that is common to all orderable items in the batch, and if you 
do not need to make changes to individual orders in the batch, click Submit. The orders are processed 
and the patient is cleared form Department Order Entry.  

11. If you need to make changes to one or more individual orders in the batch, click Next prior to 
submitting the batch. The first order on the scratch pad is selected and you can begin filling out the 
order details for the specific orderable item, including associating a No Charge indicator or a comment 
with the single order. You also can add and remove orders from the batch (see Adding and Removing 
Orders from a Batch). Use the Next and Previous buttons to navigate to a specific orderable item. After 
making the changes you want, click Submit.  

12. Select a new patient and encounter for which you want to place the batch of orderable items. The batch 
orders and common orders will be displayed automatically. 

13. Repeat Steps 8 through 12 for the patient.  
14. Repeat Steps 13 and 14 for all patients.  

 

Adding Orders to a Batch 

Once you have started a batch and defined the common order details, you can add orders to, and remove orders 
form the batch. 
To add an order, complete the following steps: 

1. Select New from the Orders menu. The cursor is positioned in the Orderable box, allowing you to enter 
the name of the new order.  

2. Enter an orderable in the Orderable box. If you are not sure of the name of the order, enter a partial 
name, then click the ellipsis button to display a list from which you can select.  

3. Select your orderable and hit OK or Enter.  
4. You are then prompted whether you want to add the order to just the current patient or to all 

subsequent patients. Select an option. The order is then added to the scratch pad and the order details 
for the order are displayed. 

5. Repeat Steps 2 through 4 for all orders you want to add to the batch.  

 

Removing Orders from a Batch 

To remove an order from a batch, complete the following steps: 

1. Select the order you want to remove from the scratch pad and select Remove form the Order menu.  
2. You are prompted whether you want to remove the order from just the current patient or from all 

subsequent patients. Select an option. The order is removed from the scratch pad. 

Note 
If you associate the No Charge indicator or a comment at this point in the batch ordering 
process, the indicator or comment is associated with all orders in the batch. Later in the 
process, you will have the ability to associate the indicator or comment with a single order 
in the batch.

Note 
The order details displayed are for the order selected on the scratch pad. If all the orders 
on the scratch pad are selected, then the order details show are those that are common to 
all the orders. The common order details cannot be accessed again once you select an 
individual order.

Note 
If you have associated the No Charge indicator or any comments with the batch, these are 
applied to the new order as well.
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Canceling a Procedure 

Complete the following steps to cancel a procedure: 

1. Click on Cancel Orders  , and select the patient for whom you want to cancel a procedure. 

Alternately, you can go to Task -> Cancel Orders.  
2. Enter the patient.  
3. Click on the Filter button located just beneath the patient's name. This mechanism allows you to choose 

to search on orders by Laboratory or Radiology. Furthermore, it allows you to search for all encounters 
associated with the patient or only the encounter you chose in the Encounter Search screen when 
initially selecting the patient. The column headers Orderable, Order Status, Departmental, Start 
Date/Time, and Order Details will display. To arrange the order of how the orderables are displayed, 
click on any one of the column headers.  

4. Select the order you want to cancel. The cancel format is displayed in the details section.  

5. Cancel Reason: Select from the  button or enter the first letter of the reason you wish to choose.  

6. Click Submit Orders  . The order is added to the scratch pad and is then processed.  

Adding Another Procedure to an Existing Accession 

Complete the following steps to add an orderable to an existing accession: 

1. Click Accession Add On  , and the Accession Number box is displayed in place of the Person 

Name or Alias box. Alternately, you can go to Task -> Accession Add On.  
2. In the Accession number box, enter the accession number to which you want to add an orderable. Press 

<Enter> to default the current year and today's Julian date. 

3. The system displays the Associated Containers dialog box, which shows the columns Container Type, 
Specimen, Volume, Drawn Date/Time, Current Location, Orders Placed Against Container of the 
accession to which you want to add an orderable. Select a container from the list, then click OK. 

  

4. From the Orderable Selection field, enter the name of the orderable you want to add on.  

5. Click Add Orderable to Scratch Pad  . The orderable is added to the scratch pad at the 

bottom on the screen. Alternately you can press and hold <Ctrl> then press a.  

6. When you are finished adding orderables to the scratch pad, click Submit Orders  . Alternately 

you can press and hold <Ctrl> then press o.  

Ordering a No Charge Procedure 

After entering a procedure name in the Orderable Selection field go to the Order menu, select No Charge. 

Understanding Ordering Statuses in the Scratchpad 

When you submit an order that is displayed on the scratch pad, the order passes through various processing 
statuses for validation. 
Ready: The order is ready to be submitted. 
Validating: The system validates the details associated with the order to verify that all required elements have 
been completed. Dates and times entered are checked against encounter information and scheduling logic. If you 
have made changes to the order by redisplaying the order details after the order was placed on the scratch pad, 
you may have circumvented the preliminary checking, so the system rechecks everything again. 

Note 
If the order you are selecting to remove was one that was added after the batch was 
started and was not saved to the batch, you will not be prompted to select whether to 
remove it form the current patient only or for all subsequent patients.

Note 
Methods of entering an accession number: 
<Tab>: defaults current year and today's Julian date 
Numeric Pad </>, <>, <>: defaults year only. Press <>,<>, <> again to default today's 
Julian date.
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Scheduling: If a specimen needs to be collected, the system enters the task according to the priority you assigned 
to the order. For example, if you indicated a priority of Routine for an order that requires a blood sample, that 
blood sample will be listed on the next regularly scheduled collection round.  

Checking for Duplicates: The system, using the parameters set by your institution for the type of orderable, 
checks to see if the same exact procedure has been ordered within the exclusionary time frame. You can be 
warned that the order is a duplicate or the order can be rejected, depending on your system setup. 
Assigning Accession: The order is assigned a unique accession number generated by the system. 
Submitting Order: When all parts of the order are correct, the system writes the order to the database and it is 
communicated to other Cerner applications that manage the tasks generated by the order and document its 
results. 
Submitted: The submission process is complete. 
Error: A problem occurred in processing. Select the order in the scratch pad and select View Submission Errors 
from the Task menu.

Modifying an Order from the Scratchpad 

1. Select the order on the scratch pad.  
2. Select Display Details from the Order menu or double-click the order in the scratch pad to restore the 

order to the order details section.  
3. Modify the order details as needed.  
4. Select Submit Orders from the Task menu to submit the order for processing.  

Modifying a Submitted Order 

You can modify the following details for orders placed for patient: 

Ordering Physician  
Consulting Physician  
Chart Copy Location  
Reporting Priority  

To modify an existing procedure placed for a patient, complete the following steps. 
1. Select the Modify Order mode from the Task menu. 
2. In the Client box, enter the name of the facility associated with the patient for whom you are placing orders, or 
make a selection from the list (Optional) 
3. Select a patient and an encounter. 
4. To change the selected catalog type or encounter scope, click Filter (located just above the existing orders 
spreadsheet), to open the Filter Existing Orders dialog box. This will allow you to filter orders to be modified by 
catalog type and encounter. The dialog box contains the following elements: 

Laboratory option - Select this option to display orders associated with the laboratory catalog type.  
Radiology option - Select this option to display orders associated with the radiology catalog type. 
All Encounters option - Select this option to display orders for all encounters.  
Selected Encounter - Select this option to display orders associated with a specific encounter.  

5. Select the order to be modified. The modify format is displayed in the Details Section. 
6. You can modify only the following order details: 

Chart Copy Location  
Consulting Physician  
Ordering Physician  
Reporting Priority  

7. If you have more than one order to modify, select Add from the Order menu to move this order to the scratch 
pad. You must move the order to the scratch pad before submitting the modification. 
8. Click Submit Orders when all orders to be modified are displayed in the scratch pad. 

Customizing Patient Demographics 

If given the privilege from an administrator, you can customize the patient demographics section of DOE at the 
end-user level. 

Use Customize Demographics to define and maintain the patient demographic information that is displayed in the 
Demographics box in the main application. You can define the demographic data elements and labels to be 
displayed and determine the positions within the Demographics box. You also can customize the display of the 
demographic information, using either a columnar or compressed view.  
You can click OK at any time, to save your changes and close the Customize Demographics window. You also can 
click Cancel to close the Customize Demographics window without saving your changes.  
Use the screenshot below to help navigate the following tasks available with this customization. The Help icon in 
the Customize Demographics window will give you even more information.  

Begin by selecting Patient Demographics from the 

Note 
The Scheduling status does not apply to Radiology orders.
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Customize menu. 

Defining the Customize Options 

1. To define the number of columns to be displayed in the Demographic Data Elements group box, select 
a numeric value between one and six from the Columns list. The default number of columns may be 
different depending on the application from which the Customize Demographics window is opened. 

 

2. Select the Columnar View option or the Compressed View option to define the display of the 
demographic data.  

3. If you want to receive a system message when current and historic demographics are different, select 
the Notify Me When Current and Historic Demographics are Different option. 

4. When you are finished defining the Customize Options group box, you can define demographic data 
elements and labels, position the demographic information, preview the information, or restore the 
default values as needed.  

5. You can click OK at any time, to save your changes and close the Customize Demographics window. 
You also can click Cancel to close the Customize Demographics window without saving your changes.  

Defining Demographics Data Elements, Labels, and Positions 

 
Use the Demographic Data Elements group box to define the demographic data elements and labels to be displayed 
and to determine the positions within the Demographics box in the main application. 

 

 

Some demographic information is defined by default. You can add new data elements or modify existing ones as 
needed. The total number of demographic data elements you can select is determined by the number of rows and 
columns available; ten rows are available automatically, and the number of columns is defined in the Customize 
Options group box. 

Complete the following steps to define data in the Demographic Data Elements group box: 

1. Select a box in a column and row; this defines the position of the data element. To open the Set 

Demographic Data Elements dialog box, enter text in the box and press ENTER or click  next to the 

Note 
You can remove columns as needed; they are removed in order from right to left. If 
demographic information is defined for the column you are removing, a system message is 
displayed.

Note 
The Notify Me When Current and Historic Demographics are Different option is available 
only when at least one pair of like demographic values, such as name and name 
(historical), is defined in the Demographic Data Elements group box. A visual indicator  
is displayed automatically when the current and historic demographics are different. When 
you select this customize option, a system message is displayed, in addition to the 
indicator, when the current and historic demographics are different. 

You may receive the system message multiple times; this can occur when 
multiple pieces of the patient's demographic information are updated and when 
you view information for multiple patients from the same application. If you no 
longer wish to receive the system message, you can deselect the notification 
option at any time.  
Historical demographics are not available in all PathNet applications.  

Note 
You cannot add or remove rows from the Demographic Data Elements group box, however, you do not 
have to define information in all rows. Empty rows in the group box do not increase the area in the 
Demographics box in the main application.
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box. 

 

 
2. Select a demographic data element from the Value list. This list is sorted alphabetically, with the 

corresponding historic value listed immediately after the current value. For example, Age (Historical) is 
listed immediately after Age. A description of the selected demographic data element is included in the 
Description box. 

3. Each demographic data element is defined with a default label. If you want a different label, enter up to 
25 characters of text in the Label box. Duplicate labels are permitted; however, you will receive a 
system message warning when a duplicate exists.  

4. Select the Bold Label option if you want the text defined in the Label box to be displayed using a bold 
font style. This option is selected automatically when you are defining a new demographic data 
element, but you can deselect it as needed.  

5. If you want the system to display text for a demographic data element that does not have data, enter 
up to 25 characters of text in the Missing Data Value box. 

6. Select the Stack If Multiple Values option if you want the information displayed in the tooltip when you 
hover the cursor over a demographic field to be in a vertical list format instead of a comma-separated 
list.  

7. Click OK to save your changes and close the Set Demographic Data Elements dialog box. The data 
element and label information is added or updated in the Demographic Data Elements group box. Click 
Cancel to close the Set Demographic Data Elements dialog box without saving your changes.  

8. When you have finished defining the data elements, labels, and positions, you can define customize 
options or preview the demographic information as needed.  

Previewing Demographic Information 

Use the Preview Demographics box to preview the demographic information you have selected. Example values 
have been defined automatically, so that you can see how the demographic information will be displayed as you 
select data elements in the rows and columns. 

Note 
Empty boxes are allowed in a row, so that you can spatially separate demographic values 
as needed. If a demographic value is not defined in a box, the text from the preceding 
value fills the space. This allows you to avoid or reduce truncation of demographic 
information.

Note 
The values from which you can select in the Set Demographic Data Elements dialog box 
are determined by the application. Historical demographic values are not available in all 
applications. You also can select None from the Values list to remove previously defined 
elements.

Note 
Sometimes, a demographic data element may not have data or the element may not be in 
context for the application. For example, if you select ABO/Rh as a demographic data 
element and enter the word unknown in the Missing Data Value box, unknown is displayed 
in the application if the patient does not have an ABO/Rh result. In addition, if you have 
selected any encounter, order, or historical demographic data elements, that information is 
not available when you are in the Flowsheet mode of Order Result Viewer; when that 
occurs, the system will not display any information unless you have entered text in the 
Missing Data Value box.
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If any demographic information is truncated ... is displayed. You can position your pointer over the truncated 
information to view the entire demographics in a tooltip. 

You can modify the display in the Preview Demographics box by selecting one of the Display options in the 
Customize Options group box. The Columnar View option displays information in rows and columns, while the 
Compressed View option displays information in a string. 

Restoring Default Values 

You can reset the demographic information defined in the Demographic Data Elements group box as needed. 
Default demographic information is defined by the main application, and is maintained in DB Customize 
Demographics. 

Complete the following steps to reset the demographic information as needed: 

1. Click Restore Defaults. The demographic data elements, labels, and positions are reset.  
2. Click OK to save your changes and close the Customize Demographics window. Click Cancel to close the 

Customize Demographics window without saving your changes.  

Customizing the Scratchpad 

You can enter and save preferences to control the way items on the scratch pad are displayed. You can change 
color preferences, submission preferences, and column headings. To customize your scratch pad display, complete 
the following steps: 

 

Color preferences 

1. Select Scratch Pad from the Customize menu. The Customize Scratch Pad dialog box is displayed with 
the Color Preferences tab active.  

2. Select a status of order processing displayed in the Items box; for example, Ready.  
3. Click the ellipsis button next to the Text Color box to view a color palette.  
4. Select a color. All orders are in the status of Ready when they are first added to the scratch pad and 

will be displayed in the text color you indicated.  
5. Follow the same procedure to select a background color, making certain that you select a color that 

contrasts with the text color appropriately. As you make your selections, look at the Sample box to 
preview your new color scheme.  

6. Continue establishing text and background colors for the various statuses. When the system processes 
your new orders, you can watch the scratch pad as the submission process advances from one phase to 
another. 

Submission preferences: 

Note 
If you have defined a pair of like demographic data elements, such as name and name (historical), 
visual indicators are displayed when the current and historic demographics are different  , or when 

the historic demographics are not found  . Examples in the Preview Demographics box were created 

purposely with different values, to show you the  indicator when a pair of like elements is defined.

Note 
The text color of black on a yellow background is defaulted for duplicate orders. The text 
color of white on a red background is defaulted for errors. It is not necessary, and perhaps 
not desirable, to assign a color scheme to every phase.
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1. Select Scratch Pad from the Customize menu. The Customize Scratch Pad dialog box is displayed with 
the Color Preferences tab active.  

2. Select the Submission Preferences tab.  
3. Select the check box if you want orders to be removed from the scratch pad automatically after 

successful submission.  
4. Slide the marker to the appropriate mark to indicate the maximum number of orders to accumulate on 

the scratch pad before you must submit them.  
5. Slide the marker to the appropriate mark to indicate the number of orders to allow on the scratch pad 

before the system displays a warning. If you have set your maximum to 10, you should set the warning 
to a smaller number. The reason for limiting the scratch pad accumulation is to prevent your PC from 
consuming too much memory to be able to continue processing efficiently.  

Display Preferences: 

 

1. Select Scratch Pad from the Customize menu. The Customize Scratch Pad dialog box is displayed with 
the Color Preferences tab active.  

2. Select the Display Preferences tab.  
3. The columns listed in the Available Columns box can be displayed in the scratch pad. Select the column 

to be displayed, then click Move.  
4. The columns listed in the Selected Columns box are displayed in the scratch pad currently.  
5. To hide a column, select it and click Move. This moves the column heading to the Available Columns 

list.  

Customizing or Hiding the Status Bar 

 

1. Right-click on the status bar (located at the bottom left or right of the Cerner application). 
Alternatively, from the context menu, select hide to hide the status bar from view, or select Customize 
to open the Customize Status Bar dialog box to change the information that is displayed. This dialog 
box also can be opened by selecting Status Bar from the Customize menu.  

2. The elements listed in the Selected Panels box are those that are displayed currently on the status bar. 
Select an element and click Move to move the item to the Available Panels box. The items listed in the 
Available Panels box are not displayed on the status bar but can be restored at any time. 
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3. To return the status bar to its original status, click Reset.  
4. Click Close to save your changes and exit.  

Collection List 

Overview 

Use Collection List to print batches of collection lists quickly and efficiently. You also can preview the collection run 
prior to printing collection lists.  

Collection lists are generated by selecting a predefined collection run and collection schedule time. The collection 
date and a label printer also can be specified. The system automatically gathers all pending collections for the list 
based on the collection route, locations, scheduled collection date and time, collection priority , and specimen type 
of the orders.  

The preview option enables you to see the names of all the patients who qualify for the requested collection list, 
their locations, the scheduled dates and times of the orders, and other order details. If you want to print only a 
subset of the list, you can select certain patients to be included, thus customizing the collection list.  

You might preview the collections if, for example, you want to determine the number or type of specimens to be 
collected and then make a decision about whether to print the collection list labels at that time. 

Collection List Processing 

Criterion for specimens to qualify for a collection list: 

Patient location  
Collection Priority  
Specimen Type  

The final criterion relates to whether an order is nurse-collect. Orders requested as nurse-collect can be included or 
excluded from a collection list, based on each collection route schedule time. Each route schedule time has one of 
the following designations: 

Includes both nurse-collect and non-nurse-collect orders  
Includes only nurse-collect orders (excludes non-nurse-collect orders)  
Includes only non-nurse-collect orders (excludes nurse-collect orders)  

Scheduled Date and Time 

Other criteria the system uses to determine which collections qualify for the list are the scheduled date and time of 
the orders. The scheduled date is usually specified by the person requesting the order. The scheduled time can be 
assigned to orders in one of two ways: 

1. The system determines a future time based on a predefined collection schedule for the patient's nursing 
station or location.  

2. A future collection time can be specified by the person requesting the order.  

Pending collections qualify for the list based on the scheduled date and time if they fall into any of the categories 
listed below. 

Orders whose scheduled date and time are the same as the collection date and time entered for the 
list.  
Orders with scheduled date and time earlier than the list date and time. Orders scheduled earlier than 
the list date and time are included if they fall within the look-back time period defined in the Collection 
List Options dialog box.  
Orders with scheduled times that fall between the time of the current list and the next collection time 
for the route.  
Orders with scheduled times that fall within the look-ahead minutes defined for the route.  

System Actions 

Once the appropriate orders are gathered, the system prints collection lists and labels. A unique collection list 
number is assigned to collections on each route within the run. The list number can be used to log in specimens 
after they are collected. The labels are determined by the collection requirements defined in the Order Catalog for 
each order. 

The system performs label netting to determine the minimum number of specimen containers required for each 
patient. The required containers are defined in the system. 

Note 
Any item listed can be moved to the opposite list. You can click Select All to select all of 
the items from a list. When you do this and then click Move, you can hide all elements or 
display all elements, depending on the direction of the move.
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The statuses of the containers are updated to Dispatched to indicate that labels have been generated and 
specimens are to be collected. Orders in Dispatched status will not print on subsequent collection lists unless they 
are rescheduled for a new list. 

Printing Collection Lists 

To print collection lists and labels, perform the following steps: 

1. Make a select from the Available Runs list. The collection routes included in the run then are displayed 
in the Routes/Default Printer list.  

2. Make a selection from the Collection Times list. The time immediately following the current time is the 
recommended selection. (The system defaults to the next available time, based on the current system 
time.)  

3. Make a selection from the Routes/Default Printer list.  
4. Using the Collection Date spin box, specify the collection date of the orders you want to process. You 

can click the arrow on the right to display a calendar from which you can select a date. The system 
displays the current date as a default, or the next day's date if the last collection time for the current 
date has passed.  

5. Either select the Use Default Printers option or select a label printer from the list. (If you want to select 
a printer but the Use Default Printers box is checked, you must first deselect Use Default Printers.) If 
you specify a printer, it will override any default printers defined, and the labels for the entire collection 
run will print on that one printer.  

6. If you want the system to look back more than 24 hours for orders (24 hours is set as the default), 
select Options from the View menu and change the specifications in the Collection List Options dialog 
box. For more information on the Collection List Options dialog box, click here.  

7. To preview the pending collections that qualify for the selected collection run, or to customize a 
collection list, open the Preview window. This is an optional step.  

8. After you have identified a collection run, you can preview the collection list or lists. You also can 
customize them if you do not want to include all the patients who qualify for this collection run, thus 
creating your own collection list. Follow the steps below. 

a. Open the Preview window in one of the following ways:  
b. Select Display Preview from the Task menu.  

c. Click the Preview icons  or . The names of the patients who qualify for 

the selected collection run then are displayed, along with their locations and scheduled 
dates and times. 
   

d. Scroll through the displayed list, if necessary, to review the pending collections. 

To view details for all patients, select All Details from the View menu. The 
system displays all the orders, their collection priorities, and the specimen 
types. To hide the details, select All Details again (so that the check mark is 
removed).  
To view details for a specific patient, select the appropriate row (by clicking on 
it or using the arrow keys to move to it), then click Details. The system expands 
the spreadsheet, displaying the orders for that patient, their collection priorities, 
and the specimen types. To contract the spreadsheet and hide these details, 
click the Details button again. 

To customize the list so that not all of the displayed orders are included, simply 
deselect those orders you do not want to include by clearing the check boxes at 
the beginning of the lines on which they are displayed.  
To print the collection list (or lists) and labels from this window, select Print 
Labels from the Task menu. The system then opens the List Numbers Assigned 
dialog box to display the numbers assigned to the collection list or lists. Click 
OK to close the window.  

9. To print the collection list (or lists) and labels, select Print Labels from the Task menu. The system then 
opens the List Numbers Assigned dialog box to display the numbers assigned to the collection list or 
lists. Click OK to close the window.  

Collections Inquiry 

Overview 

Use Collections Inquiry to view orders for which a specimen has not been collected, or for which a specimen is 
collected but has not been logged in at the testing laboratory. 

Inquiry can be performed in the following modes: 

Note 
You can click the Preview as of [date and time] button at any time 
to refresh the list in the Preview window. Any new collections will 
be displayed and the system will update the date and time shown 
on the button.
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Patient location or locations  
Collection or transfer lists  
Accession number  
Single patient  
Missed orders on hold  

The modes available are based on your task-level security. If you have access to all tabs except the Accession tab, 
for example, you will not be able to perform an inquiry by accession number. However, you can perform an inquiry 
using any other mode. 

Options are also available to filter the orders by collection status, specimen type, and collection priority. You also 
have the option to look ahead at pending collections, view collections scheduled or collected through the current 
time, or view only collections scheduled up to a specific time in the past. 

Before you can perform an inquiry by location, a template or facility must be selected. Once a user has chosen a 
template or a facility, it is used as the default every time that user opens Collections Inquiry (until the user selects 
a different facility or template). If you select a template, the parameters are predefined in Collection Templates, 
including the locations (facilities, nurse units, or ambulatory locations), the filters (collection statuses, specimen 
types, and collection priorities), and the date and time of orders to be included in the report. 

When the inquiry is performed, the list of orders is displayed in a spreadsheet format, and is sorted by the data in 
the first three columns of the spreadsheet. By clicking on a column header, you can re-sort the displayed 
information based on the data in the selected column. 

You can view container information for an order by going into the Container Inquiry application directly from this 
application. You also can cancel orders for which specimens have not been collected. 
Two types of printing can be performed in Collections Inquiry: inquiry reports and specimen labels. The report is 
simply a hard-copy reproduction of the information displayed in the spreadsheet in this window. Specimen labels 
can be printed for one or more selected orders, or for all orders in the spreadsheet. 

Inquiry by Location 

You must select a facility or template before you can perform an inquiry by location. If you have not, the system 
will prompt you to do so. If you are not prompted to select a facility, it means that you previously selected a facility 
or a template in Collections Inquiry. The application remembers your choice and displays the default in the status 
bar. 

Complete the following steps to perform an inquiry by location: 

1. If you are using Collections Inquiry for the first time or have not previously selected a facility, the 
system displays, select a default facility under the View menu. Click OK to close the message box.  

2. From the View menu, choose Select Facility. The Select Facility dialog box opens, enabling you to select 
the facility for which you want locations to be displayed.  

3. If you are not prompted to select a facility, but want to select a different facility, choose View menu. 
Select Facility to open the Select Facility dialog box and select a different facility.  

4. If you want to select a different template, choose View menu, select Template. The Select Template 
dialog box opens, enabling you to select a template. The selected template defines the collections that 
will be included in the inquiry report.  

5. Once the appropriate facility or template is selected, click the Location tab (if it is not already the active 
tab).  

6. Select the patient locations you want to use in the inquiry by transferring them from the Available list 
to the Selected list. You can transfer locations in the following ways: 

a. To transfer a single location, select it and click Move> or <Move, or simply double-click the 
location. 
   

b. To transfer multiple locations, select them and click Move> or <Move.  
c. To transfer all locations, select any location in the list from which you want to make the 

transfer, click Select All, then click Move> or <Move. 

7. To modify the criteria to be used when the system retrieves orders, click Filter. The Inquiry Filters 
dialog box opens. 

a. Inquiry filters are criteria that the system uses in searching for orders during inquiry. When 
the Inquiry Filters dialog box first is opened, the system displays all collection statuses, all 
specimen types, and all collection priorities as defaults. You can deselect specific statuses, 
specimen types, or priorities that you do not want used. You also can indicate that you want 
orders to be retrieved on the basis of look-ahead hours rather than ending date and time 
(the initial default is ending date and time).  

b. Complete the following steps to modify inquiry filters: 

Click Filter to open the Inquiry Filters dialog box.  
To change the collection statuses to be used as filters when orders are 
retrieved, click Select under the Collection Statuses list. The Select -Statuses 

Note 
The arrow on the Move button changes direction when you select any location 
or locations in one of the dual lists. This enables you to undo selections or to 
remove a few items from a long list.
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dialog box opens. Move statuses between lists until only the statuses you want 
to use are in the Selected list.  
To change the specimen types to be used as filters when orders are retrieved, 
click Select under the Specimen Types list. The Select -Specimen Types dialog 
box opens. Move specimen types between lists until only the statuses you want 
to use are in the Selected list.  
To change the collection priorities to be used as filters when orders are 
retrieved, click Select under the Collection Priorities list. The Select -Collection 
Priorities dialog box opens. Move priorities between lists until only the statuses 
you want to use are in the Selected list. For more information on this process, 
click here.  
Indicate the time range for which you want to view orders by selecting the 
appropriate option under Date/Time Options, and then completing the 
associated boxes.  

c. To view collections scheduled or collected within a time window, select the Time Window 
option (which is the default, unless you have previously selected the other option). The 
Look Ahead Hours and the Look Back Hours boxes are available for you to enter a time 
window.  

d. To view only collections scheduled up to a specific time in the future or past, select the 
Cutoff Hours option. The Future option, Past option, and (Cutoff Hours) box are available for 
you to define the cutoff hours. To set a cutoff time in the future, select the Future option 
and enter the number of cutoff hours.  

If you want to set a cutoff time in the past, select the Past option and enter the number of cutoff hours. 

1. Click OK to close the Inquiry Filters window.  
2. To generate the collections inquiry list, click Retrieve or select Retrieve from the Task menu.  
3. To print the collections inquiry report, select Print from the Task menu. A dialog box then opens to 

prompt you for the appropriate print criteria.  

Inquiry by List 

If you start Collections Inquiry just before performing an inquiry by list, a message box may open displaying the 
message, Please select a default facility under the View menu. (You get this prompt when you are using Collections 
Inquiry for the first time or if you have not previously selected a facility.) Click OK to close the message box. You 
do not need to select a facility in order to perform an inquiry by list. If you select a facility before performing an 
inquiry by list, it has no impact on the process of performing an inquiry by list. The default facility is used only 
when you are performing an inquiry by location. If you will be performing Inquiry by Location during this session, 
however, you may want to go ahead and select the default facility. 

Complete the following steps to perform an inquiry by list: 

1. Click the List tab.  
2. Indicate whether you want to view orders on collection lists or specimen transfer lists, by selecting the 

appropriate option. (Collection list is the default.)  
3. Specify the date for the lists you want to view, using the Date spin box.  
4. Click Lists to display the list numbers for the specified date. The numbers are displayed in the list below 

the Lists button.  
5. In the list, select the list number or numbers whose orders you want to view. To select more than one 

list number, hold down the CTRL key.  
6. If you are viewing orders on a transfer list, select a From Location and a To Location (from the lists 

provided) or do nothing to accept the default of (ALL) for all locations.  
7. To modify the criteria to be used when the system retrieves orders, click Filter. The Inquiry Filters 

dialog box opens.  
8. To generate the collections inquiry list, click Retrieve or select Retrieve from the Task menu.  
9. To print the collections inquiry report, select Print from the Task menu. A dialog box then opens to 

prompt you for the appropriate print criteria.  

Inquiry by Accession 

If you start Collections Inquiry just before performing an inquiry by accession, a message box may open displaying 
the message, Please select a default facility under the View menu. (You get this prompt when you are using 
Collections Inquiry for the first time or if you have not previously selected a facility.) Click OK to close the message 
box. You do not need to select a facility in order to perform an inquiry by accession. If you select a facility before 
performing an inquiry by accession, it has no impact on the process of performing an inquiry by accession. The 
default facility is used only when you are performing an inquiry by location. If you will be performing Inquiry by 
Location during this session, however, you may want to go ahead and select the default facility. 

Complete the following steps to perform an inquiry by accession: 

1. Click the Accession tab.  
2. In the Starting Accession box, enter the accession number with which you want the inquiry to start. 

When you press ENTER, the system also enters this number in the Ending Accession box.  
3. If you want to view orders for only a single accession, press ENTER when the cursor is in the Ending 

Accession box (and the same accession number is displayed in both boxes). If you want to view orders 
for a range of accessions, change the number in the Ending Accession box to the number of the 
accession with which you want the inquiry to end.  

4. To modify the criteria to be used when the system retrieves orders, click Filter. The Inquiry Filters 
dialog box opens.  

5. To generate the collections inquiry list, click Retrieve or select Retrieve from the Task menu.  
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6. To print the collection inquiry report, select Print from the Task menu. A dialog box then opens to 
prompt you for the appropriate print criteria.  

Inquiry by Patient 

If you start Collections Inquiry just before performing an inquiry by patient, a message box may open displaying 
the message, Please select a default facility under the View menu. (You get this prompt when you are using 
Collections Inquiry for the first time or if you have not previously selected a facility.) Click OK to close the message 
box. You do not need to select a facility in order to perform an inquiry by patient. If you select a facility before 
performing an inquiry by patient, it has no impact on the process of performing an inquiry by patient. The default 
facility is used only when you are performing an inquiry by location. If you will be performing Inquiry by Location 
during this session, however, you may want to go ahead and select the default facility. 

Complete the following steps to perform an inquiry by patient: 

1. Click the Patient tab.  
2. In the Patient box, enter the name of the patient for whom you want to perform the inquiry (last name 

first, then a comma, then the first name). You can enter the complete or partial patient name, or click 
the ellipsis button to open the Search dialog box and perform a search based on certain parameters.  

3. If you do not know the patient's full name or you are not certain of the spelling, you can click the 
ellipsis button for assistance (after, optionally, entering one or more letters of the patient's last name in 
the Name box). The system opens the Search dialog box, in which you can search for a patient record 
stored within your database.  

4. If you enter a partial patient name, and the letters entered match with only one name in the database, 
the full patient name is displayed in the Patient box as soon as you click the ellipsis button . The system 
does not open the Search dialog box.  

5. To modify the criteria to be used when the system retrieves orders, click Filter. The Inquiry Filters 
dialog box opens.  

6. To generate the collections inquiry list, click Retrieve or select Retrieve from the Task menu.  
7. To print the collection inquiry report, select Print from the Task menu. A dialog box then opens to 

prompt you for the appropriate print criteria.  

Inquiry for Missed Collections 

If you start Collections Inquiry just before performing an inquiry for missed collections, a message box may open 
displaying the message, Please select a default facility under the View menu. (You will get this prompt when you 
are using Collections Inquiry for the first time or if you have not previously selected a facility.) Click OK to close the 
message box. You do not need to select a facility in order to perform an inquiry by patient. If you select a facility 
before performing an inquiry for missed collections, it has no impact on the process of performing an inquiry for 
missed collections. The default facility is used only when you are performing Inquiry by Location. If you will be 
performing an inquiry by location during this session, however, you may want to go ahead and select the default 
facility. 

Complete the following steps to perform an inquiry for the missed collections that are on hold: 

1. Click the Missed tab.  
2. To modify the criteria to be used when the system retrieves information on missed collections, click 

Filter. The Inquiry Filters dialog box opens.  
3. To generate the collections inquiry list, click Retrieve or select Retrieve from the Task menu.  
4. To print the collection inquiry report, select Print from the Task menu. A dialog box then opens to 

prompt you for the appropriate print criteria.  

Printing the Collections Inquiry by Patient 

Complete the following steps to print a copy of the displayed information: 

1. From the Task menu, select Print. A dialog box opens.  
2. Select the appropriate print criteria.  

Printing Specimen Labels 

Complete the following steps to print specimen labels: 

1. Make a selection from the Label Printers list.  
2. Select the order or orders for which you want to print labels. (If you want to print labels for all 

displayed orders, skip this step.)  
3. Click Labels to open the Labels dialog box. You can also open this dialog box by selecting Print Label 

from the Task menu.  
4. In the Labels dialog box, the Selection option will automatically be selected. 

If you are printing selected orders (you have completed step 2), leave this option selected.  
If you want to print labels for all displayed orders, select the All option instead.  

5. Click Print.  

Canceling Orders 
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You can cancel orders for which specimens have not been collected or for which specimens have not been logged in 
at the testing location. (These are the only kinds of orders that are displayed in Collections Inquiry.) 

This feature is useful for clinics that place future orders in the system for outpatients. For example, if the patient 
never comes to the lab to have the lab work done, the orders could be canceled after a specified amount of time 
has elapsed. In the Inquiry Filters dialog box, you specify an ending date that is a week or two in the past, select 
all of the outpatient locations on the Locations tab, retrieve the orders, and then cancel them in a batch by 
selecting the All option in the Cancel Orders dialog box. 

Complete the following steps to cancel orders: 

1. If you want to cancel a specific orders or orders, select the order or orders when the collections inquiry 
spreadsheet is displayed.  

2. From the Task menu, select Cancel Orders to open the Cancel Orders dialog box using one of the 
following methods:  

3. In the Cancel Orders dialog box, select the appropriate option. Under Cancel What?, the following 
options are available: 

Choose the Selection option to cancel selected orders (those that are highlighted).  
Choose the All option to cancel all orders that are displayed in the spreadsheet.  
Choose the Discharge Only option to cancel orders displayed in the spreadsheet for 
discharged patients.  

4. To enter free text comments regarding the cancellation, type them in the Cancel Comment text box. 
(When you cancel orders, they will automatically be assigned a cancel reason of Collections Inquiry 
Cancel along with the date and time and ID of the user who performed the cancellation.)  

5. Click Cancel Orders. The system then prompts for confirmation. If you click Yes, the system cancels the 
order or orders. When the spreadsheet is redisplayed, the canceled order or orders are no longer 
visible.  

Here is another example of how this option could be used: When you are performing an inquiry by location, you 
could select some or all locations. In the Inquiry Filters dialog box, you could set the ending date to five days ago, 
and select statuses of Pending and Dispatch. Then you could cancel all orders with a scheduled date of five or more 
days in the past that have not been collected, by opening the Cancel Orders dialog box and selecting the All option. 
This will cancel all orders displayed in the inquiry spreadsheet. 

If you select the option for discharged patients (in the Cancel Orders dialog box), the system cancels all orders 
displayed in the spreadsheet whose patients are discharged. If you cancel selected orders (you choose the 
Selection option in the Cancel Orders dialog box), the system cancels all highlighted orders in the spreadsheet. 

Modify Collections 

Overview 

Use Modify Collections to do the following: 

Modify collection information after specimen containers have been logged in as received  
Update the status of a collected container or order to Dispatched so the collection will be recollected 
You can change the collection date and time, collector ID, and collection method for a container or 
order. When you modify collection information at the container level, your changes apply to all the 
orders in that container. When individual orders in a container are modified, the modified orders are 
pulled from the container and put into a new container or containers. After you modify orders in a 
container, the container row becomes locked to prevent any further changes to the entire container. 
(You could still make changes to the order rows.) 

You can mark a collected container or order for recollection by selecting it in the displayed spreadsheet. 
When you subsequently select Recollect from the Task menu, the entire container is updated to a 
Dispatched status. When individual orders in a container are marked for recollection, the orders will be 
pulled from that container and put into a new container or containers. After a container or any orders in 
a container are marked for recollection, the entire container becomes locked so that no further changes 
can be made.  

Collection information is displayed in spreadsheet format after being retrieved by accession number. You then can 
modify the information or mark containers or orders for recollection. 

After modifying the collection information or selecting containers or orders for recollection, you must choose the 
appropriate command (Modify or Recollect) from the Task menu before the changes are saved or the status is 
updated. (If the toolbar is available in Modify Collections, you can perform the same actions by clicking the 
appropriate toolbar button.) 

Modifying Collection Information 

Note 
Collections can be modified only when the container status is Received, Collected, In-
Transit, or Stored. Other statuses may be displayed but the collection information on those 
rows are not modifiable.
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Complete the following steps to modify collection information: 

1. Under Mode, select the Modify option.  
2. In the Accession Number box, enter the accession number for the containers or orders whose collection 

information you want to modify.  
3. Click Retrieve. The system displays a list of the containers associated with the accession number. 

Information about the person whose accession number was entered is displayed under Demographics.  
4. To display detailed information about the containers, from the Task menu, select Container Inquiry. The 

Container Inquiry application opens, displaying container information for the accession number entered 
in Modify Collections. (For information about how to use Container Inquiry, click the Help menu in 
Container Inquiry.) When you close Container Inquiry, you will be returned to Modify Collections.  

5. If more than one order is included in a container, an ellipsis button (...) is displayed after the Order 
column on that line. You can click this ellipsis button to get a quick view of the orders. A list of the 
order names is displayed in a popup dialog box. To close this dialog box, click in it.  

6. If more than one order is included in a container, collection information for only the first order is shown 
initially, in the container row of the spreadsheet. To expand the spreadsheet to display collection 
information for the other orders, click anywhere in that container row. Then, from the View menu, 
select View Show Detail. The additional rows will be displayed below the container row. To hide these 
rows, from the View menu select View Hide Detail. 

7. In the Modify Collections spreadsheet, make the necessary changes to collection date, collection time, 
collector ID, and collection method for the selected containers or orders. 

To modify a single collection date, collection time, collector ID, or collection method, 
double-click the appropriate cell and enter or change the information.  
To modify the information in an entire column at once, click the column header to open a 
dialog box in which you can make the change. If you want to modify the information in only 
a certain block of cells in the column, drag the mouse to select (highlight) the block of cells; 
the same dialog box then opens. 

8. From the Task menu, select Modify to save the changes you have made to collection information. You 
will be prompted for confirmation. You also may be prompted to reprint labels and to specify a label 
printer.  

Whether you are prompted to reprint labels depends on the specifications in the Modify Options dialog box. If you 
do not see the Reprint Labels prompt, it may be because the option to always reprint labels or to never reprint 
labels is selected in the Modify Options dialog box, or the option to reprint labels for recollects only is selected. To 
change this, open the Modify Options dialog box. (From the View menu, select Options.) The Modify Options dialog 
box is also where you select a label printer. 

Recollecting Collections 

Complete the following steps to update containers or orders to a Dispatched status, enabling them to be 
recollected: 

1. Under Mode, select the Recollect option.  
2. In the Accession Number box, enter the accession number that includes the collections to be 

recollected.  
3. Click Retrieve. The system displays a list of the containers associated with the accession number. 

Information about the person whose accession number was entered is displayed under Demographics.  
4. To display detailed information about the containers, from the Task menu, select Container Inquiry. The 

Container Inquiry application opens, displaying container information for the accession number entered 
in Modify Collections. (For information about how to use Container Inquiry, click the Help menu in 
Container Inquiry.) When you close Container Inquiry, you will be returned to Modify Collections.  

5. If more than one order is included in a container, an ellipsis button (...) is displayed after the Order 
column on that line. You can click this ellipsis button to get a quick view of the orders. A list of the 
order names is displayed in a popup dialog box. To close this dialog box, click in it.  

6. If more than one order is included in a container, collection information for only the first order is shown 
initially, in the container row of the spreadsheet. To expand the spreadsheet to display collection 
information for the other orders, click anywhere in that container row. Then, from the View menu, 
select View Show Detail. The additional rows will be displayed below the container row. To hide these 
rows, from the View menu select View Hide Detail. 

Note 
Rows displaying containers that have not yet been collected (such as those in a status of 
Dispatched, Missed, and Canceled), and rows displaying orders that are in-process or 
completed, are locked and may display a specific background color to indicate they cannot 
be modified. (The color, if any, is defined in the Modify Options dialog box and can be 
changed. From the View menu, select Options to open the Modify Options dialog box.) 
Once you modify data in a row (step 7), you can no longer display the order names or 
collection details (as described in steps 5 and 6) or hide the collection details for that 
container, once they are displayed.

Note 
Collections can be modified only when the container status is Collected, In-
Transit, or Stored. Other statuses are displayed but the collection information 
in those rows will not be modifiable.
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7. In the Mark Collections to Recollect spreadsheet, select the containers or orders that you want to be 
recollected by entering a check mark in the R column. (If a container has more than one order, and 
only some of the orders are marked for recollection, these orders will be pulled and put into a new 
container.)  

8. From the Task menu, select Recollect to update the collections to a Dispatched status. You will be 
prompted for confirmation. You also may be prompted to reprint labels and to specify a label printer.  

Whether you are prompted to reprint labels depends on the specifications in the Modify Options dialog box. If you 
do not see the Reprint Labels? prompt, it may be because the option to always reprint labels or to never 
reprint labels is selected in the Modify Options dialog box. To change this, open the Modify Options dialog box. 
(From the View menu, select Options.) The Modify Options dialog box is also where you select a label printer. 

Transfer Specimens 

Overview 

Use Transfer Specimens to view a list of specimens requiring transport from their current location to the testing 
laboratory. You can modify, print, or delete this list. In addition, you can create a new transfer list or configure a 
transfer list manually by entering the accession numbers. 

When specimens are collected and logged in, the system captures the log-in location. Each laboratory test site is 
associated with a log-in location to identify the physical area where it resides. The From and To locations for 
transfer lists consist of one or more log-in locations. 

The transfer list includes details about each specimen, such as accession number, container number and 
description, orders, patient name, and patient number. 
When the courier picks up specimens, the list can be updated to a transferred status. The system captures the 
date, time, and identification of the person responsible for transfer. The specimen containers then have an in-
transit status until they are received at a new log-in location. 

Each transfer list is assigned a list number, which can be used at the receiving location to perform a batch log-in by 
list number. The printed list can be used as a checklist to verify that all specimen containers are sent and received. 

Viewing Transfer Lists 

Complete the following steps to view a transfer list or lists: 

1. If you want to view existing lists that have not been transferred, select the Not Transferred option.  
2. If you want to view lists that have been transferred, select the Transferred option. Lists that have been 

transferred can be reprinted, but they cannot be modified, deleted, or transferred again.  
3. Make a selection from the From list.  
4. Make a selection from the To list. This is the destination location.  
5. From the date spin box, specify the date of the transfer lists you want to view.  
6. Click Retrieve. The system then retrieves all transfer lists for which specimens have not yet been 

transferred for the specified locations and date. The transfer list numbers are displayed in the Transfer 
Lists list. Information about the highlighted list is displayed in the spreadsheet to the right of the list.  

7. You can review information for a different list whose information was retrieved by clicking the 
appropriate transfer list number in the Transfer Lists list.  

8. To print a transfer list, first click it so that it is highlighted. Then, from the Task menu, select Print List.  

Modifying Transfer Lists 

Transfer lists can be modified before transfer by adding or removing specimen containers. You also can modify 
transfer lists manually. Lists that have been transferred cannot be modified. 
Complete the following steps to modify a list: 

1. Specify the From and To locations, and the date of the transfer list you want to modify, then click 
Retrieve.  

2. If more than one transfer list number is displayed in the Transfer Lists list, click the number of the list 
that is to be modified. The information for that transfer list then is displayed.  

3. Click Modify. The Modify Transfer List window opens.  
4. If you want to create a new transfer list using a list of available containers, select the List Build option 

under Mode. For more information on how to do this, click here.  
5. If you want to configure a transfer list manually by entering the accession and container ID of each 

specimen, select the Manual Build option under Mode.  

Note 
Rows displaying containers that have not yet been collected (such as those in a status of 
Dispatched, Missed, and Canceled), and rows displaying orders that are in-process or 
completed, are locked and may display a specific background color to indicate they cannot 
be selected now. (The color, if any, is defined in the Modify Options dialog box and can be 
changed. From the View menu, select Options to open the Modify Options dialog box.) 
Once you select a row (step 7), you can no longer display the order names collection 
details (as described in steps 5 and 6) or hide the collection details for that container, once 
they are displayed.
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6. When you have finished updating the transfer list, click Update. Transfer Specimens returns you to the 
main window.  

Configuring New Transfer Lists 

Complete the following steps to create a new transfer list: 

1. From the Transfer Specimens main window, click New to open the Build Transfer List window.  
2. Under Mode, select the List Build option.  
3. Make a selection from the From list.  
4. Make a selection from the To list.  
5. Make a selection from the Transfer Temp list or accept the default of (All). This list is displayed only 

when Filter by Transfer Temperature option has been selected in the Transfer Specimens Options dialog 
box from the View menu.  

6. Click Retrieve. The system searches for specimen containers qualifying for transfer and displays them 
in the Available spreadsheet.  

7. Make a selection from the Available list and click Move> to add them to the Selected spreadsheet. To 
add all available containers to the Selected spreadsheet, click Select All before clicking Move.  

8. Click Save. A message box opens, displaying the list number assigned to the specimens and the 
origination and designation locations of the transfer list. Click OK to close this message box.  

Deleting Transfer Lists 

Transfer lists can be deleted before being transferred to its designation. This will remove the transfer list number 
from the system. The specimen containers that were on the deleted list then can be added to a new transfer list, if 
appropriate. Lists that have been transferred cannot be deleted. 
Complete the following steps to delete a transfer list: 

1. Specify the from and to locations, and the date of the transfer list you want to delete, then click 
Retrieve.  

2. If more than one transfer list number is displayed in the Transfer Lists list, select the list that is to be 
deleted. The information for that transfer list then is displayed.  

3. Click Delete. After confirmation, the transfer list is deleted.  

Transferring Specimens 

When the specimens are ready to be transferred, such as when the courier picks them up, you can document this 
in the system. 
Perform the following steps: 

1. Specify the from and to locations, and the date of the transfer list in which the specimens are included, 
then click Retrieve.  

2. If more than one transfer list number is displayed in the Transfer Lists list, click the number of the list 
in which the specimens to be transferred are included. The information for that transfer list then is 
displayed.  

3. Click Transfer. After confirmation, the displayed containers are updated to a status of in-transit. If you 
have selected the Auto Print Transferred Transfer Lists option from the Transfer Specimens Options 
dialog box, the transfer list is automatically printed when you click Transfer.  

Specimen Login 

Overview of Specimen Login 

Use Specimen Log-In to document specimen collection information, such as the collection time, collection ID, 

Note 
If you have selected the Auto Print Created/Updated Transfer Lists option from the Transfer 
Specimens Options dialog box, the modified transfer list is printed automatically when you click 
Update. Otherwise, you can print the list by selecting it in the main window, and then selecting Print 
List from the Task menu.

Note 
The new transfer list is automatically printed when you click Save if you have selected the Auto Print 
Created/Updated Transfer Lists option from the Transfer Specimens Options dialog box. Otherwise, 
you can print the list by selecting it in the main window, and then selecting Print List from the Task 
menu.

Note 
Specimen containers that are in-transit no longer will be displayed in the Transfer Specimens window. 
After being logged in at a new location, they can then qualify for a new transfer list, if applicable.
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collection method, and the location where the specimen was received. The system can capture multiple locations 
for one specimen, starting at the initial place of collection and ending with a testing laboratory or storage location. 
Each log-in location is stored by the system along with the date and time the specimen was logged in and the 
person who received it. 

Most information is entered using a spreadsheet format. This spreadsheet displays data about the pending 
collections, such as the ordered procedures, containers, and scheduled dates and times. Details about each 
collection are displayed in the spreadsheet. 

Various methods are available to identify the specimens to be logged in. You can log in specimens using the 
location, collection or transfer list, patient, or accession number. You must select one of these log-in options before 
you can start the log-in process. 

When specimen collection is unsuccessful, it can be marked as missed, with options to reschedule the collection, 
put the collection on hold, or cancel the orders. The system stores the reason missed along with the date, time, 
and ID of the person who missed the collection. 

Collection comments can be viewed or added in Specimen Login and label comments can be viewed. 

Specimens collected for testing in the microbiology laboratory require additional information that is not needed for 
general laboratory specimens. An additional window will open during the log-in process to prompt for and capture 
the required data for these specimens. 

Logging in by Location 

Complete the following steps to log in by location: 

1. Select the Location option under the Log-In By heading in the Specimen Log-In window  
2. A facility is displayed to the right of the option buttons. If this is not the correct facility, choose Select 

Facility from the View menu to open the Select a Facility dialog box so you can select the appropriate 
facility. You are able to change the facility only if the active log-in template allows it.  

3. Make a selection in the Location box. This is the location from which the specimens are to be collected, 
such as patient's location or associated nurse unit.  

4. The current date is displayed in the Scheduled Date box. If the active log-in template allows you to 
modify this date, this box will be active. Depending on how this option is defined in the log-in template, 
you can retrieve collection information for the specific date only, for all collections prior to and including 
that date, or for all dates.  

5. Click Retrieve. The Log-In By LOCATION window opens and displays the appropriate collection 
information.  

6. In the spreadsheet, enter any missing required information for the accession. Certain displayed data 
can be changed if necessary. The following is a description of the required and modifiable collection 
information.  

Entering Collection Information for Specimens 

Certain data must be entered in the spreadsheet before a specimen can be logged in. If this information is missing, 
you can enter it. Certain displayed data can be changed, if necessary. 

Depending on how the active log-in template is defined, you may be able to enter or modify information in multiple 
cells simultaneously. If this feature is activated, you can enter a value in all of the populated cells in a column or in 
all of the cells in a selected block at once. Click the column header or highlight a block of cells in a column that 
contains modifiable data to open the appropriate dialog box from which you can make your modifications. You then 
can specify the information to be entered in the cells if it is the same for all. 

The following collection information is displayed in the spreadsheet: 

Non-Modifiable Columns Description 

Modifiable Columns Description 

Patient 
column 

Displays the name of the patient associated with the collection. 

Accession 
column 

Displays the accession number assigned to the collection. 

Container 
column 

Displays the container or containers used for the collection. 

Order 
column 

Displays the order or orders associated with the collection. If multiple orders are associated with an 
accession, the system displays an ellipsis button to the right of the Order column; click that button 
for a list of associated orders. The ellipsis button is displayed only when details are hidden. 

Priority 
column 

Displays the priority for the order. 

Status 
column 

Displays the status of the collection. 

Cont/Vol 
column 

Displays the container's volume. If multiple containers were used to collect the specimen, the 
system displays an ellipsis button to the right of the Cont/Vol column; click that button to display a 
list of containers. The ellipsis button is displayed only when details are hidden. 
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1. To display details about a collection, including all containers and orders associated with an accession, 

select the accession row and then select Details from the Task menu.  
2. To hide the displayed collection details, select a row and then select Details from the Task menu. If you 

select Details when a container row is selected, the spreadsheet contracts so that the order information 
for that container no longer is displayed. If you select Details when an accession row is selected, the 
spreadsheet contracts so that the container information for that accession no longer is displayed.  

3. is displayed in the Comments column if collection comments exist for a container, or if label comments 
exist for an order. To view these comments, select Comments from the View menu to open the 
Comments dialog box.  

4. The Location box displays the location to which the containers for the selected specimens will be logged 
in. If this is not the correct location, select the appropriate location in the box.  

5. To mark collections as missed, select the accessions, orders, or containers you want to mark as missed 
by entering checkmarks at the beginning of the appropriate rows and then selecting Miss Specimen 
from the Task menu.  

6. To log in collections as received, select the accessions, orders, or containers you want to log in by 
entering check marks at the beginning of the appropriate rows and then selecting Log In Specimen 
from the Task menu.  

7. Update the list of collections displayed at any time by selecting Refresh from the View menu. This 
updates the spreadsheet with any new pending collections and new collection information for orders 
already displayed.  

Logging in by List 

The List option enables you to log in specimens by collection list or transfer list. Perform the following steps to log 
in by a collection or transfer list: 

1. Select the List option under the Log-In By heading in the Specimen Log-In window.  
2. To log in by the collection list, enter the number assigned to the collection list in the Collection List 

Number box.  
3. To log in by the transfer list, enter the number assigned to the transfer list in the Transfer List Number 

box.  
4. The current date is displayed in the List Date box. You can modify this date, if appropriate.  
5. Click Retrieve. The Log-In By LIST window opens and displays the appropriate collection information.  
6. In the spreadsheet, enter any required information that is missing for the accession. Certain items can 

be modified, if necessary.  
7. To display details about a collection, including all containers and orders associated with an accession, 

select the accession row and then select Details from the Task menu.  
8. To hide the displayed collection details, select a row and then select Details from the Task menu. If you 

select Details when a container row is selected, the spreadsheet contracts so that the order information 
for that container no longer is displayed. If you select Details when an accession row is selected, the 
spreadsheet contracts so that the container information for that accession no longer is displayed.  

9. A paperclip icon  is displayed in the Comments column if collection comments exist for a container, 

or if label comments exist for an order. To view these comments, select Comments from the View menu 
to open the Comments dialog box.  

10. The Location box displays the location to which the containers for the selected specimens will be logged 
in. If this is not the correct location, select the appropriate location in the box.  

11. To mark collections as missed, select the accessions, orders, or containers you want to mark as missed 
by entering checkmarks at the beginning of the appropriate rows and then selecting Miss Specimen 
from the Task menu.  

12. To log in collections as received, select the accessions, orders, or containers you want to log in by 
entering check marks at the beginning of the appropriate rows and then selecting Log In Specimen 
from the Task menu.  

13. Update the list of collections displayed at any time by selecting Refresh from the View menu. This 
updates the spreadsheet with any new pending collections and new collection information for orders 
already displayed.  

Logging in by Patient 

(log-in 
indicator) 
column 

Select the cell in the row that you want to log in or mark as missed. Select all the rows in the 
spreadsheet by right-clicking the column header, and then selecting Check All from the context 
menu. To remove all the check marks, select Uncheck All from the context menu. 

Coll Date 
column 

Displays a collection date. If a date is not displayed, enter the date that the specimen was 
collected. You can change a displayed collection date if the specimen has not yet been collected. 

Coll Time 
column 

Displays a collection time. If a time is not displayed, enter the time that the specimen was 
collected. You can change a displayed collection time if the specimen has not yet been collected. 

Coll ID 
column 

Displays a collector ID. If an ID is not displayed, enter the ID of the person who collected the 
specimen. You can change a displayed collector ID, if necessary. 

Coll Method 
column 

Displays a collection method. If a collection method is not displayed or is Incorrect, select the 
appropriate method from the collection method list by clicking in the cell. 

Rec Date 
column 

Displays a received date for the collection. You can change this date, if necessary. 

Rec Time 
column 

Displays a received time for the collection. You can change this time, if necessary. 

Rec ID column Displays a received ID for the collection. You can change this ID, if necessary. 
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The Patient option enables you to log in specimens by the patient's name, medical record number, financial 
number, or requisition number. Perform the following steps to log in by a patient name, medical record, financial 
number, or requisition number: 

1. Select the Patient option under the Log-In By heading in the Specimen Log-In window.  
2. From the View menu, select Patient by Name, by Medical Record Number, by Financial Number, or by 

Requisition Number. Depending on the selected option, the label on the corresponding box will change 
to Name, Medical Record Number, Financial Number, or Requisition Number.  

To log in specimens by the patient's name, select Patient by Name and enter that name in the Name box from the 
View menu. If you are entering a patient name, you must enter the last name, then a comma, and then the first 
name. If you do not know the patient's full name or associated number, click the ellipsis button to open the Search 
dialog box for assistance. To narrow the search, enter one or more letters or numbers in the Name or Number box 
prior to clicking the ellipsis button. 

To log in specimens by the patient's financial number, select Patient by Financial Number from the View 
menu and enter that number in the Financial Number box.  
To log in specimens by the patient's requisition number, select Patient by Requisition Number from the 
View menu and enter that number in the Requisition Number box.  

1. If the Scheduled Date box is active, the current date will be displayed as the scheduled collection date. 
If the active log-in template allows you to modify this date, this box will be active. Depending on how 
this option is defined in the log-in template, you can retrieve collection information for the specific date 
only, for all collections prior to and including that date, or for all dates.  

2. Click Retrieve. The Log-In By PATIENT window opens and displays the appropriate collection 
information.  

3. In the spreadsheet, enter any required information that is missing for the accession. Certain items can 
be modified if necessary.  

4. In the spreadsheet, enter any required information that is missing for the accession. Certain items can 
be modified, if necessary.  

5. To display details about a collection, including all containers and orders associated with an accession, 
select the accession row and then select Details from the Task menu.  

6. To hide the displayed collection details, select a row and then select Details from the Task menu. If you 
select Details when a container row is selected, the spreadsheet contracts so that the order information 
for that container no longer is displayed. If you select Details when an accession row is selected, the 
spreadsheet contracts so that the container information for that accession no longer is displayed.  

7. A paperclip icon  is displayed in the Comments column if collection comments exist for a container, 

or if label comments exist for an order. To view these comments, select Comments from the View menu 
to open the Comments dialog box.  

8. The Location box displays the location to which the containers for the selected specimens will be logged 
in. If this is not the correct location, select the appropriate location in the box.  

9. To mark collections as missed, select the accessions, orders, or containers you want to mark as missed 
by entering check marks at the beginning of the appropriate rows and then selecting Miss Specimen 
from the Task menu.  

10. To log in collections as received, select the accessions, orders, or containers you want to log in by 
entering check marks at the beginning of the appropriate rows and then selecting Log In Specimen 
from the Task menu.  

11. Update the list of collections displayed at any time by selecting Refresh from the View menu. This 
updates the spreadsheet with any new pending collections and new collection information for orders 
already displayed.  

Logging in by Accession 

The Accession option enables you to log in one or more specimens by accession number. Complete the following 
steps to log in by accession numbers: 

1. Select the Accession option under the Log-In By heading in the Specimen Log-In window.  
2. Click Retrieve to open the Log-In By Accession window.  
3. In the Accession box, enter the accession numbers for the collections you want to log in.  
4. In the spreadsheet, enter any required information that is missing for an accession. Certain items can 

be modified if necessary.  
5. To display details about a collection, including all containers and orders associated with an accession, 

select an accession row and then select Details from the Task menu.  
6. To hide the displayed collection details, select a row and then select Details from the Task menu. If you 

select Details when a container row is selected, the spreadsheet contracts so that the order information 
for that container no longer is displayed. If you select Details when an accession row is selected, the 
spreadsheet contracts so that the container information for that accession no longer is displayed.  

7. A paperclip icon is displayed in the Comments column if collection comments exist for a container, or if 
label comments exist for an order. To view these comments, select Comments from the View menu to 

Note 
If you enter a partial patient name, and the letters entered match with only one name in the database, 
the full patient name is displayed in the Name box as soon as you click the ellipsis button. The system 
does not open the Search dialog box. 

To log in specimens by the patient's medical record number, select Patient by Medical 
Record Number from the View menu and enter that number in the Medical Record Number 
box.  
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open the Comments dialog box.  
8. The Location box displays the location to which the containers for the selected specimens will be logged 

in. If this is not the correct location, select the appropriate location in the box.  
9. To mark collections as missed, select the accessions, orders, or containers to be marked as missed by 

entering checkmarks at the beginning of the appropriate rows and then selecting Miss Specimen from 
the Task menu.  

10. In the (log-in indicator) column, check marks are entered automatically by the system as you enter 
each accession number. To log in the collections as received, select Login Specimen from the Task 
menu. 

11. Update the list of collections displayed at any time by selecting Refresh from the View menu. This 
updates the spreadsheet with any new pending collections and new collection information for orders 
already displayed.  

Entering Collection Information for Specimens 

Certain data must be entered in the spreadsheet before a specimen can be logged in. If this information is missing, 
you can enter it. Certain displayed data can be changed, if necessary. 

Depending on how the active log-in template is defined, you may be able to enter or modify information in multiple 
cells simultaneously. If this feature is activated, you can enter a value in all of the populated cells in a column or in 
all of the cells in a selected block at once. Click the column header or highlight a block of cells in a column that 
contains modifiable data to open the appropriate dialog box from which you can make your modifications. You then 
can specify the information to be entered in the cells if it is the same for all. 

The following collection information is displayed in the spreadsheet: 

Non-Modifiable Columns Description 

 

 

Modifiable Columns Description 

 

Note 
If you do not want to log in an accession number, deselect that accession.

Patient 
column 

Displays the name of the patient associated with the collection. 

Accession 
column 

Displays the accession number assigned to the collection. 

Container 
column 

Displays the container or containers used for the collection. 

Order 
column 

Displays the order or orders associated with the collection. If multiple orders are associated with an 
accession, the system displays an ellipsis button to the right of the Order column; click that button 
for a list of associated orders. The ellipsis button is displayed only when details are hidden. 

Priority 
column 

Displays the priority for the order. 

Status 
column 

Displays the status of the collection. 

Cont/Vol 
column 

Displays the container's volume. If multiple containers were used to collect the specimen, the 
system displays an ellipsis button to the right of the Cont/Vol column; click that button to display a 
list of containers. The ellipsis button is displayed only when details are hidden. 

(log-in 
indicator) 
column 

Select the cell in the row that you want to log in or mark as missed. Select all the rows in the 
spreadsheet by right-clicking the column header, and then selecting Check All from the context 
menu. To remove all the check marks, select Uncheck All from the context menu. 

Coll Date 
column 

Displays a collection date. If a date is not displayed, enter the date that the specimen was 
collected. You can change a displayed collection date if the specimen has not yet been collected. 

Coll Time 
column 

Displays a collection time. If a time is not displayed, enter the time that the specimen was 
collected. You can change a displayed collection time if the specimen has not yet been collected. 

Coll ID 
column 

Displays a collector ID. If an ID is not displayed, enter the ID of the person who collected the 
specimen. You can change a displayed collector ID, if necessary. 

Coll Method 
column 

Displays a collection method. If a collection method is not displayed or is Incorrect, select the 
appropriate method from the collection method list by clicking in the cell. 

Rec Date 
column 

Displays a received date for the collection. You can change this date, if necessary. 

Rec Time 
column 

Displays a received time for the collection. You can change this time, if necessary. 

Rec ID column Displays a received ID for the collection. You can change this ID, if necessary. 
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Marking Collections as Missed 

When you select the Miss option, the Missed Collection dialog box opens. If multiple accession numbers are 
selected, the system opens a Missed Collection dialog box for each selected accession; these are not all displayed 
at the same time. After you close the first one, the second will open so you can enter specific information for each 
missed item individually. 
To mark a collection as missed, perform the following steps: 

1. Select the collection to be marked as missed, then select Miss Specimen from the Task menu in the 
Log-In By [Log-In Option] window to open the Missed Collection dialog box.  

2. Under the Miss What? heading, select the appropriate option to indicate the level at which the collection 
was missed, such as container, order, or accession.  

3. If you selected the Partial by Container(s) option or the Partial by Order(s) option, the dialog box 
expands to display a list of all the related containers or orders. Enter check marks in one or more boxes 
to indicate the containers or orders which you want to mark as missed.  

4. Under Action, select the appropriate option to indicate the action you want to take on the missed items.  
5. Make a selection in the Miss Reason box. The label on this box displays Cancel Reason if the Cancel 

Order(s) option was selected.  
6. The ID box displays the ID of the person who is signed on to the system currently. This ID can be 

changed, if appropriate.  
7. The Date/Time boxes display the current date and time. If a different date or time should be recorded 

for the missed collection, make the necessary changes.  
8. When you are finished, click OK to save your changes and mark the collections as missed.  

Viewing Comments 

To view comments, perform the following steps: 

1. In the Log-In By [Log-In Option] window, select the accession, container, or order for which you want 
to view comments. You can tell when comments exist for an item because is displayed on the line.  

2. Select Comments from the View menu to open the Comments dialog box.  
3. Depending on whether you want to view collection comments or label comments , click the Collection 

Comments tab or the Label Comments tab.  
4. To add new comments, click Add to open the Add Comment dialog box. Select Collection Comments or 

Label Comments in the Comment Type box to indicate the type of comment being added, then enter 
the comment in the Comment box.  

5. To close the Comments dialog box, click Close.  

Printing Specimen Labels 

 
Complete the following steps to print specimen labels for selected orders, containers, or accessions: 

1. In the Log-In By [Log-In Option] dialog box, select the orders, containers, or accessions for which you 
want to print labels by entering check marks in the boxes at the beginning of the appropriate rows. 

2. Select Label Printer from the Task menu to open the Label Printer dialog box.  
3. In the Label Printer box, select the label printer to which you want the specimen labels to be sent.  
4. The Set As Default Label Printer option is selected automatically when this dialog box is opened. If you 

do not want the selected label printer to be the default for all specimen labels that are printed from any 
Log-In By [Log-In Option] window, deselect this option. Your selection then will apply only to the 
current window. 

5. Click OK to save your selection and close the Label Printer dialog box.  
6. Select Print Labels from the Task menu to send the labels to the printer.  

Preventing Auto-verification for an Accession 

To prevent auto-verification for a specific accession, complete the following steps: 

1. Select Prevent Auto-verification for Accession from the Task menu in the Specimen Log-In window to 
open the Prevent Auto-verification dialog box.  

2. Click Select, and then enter the accession number for which auto-verification should not be allowed.  
3. Click OK to close the dialog box and return to the Prevent Auto-verification dialog box.  
4. Click OK to return to the Specimen Log-In window.  

Note 
If you want to use the default label printer, skip Steps 2 through 5.

Note 
If you have multiple Log-In By [Log-In Option] windows open, the Label Printer dialog box 
closes only after you indicate whether you want your changes applied to the specimens 
listed in all of the open Log-In By [Log-In Option] windows.
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Label Preprint 

Overview 

Use Label Pre-Print to generate labels for accessions that are unused (that is, that have not been assigned to any 
orders in the system). These labels can be placed on specimens that are collected prior to order entry. The 
accessions then will be manually assigned to the orders in Departmental Order Entry. 
Label Pre-Print typically is used to preprint labels in the following situations: 

At a remote drawing station that has no PathNet terminal  
In a trauma unit where specimens are drawn in an emergency situation  
At a drawing station at a community health fair  
When a downtime is scheduled 
In all of these cases, orders are entered into the system after specimens are collected, and the Pre-
printed accession number is entered with the orders in Departmental Order Entry.  

The labels are distributed in advance to the appropriate locations, and are affixed to the specimen containers 
before they are transported to the collection area. When the specimens are received, the accession number printed 
on the label is assigned to the corresponding ordered procedures. 

Label Reprint 

Overview 

Use Label Reprint to reprint labels for specimen containers. This is useful for replacing lost or damaged labels, or 
for printing additional labels. 
Labels are printed for one accession at a time. A label is automatically printed for each container on the accession. 

Reprinting Labels 

To reprint labels by accession: 

1. Select the Accession tab in the Label Reprint window.  
2. In the Starting Accession box, enter the first accession number for which you want to reprint labels. If 

your institution uses site prefixes, enter the one- to five-character site prefix before entering the 
accession number. Depending on your database settings, the system may display a default site prefix; 
this can be changed. For more information about completing this box, click here.  

3. In the Ending Accession box, enter the last accession number for which you want to reprint labels.  
4. If you want to reprint labels for a specific service resource, select the appropriate service resource in 

the Service Resource box. The list is populated by all service resources associated with the entered 
accession or list. Typically, you should accept the default of All to reprint labels for all service resources.  

5. In the Label Printer box, select the label printer ID to which you want the labels to be sent.  
6. Under the Label Types heading, select either All Labels, Specimen Labels, or Aliquot Labels to indicate 

the type of labels to be reprinted.  
7. Click Print. To print another copy of the same labels, click Print again.  

To reprint labels by Collection List or Transfer List 

1. Select the List tab in the Label Reprint window.  
2. Select either the Collection List or Transfer List option to indicate the type of list for which labels are 

being reprinted.  
3. In the Date box, enter the date of the list.  
4. In the List Number box, select or enter the number of the Collection List or the Transfer List.  
5. In the Service Resource box, select the appropriate service resource for which you are reprinting labels.  
6. In the Label Printer box, select the label printer ID to which you want the labels to be sent.  
7. Under the Label Types heading, select either All Labels, Specimen Labels, or Aliquot Labels to indicate 

the type of labels to be reprinted.  
8. Click Print. To print another copy of the same labels, click Print again.  

Worklist Configure 

Overview of DB Worklist Build 

Use DB Worklist Build to specify predefined parameters for commonly requested worklists. Basically, you are 
creating a template that will be used to create actual worklists in the Worklist Request application. When you define 
the parameters for a commonly requested worklist, you assign a name to identify this template or set of 
parameters. The name then can be used when requesting a worklist in Worklist Request to make the process of 
requesting a worklist quick and efficient. 

Worklists can be requested for a specific test site and orderable item. A worklist that includes space to write results 
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is called a worksheet. 

A worklist name or template can include many options, such as all orderables for the specified test site, or only 
specific orderables or assays. You also can specify priorities to be included, printing and formatting specifications, 
and other various options for information to be included in the worklist. 

 

Assigning a Worklist Name 

A worklist name is used to identify the template or set of predefined parameters for requesting a worklist. To 
assign a worklist name, complete the following steps: 

1. In the DB Worklist Build window, select New Worklist Name from the Task menu to open the New 
Worklist dialog box.  

2. In the Test Site box, enter the name of the test site for which you want to define worklist parameters. 
For a list of available test sites, click (You may enter one or more characters in the Test Site box prior 
to clicking the ellipsis button to narrow the information displayed). The Test Site Lookup dialog box 
opens; select the appropriate test site from the displayed list.  

3. In the Name box, enter the worklist name for which you want to define parameters. This name will be 
displayed to users creating worklists so it should be as clear as possible to reflect the information that 
will be contained in the completed worklist.  

4. Click OK to save the information and close the New Worklist dialog box. The worklist name and test site 
are displayed at the top of the DB Worklist Build window so you can continue defining parameters for 
the template.  

Specifying Orderables to be Included in the Template 

You can include all orderable items for the selected test site or you can specify one or more orderable items or 
assays to be included in the worklist template. To identify orderable items to be included in the template, complete 
the following steps. 

1. To include all orderable items for the test site, select the All option in the Procedures box in the DB 
Worklist Build window. This option is the default and is selected automatically when you are first 
defining a worklist name.  

2. To include one or more orderable items in the template being defined, select the Order option, then 
click Change to open the Select Worklist Procedures dialog box. The Available box displays all orderable 
items that are defined for the test site. Move the procedures to be included in the worklist to the 
Selected box. 

  

3. To include one or more assays in the template being defined, select the Detail option, then click Change 
to open the Select Worklist Procedures dialog box. The Available box displays all assays that are 
defined for the test site. Move the assays to be included in the worklist to the Selected box. 
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Specifying a Fill Template 
You can format your worklist based on the layout of the plate, tray, or rack you are using. You can 
define fill parameters, which determine how the accessions populate the worklist when doing an 
automatic configure in Worklist Request. To include and define a template and fill parameters for the 
worklist parameters, complete the following steps:  

4. Select include in the Template Box, then click Setup. 

  

5. Enter the dimensions of the plate, tray or rack you want to associate to this worklist. The template 
considers plates, trays and racks to be square, with the intersections of rows ad columns as a container 
position.  

6. Columns: Enter the number of columns in the plate, tray or rack. You can enter a positive whole 
number between 1 and 9999. If you want to name the columns using letters rather than numbers, 
select the Alpha option.  

7. Rows: Enter the number of rows in the plate, tray or rack. You can enter a positive whole number 
between 1 and 9999. If you want to name the rows using letters rather than numbers, select the Alpha 
option. 

  

8. Select the fill options to determine how the system will fill the template with accessions. As you define 
the Fill Options, the Fill Sequence tab at the bottom of the dialog box is updated automatically, 
displaying how the template will look. The numbers in the cells are the order in which the accessions 
will populate the worklist when doing an automatic configure in Worklist Request.  

9. Now that you have defined the fill sequence, you can define any dilutions for positions in the template. 
To do this, select the Dilutions tab at the bottom of the Template Setup dialog box. The define a 
dilution, select a cell and press F2. Select a dilution in the Dilution List of Values dialog box and click 
OK. The dilution value is then displayed in the cell.  

10. Next, select the Summary tab to view details of the template you have defined. This information is 
ready only. The Fill Sequence number is the order seen on the Fill Sequence tab. The Position is the 
Row:Column intersection. The Dilution is the value that was added on the Dilution tab. The QC 
Accession and QC Short Description are defined when you set up the Quality Control parameters.  

11. When all options have been defined for the template, Click OK. The dialog box will close and the 
template is saved as part of the worklist parameters. If at any time, you deselect the Include option in 
the Template box, the template parameters that you defined remain saved, but are not applied at the 
time the worklist is created in Worklist Request. You can then select Include at a later time and the 
previously defined template is applied to the worklist once again.  

Including Quality Control Accessions in the Template 

Quality Control (QC) accession numbers can be included in the worklist template. To include QC accessions in the 
worklist template, complete the following steps: 

In the Quality Control box in the DB Worklist Build window , select the appropriate option. 

1. Select the QC Only option if you want the worklist to contain only QC accession numbers for 
the specified test site.  

2. Select the Include option if you want the worklist to include QC accession numbers, as well 
as the accession numbers for the orderable items.  

3. Select the Exclude option if QC accession numbers are not to be included in the worklist 
template. This is the default. If you select this option, you are done with this task. The 
steps below are applicable only if you are including QC accessions in the template. 
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Including QC when not Including a Fill Template  

1. If you indicate that QC accession numbers are to be included in the template, and you have not chosen 
to Include a Fill Template, click Setup. The QC Accessions dialog box opens so you can assign QC 
accessions to the worklist parameters being defined.  

2. In the QC Accessions dialog box, select the appropriate accession number in the Available Accessions 
box, then click Add. This moves the selected accession number to the displayed spreadsheet.  

3. Indicate whether you want this QC accession number to be printed at the beginning or end of the 
worksheet, or at specified intervals, by checking the appropriate column in the spreadsheet.  

4. If you selected the At Intervals option, in the Interval column enter the number of patient accessions 
that define the interval between QC accessions.  

5. Click Apply to save the information entered and keep the QC Accessions dialog box open so another QC 
accession can be added.  

6. Repeat steps 4 through 6 for each additional QC accession to be included in the worklist.  
7. You can rearrange the order in which QC accessions will be printed (for example, you could specify 

three accessions to print at the beginning of the worksheet, but you want one of them always to be the 
third one to print). Change the order by selecting an accession in the Selected Accessions spreadsheet, 
then clicking the Up or Down Arrow buttons as necessary.  

8. Click OK when all appropriate QC accessions have been added.  
9. To remove a QC accession from a worklist, click Setup, select the QC accession, and click Remove.  

Including QC when Including Fill Template 

1. If you indicate that the QC accession numbers are to be included in the template and you have chosen 
to Include a Fill Template, click Template QC.  

2. The QC Accessions - Template dialog box opens so you can assign QC accessions to the worklist 
parameters being defined.  

3. In the QC Accessions dialog box, select the appropriate accession numbers in the Available Accessions 
box, then click Add. This moves the selected accession number to the displayed spreadsheet.  

4. Once you have added all of your QC Accessions, click Place QC. This will bring up your Fill Template 
grid.  

5. Select the position in your Fill Template where you want to add the QC accession (Refer to your Fill 
Template's Fill Sequence tab for the order that accessions will be filled.).  

6. Next, hit F2, or right click on the cell and select list of values. This brings up the list of QC accessions 
that you previously added. Then select the QC accession that you want to add into your Fill Sequence. 
If you made a mistake, click in the cell you want to change, and hit delete, or reselect the QC accession 
that you want to replace it with. When you are done, hit OK.  

7. You will now see Template Positions filled in the Template Positions column. When you are done, hit 
OK.  

8. Now that you have added your QC to your Fill Template, you will see the QC number matched to the 
Position that was selected, on the Summary tab of the Template Setup.  

 
 

Defining Format Options for the Template 

You can specify a vertical or horizontal format under the Format heading in the DB Worklist Build window . To 
specify the format for the worklist name, indicate whether you want the orderable item names to be displayed 
vertically or horizontally on the printed worklist by selecting the appropriate option. The default is vertical. 

 

If the Vertical option is selected, the printed worklist will be formatted with the orderable item names 
listed vertically when multiple items are ordered, or for orderable items containing multiple assays, 
listing detail components on a worksheet.  
If the Horizontal option is selected, the printed worklist will be formatted with the orderable item names 
listed horizontally across the page. If necessary, the orderable item names will wrap to a second line.  

Specifying Information Options for the Template 

Specify the information to be included in the worklist name or template in the Options box in the DB Worklist Build 
window. To specify the information to be included, select the appropriate options. The available options are 
described below. 

 
Accession level: Select this option if you want the qualifying orders to be displayed at the accession level with one
accession number occupying each position or row on the worklist. If you do not select this option, each order for an 
accession number has its own position or row on the worklist. 
In-Lab Only: Select this option to include accession numbers that have been logged in to the laboratory location in 
a worklist. Any orders that have not been logged in will not be included in the worklist. 
Non-Cum: Select this option to include only accession numbers that have not been included in a previously saved 
worklist. 
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Auto assign worklist ID: Select this option to have the system automatically assign the worklist a unique name 
in Worklist Request. The worklist ID that is created, is a sequential number and is displayed in Worklist Request as 
<auto assign ID>. 
Look Ahead Hours: To indicate that the worklist being defined will look ahead for future orders, enter a value 
other than the defaulted zero in the Look Ahead Hours box. 

Print Options 

 
MRN-Encounter: Select this option to include the medical record number (MRN) of the patient for the 
specific encounter.  
FIN-Encounter: Select this option to include the financial number (FIN) for the specific encounter.  

Patient Comments: Select this option to include any comments associated with the patient. 

 Age: Select this option to include the age of the patient at the time the 

worklist is generated. 

Sex: Select this option to include the gender of the patient.  
Race: Select this option to include the race of the patient.  

Visit Reason: Select this option to include the reason for the visit. 
Facility: Select this option to include the facility to which the patient is registered. 
Nurse Unit: Select this option to include the nurse unit to which the patient is registered. 

Room/bed: Select this option to include the room and bed to which the patient is registered.  

Reporting Priority: Select this option to include the reporting priority. 

Specimen Type: Select this option to include the specimen type for the accession.  

Order Status: Select this option to include the status of the order. 

Order Comments/Notes: Select this option to include any order comments or order notes associated 
with the order.  
Collected Date/Time: Select this option to include the earliest date and time the specimen was 
collected.  
Ordering Physician: Select this option to include the physician who placed the order for the 
accession.  

Result Space: Select this option to indicate that the worklist is to print space for results to be written down, thus 
turning a worklist into a worksheet. 

Result Comments/Notes: Select this option to include any result comments or result 
notes associated with the result. For this option to work, the Result Space option must be 
selected.  
Previous Results: Select this option to indicate that the most recent previous result is to 
be printed on the worksheet. For this option to work, the Result Space option must be 
selected.  
Text/Freetext Results: Select this option to print text and freetext result data on the 
worklist. This option applies to current results and previous results (if the Previous Results 
option is selected).  
Cross Test Sites: Select this option to indicate that all assays of an orderable item are to 
be included in a worksheet when the assays are to be performed at different test sites. For 

Note 
The requested collection date and time will determine if a future order is to be included in the specified 
look-ahead time frame.  
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this option to work, the Result Space option must be selected. Additionally, routing for the 
orderable item must be defined at the assay level and it must be routed to more than one 
test site.  

Specifying Priorities to be Included in the Template 

You can include all priorities or you can select one or more specific priorities to be included in the worklist name. 
When a worklist is requested using this worklist template, all orderable items with the specified priorities will be 
included in the worklist if they also meet the other predefined parameters. To specify priorities for the worklist 
template, complete the following steps. 

1. To include all priorities, select the All option in the Priorities box in the DB Worklist Build window. This 
option is the default and is selected automatically when you are first defining the worklist name.  

2. To specify only certain priorities, choose the Select option, then click Change to open the Worklist 
Priorities dialog box, which displays all of the available priorities. Initially, all priorities are selected. 
Clear the check box for any priority you do not want to include, then click OK to save your changes. 
The (Priorities) box in the DB Worklist Build window displays the revised list of priorities.  

Creating File Definitions 

You can create a file definition, which allows a user to download a worklist and send it to an instrument if you do 
not have a Cerner interface with the instrument. Each file definition contains either a Jscript® or VBScript™ local 
script that tells the system what data to use and how to structure it. More information on the local script can be 
found in the All About PathNet Local Script Reference Page. 

Including File Definitions 

Once you have defined file definitions, you can associate one with a set of worklist parameters. Then in Worklist 
Request, you can download the worklist and have a file that can be uploaded to an instrument. 
To associate a file definition wit a set of worklist parameters, complete the following steps: 

In the File Definition for Download box, select Include.  
From the list, select the file definition you want to associate with the worklist parameters.  

 

Defining Printing Options for the Template 

Certain printing options can be defined under the Print heading in the DB Worklist Build window. To define these 
specifications for the worklist name, complete the following steps. 

 

1. In the Printer box, enter the ID of the printer where the worklist is to be printed or select it from the 
drop down list. A valid printer ID must be entered before a worklist can be printed using this worklist 
name.  

2. In the Number of Copies box, enter the number of copies of the worklist that are to be printed. The 
default is one copy.  

3. In the Blank Lines box, enter the number of blank lines to be added to the end of the worklist when it 
prints. Blank lines can be used to add accession numbers or make notes.  

4. Select the Double Space option if the worklist should print double-spaced.  
5. Select the Landscape option if the worklist should print in a landscape format. This option should be 

selected only if your printer is able to print in a landscape format.  

Worklist Request 

Overview 

Worklist Request is used to print a worklist or worksheet using a predefined worklist name or template. If there is 
not an existing worklist name that is appropriate for the needed worklist, you can select Build Ad hoc Worklist from 
the Task menu and identify the parameters for the worklist. Worklist Request displays a list of accession numbers 
that meets the criteria defined for that worklist. You can edit the list of displayed accession numbers and rearrange 
them, if necessary. There is also an option to configure the worklist manually by entering the accession numbers or 
scanning the bar code. 

The list of accession numbers displayed in Worklist Request can be assigned a worklist ID that uniquely identifies 
that list of accession numbers. The date and time is also stamped with the worklist ID so that each worklist ID is 
differentiated by the date and time, if the same worklist ID is used multiple times. 
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Selecting a Worklist 

You can select a worklist for viewing, printing, or editing from the Select Existing Worklist dialog box. 

To select a worklist, perform the following steps: 

1. From the Task menu, choose Select Worklist. The Select Existing Worklist dialog box opens.  
2. Select the worklist name from the Worklist Name list.  
3. A list of existing worklist IDs is displayed based on the worklist name selected, as well as the date and 

time the worklist was created. Select the worklist to be displayed.  
4. To add sequence identifiers to this worklist, select the Use Sequence option. If sequences were 

assigned when the worklist was created, the sequences are displayed and do not need to be 
reassigned.  

5. If you want to view only those orders that have pending assays, select the Display Only Orders with 
Pending Assays option. This also applies to the accession-level worklists where at least one order for 
the accession number has pending assays. If an order does not have any assays pending (they have all 
been verified), it is not displayed when you view the worklist. You cannot modify elements on worklists 
that have only orders with pending assays.  

6. Click OK to display the selected worklist and close the Select Worklist dialog box. You can now view, 
edit, or print the worklist.  

Editing a Worklist 

In the Worklist Request window, you can make changes to an existing worklist, such as rearranging the rows, 
adding or removing accessions, deleting a worklist ID, or saving your changes under a different worklist ID. 

Editing options in Worklist Request include the following: 

If you want to delete the worklist ID associated with the worklist, from the Task menu, select Delete 
Worklist.  
If you want to add an accession number to the worklist, either type or scan the accession number in 
the Accession box and click Add to place the Accession into the worklist. You can also select Insert Row 
from the Edit menu to open the Add Items dialog box, which displays a list of the accession numbers 
that meet the parameters for the selected worklist. If your site has set the preference in Preference 
Manager (Preference Manager.exe), the system will notify you if the accession number you are adding 
already exists on the current worklist or a similar worklist .

If the list of accessions is edited, from the Task menu, select Reset QC Defaults to rearrange the QC 
accessions based on the defined parameters.  
If you want to move an accession number up or down in the list, select a row containing the accession 
number that you want to move. From the Edit menu, select Move Row Up or Move Row Down.  
If you want to remove an accession number from the list, select a row containing the accession number 
that you want to remove. From the Edit menu, select Remove Row.  
If you want to return the displayed list to the original sort based on the arrangement of the columns in 
the spreadsheet, from the Edit menu, select Default Sort.  
If you want to save a worklist after changes have been made, from the Task menu, select Assign 
Worklist.  

Adding Accessions to the Worklist 

You can insert additional accession numbers to the selected worklist in the Add Items dialog box or by scanning or 
typing the Accession number into the Accession number field. 
To add accessions to a selected worklist when not using a Fill Template, perform the following steps: 

1. From the Edit menu, select Insert Row. The Add Items dialog box opens with the list of accessions that 
meet the parameters for the worklist name selected.  

2. Select the accessions you want to add to the worklist.  
3. Click Add to add the selected accession numbers to the worklist.  
4. Click Close to close the Add Items dialog box.  

To add accessions to a selected worklist using the Accession field, perform the following steps : 

1.

a. Select the empty row inserted automatically at the bottom of the worklist, an existing row 
on the worklist, or an empty position in the template.  

b. You can enter an accession number in the Accession box or use a bar-code scanner to enter 
the accession number. Click Add to place the accession number on the worklist. 

Release Considerations 
This functionality is available with the 2007.18 Release Update.

Release Considerations 
This functionality is available with the 2007.18 Release Update.
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To add accessions to a selected worklist when using a Fill Template, perform the 
following steps:  

c. Select the accession number from the Add Accessions list or QC accession number from the 
Add QC Accessions list.  

d. Click the Place Procedure Icon, or select Place Procedure from the Task menu. You can also 
right-click on the selected accession and select Place Procedure.  

e. In the Place Procedure dialog box, select the coordinates of the template position where you 
want to place the accession number, and click OK.  

Assigning a Worklist ID 

The Request ID dialog box enables you to save a worklist after changes have been made by assigning a different 
worklist ID. 

To assign a worklist ID, perform the following steps: 

1. From the Task menu, select Assign Worklist. The Assign Worklist ID dialog box opens.  
2. In the Assign Worklist ID box, enter a worklist ID. If <<Auto Assign ID>> is displayed, it means the 

system can assign the worklist ID for you.  
3. If the worklist is eligible to be downloaded, the Download Worklist option is available and selected. This 

option will save it as a file that can be uploaded to an instrument. Deselect the option if you do not 
want to download the worklist at this time.  

4. Click OK to assign the worklist ID to the list of accession numbers and close the Assign Worklist ID 
dialog box.  

5. If you selected to download the worklist, the Enter Export File dialog box is displayed. Enter a name for 
the export file and select a destination to save the export file to, or accept the default name and 
location.  

6. Click OK. The Worklist is exported and saved to the specified directory as a file that can be uploaded to 
an instrument.  

Creating a New Worklist 

Create a new worklist when you want to request a new list of accession numbers based on a selected worklist 
name. 

To create a new worklist, complete the following steps: 

1. From the Task menu, select Create Worklist. The Create New Worklist dialog box opens.  
2. Select the name of the worklist from the Worklist Name list.  
3. If you want to configure the worklist manually, select the Manual Build option.  

When creating a worklist, if you want the accession numbers to be in a specific order, you can configure the 
worklist manually by entering the accession numbers or scanning the bar code. 

To configure a worklist manually, perform the following 
steps: 

1. From the Task menu, select Create Worklist. The Create New Worklist dialog box opens.  
2. In the Worklist Name list, select the worklist name.  
3. You must select the Manual Configure option to manually configure the worklist. If the Manual 

Buildoption is not selected, a list of all accessions within the selected worklist name is displayed in the 
(Worklist Request) spreadsheet.  

4. If you want to add sequence identifiers to each accession on the worklist, select the Use Sequence 
option.  

5. Click OK to close the Create New Worklist dialog box and return to the Worklist Request window.  
6. In the Worklist Request window, enter the accession number in the Accession box or scan the bar code.  
7. After entering the accession number, click Add to add the accession to the list and clear the accession 

box for the next accession number.  
8. When all the accessions are added, click Display to display the name and procedure information 

associated with each accession that has been entered.  
9. If QC accessions have been defined for this worklist, click Insert QC to insert the QC accessions that 

have been defined for the worklist.  
10. When the list of accessions is complete, click Finished to indicate that you have finished adding 

accession numbers to the worklist and take you out of the Manual Build mode. At this point, you can 
assign a worklist ID and print the worklist.  

11. If you want to add sequence identifiers to each accession on the worklist, select the Use Sequence 
option.  

12. When the Use Sequence option is selected, the worklist automatically adds a sequence identifier to 
each accession on the worklist. You must specify the beginning sequence for the current worklist, and if 
applicable, the range of sequences available.  

13. In the Beginning Number box, enter the sequence number with which the worklist is to start.  
14. Select the Wrap option if there is a specific range of sequences to be used for this worklist. If there are 

more accessions than the number in the range entered, the worklist wraps the sequence identifiers at 
the end of the range and starts over.  

15. In the Instrument Range and the To boxes, enter the range of sequence identifiers for the instrument 
for which the worklist is defined. This information is necessary for instruments that are limited to a 
specific number of accessions within a run.  

16. Click OK to close the Create Worklist dialog box. The list of accession numbers in the Worklist Request 

Page 40 of 75Use PathNet General Laboratory - Reference Pages - uCern Wiki

4/28/2010https://wiki.ucern.com/pages/viewpage.action?pageId=705638

SUNY DMC CLINICAL LABORATORIES Page 37 of 72



spreadsheet is displayed.  

Printing a Worklist 

You can print a worklist or worksheet to a printer other than the defined printer for that worklist. Other printing 
parameters defined for the worklist are displayed and can be changed. You may also do a print preview for the 
worklist if desired. 

To change the printing parameters, perform the following steps: 

1. From the Task menu, select Print. The Printer Select window is displayed.  
2. The predefined printer ID of the worklist is displayed in the Printer box. If necessary, enter a different 

printer name in the Printer box.  
3. Enter the number of copies to be printed in the Number of Copies box, or accept the default value.  
4. Enter the number of blank lines to be printed at the bottom of the worklist or worksheet in the Blank 

Lines box, or accept the default value.  
5. Select the Double Space option if the worklist or worksheet is to print double-spaced.  
6. In the Report Format group box, select the Vertical or Horizontal format for the printed worksheet.  
7. Click OK to print the worklist or worksheet. 

Batch Result Verify 

Overview 

Batch Result Verify allows you to verify multiple general lab or HLA results at the same time. In Worklist mode, you 
can select a saved worklist and verify all performed results that are associated with accession numbers on that 
worklist.  

 

Selecting a Worklist 

You can select an existing worklist and verify the results associated with the accession numbers on that worklist. To 
select a worklist, perform the following steps: 
1.From the Task menu, choose Select Worklist to open the Select Worklist dialog box. 
2.Select the appropriate worklist from the Name box. A list of existing worklist IDs, including the date and time the 
worklist was created, is displayed based on the worklist name selected. 
3.Select the worklist you want to view. 
4.If you want to view only those orders that have pending procedures, select the Display Only Orders With Pending 
Assays option. 
5.Click OK to display the selected worklist in the Batch Result Verify window and close the Select Worklist dialog 
box. You now can verify performed results on the worklist or view information about the accession numbers, such 
as previous results, patient demographic information, and comments.  

Verifying Results 

Performed results that are eligible to be verified in Batch Result Verify are displayed with a check box available for 
you to select. Some results may not be able to be verified at this time. 

Results that can be verified are displayed with a white cell background and can be selected. Procedures without a 
result also are displayed with a white cell background and can be selected. Results with a status of Verified, 
Corrected, or In Review are displayed with a gray cell background and cannot be selected. If you selected to 
display only pending results on a worklist, then no completed accession numbers are displayed. For interpretation 
and textual results, you can double-click the result cell to view the entire result value. 

To verify results, complete the following steps: 

1. Refresh the worklist by selecting Refresh Worklist from the Task menu. This ensures you have the 
latest results. Results that have been updated since you last refreshed cannot be verified.  

2. Identify the results you want to verify by selecting the check box for the result row. Only rows with the 
check box available can be verified. 
Note:The system does not validate that components of a calculation or interpretation result have not 
changed since you last refreshed or opened the worklist. It only is updated upon refresh if the 
calculation or interpretation result also was performed when the component was updated. Ensure the 
calculation or interpretation has not changed before you verify it.  

3. Select Verify Results from the Task menu. The results are marked as Verified and saved. 

Note 
You can also skip these steps and print by clicking the Print Icon. A worklist is printed 
using its predefined parameters.

Release Considerations 
This functionality is 
available with the 2007.18  Release Update.
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Viewing Comments 

Complete the following steps to view comments and notes for a selected order. 

1. To view, add, or edit the comments, select Comments from the View menu to open the Comments 
dialog box.  

2. To view a comment, click the appropriate tab. The available tabs depend on what types of comments 
have been added.  

3. To add or edit an order comment or note, click Edit and enter the comment in the Comments box or a 
note in the Note box.  

4. When you are finished, click Close to close the dialog box.  

Viewing Comments Using the Comment Viewer 

The Comment Viewer window allows you to view comments, notes, and footnotes associated with the items you 
select on the screen. You do not need to open a separate window each time you select a different patient, 
accession number, order, or result; the Comment Viewer is updated automatically. 

The types of comments you can view depend on your personal View Option settings. Click here for more 
information on customizing the Comment Viewer window. 

To view items in the Comment Viewer window, complete the following steps: 

1. Select an item from the Comments column on the left. Any associated comments, notes, or footnotes 
are displayed in the Viewer box. 

2. To return to the previous item you were viewing comments for, click Back.  
3. Click As Of to refresh the comments displayed. Any new comments, notes, or footnotes that have been 

added since you selected the patient, order, accession number, or result are updated and displayed.  
4. To close the Comment Viewer window, click the X in the top right corner.  

Viewing Patient Demographic Information 

To view additional patient demographic information, such as date of birth and encounter history, complete the 
following steps: 

1. From the View menu, select Patient Demographics. The Patient Demographics dialog box opens.  
2. Review the information displayed.  
3. Click Close to close the Patient Demographics dialog box and return to the previous window.  

Viewing Previous Results 

You can view previous results for the selected procedure. The most recent previous result is displayed in the Batch 
Result Verify window. You also can view more than one previous result for a selected procedure, if necessary. 
Complete the following steps to view multiple previous results: 

1. Select Previous Results from the View menu to open the Previous Results dialog box and display the 
last 15 results, if available, for the selected procedure. The results are sorted by Collection Date/Time 
from newest to oldest. If the current result is verified, it is displayed on the top line and is highlighted 
in yellow. 

2. Click Close to close the Previous Results dialog box.  

Viewing Procedure Information 

To view information about an assay, complete the following steps: 

1. Select the assay (procedure) you want to view information for, and select Procedure Information from 

Note 
If you select to stop the verification process, any accession numbers that were processed 
before you clicked Stop still are verified.

Note 
If there are no comments associated with the selected item, No Comments To Display is 
displayed in the Viewer box.

Note 
If Equivalent Assays have been defined for this procedure, the previous results for the 
equivalent procedures also are displayed in the Previous Results dialog box. The Procedure 
column displays the name of the procedure.
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the View menu. The Procedure Information dialog box is displayed.  
2. The following information is available for the selected procedure: 

a. Procedure  

Short Description is the name associated with the assay that is displayed for the orderable procedure in 
order entry, inquiry, and result entry applications.  
The test site displayed is the one to which the assay was routed.  
If the assay has been converted to another result type, the Default Result Type and Current Result 
Type values will not match. 

1. Numeric  

The reference range values displayed (normal high and low, critical high and low, review high and low, 
linear high and low, and feasible high and low) are those associated with the instrument to which the 
assay was routed. 

1. Delta  

Numeric delta checking calculates the difference between the current result and the most recent 
previous result based on collected date and time. If the difference between the two results is greater 
than the defined value, a delta fail flag is displayed for that result. The delta check type determines 
how the difference between the results is calculated. The Type options are Absolute/Prorated, 
Percent/Prorated, Absolute, and Percent. 

1. Alpha  

If the assay has an alpha result type, the value defined as the normal response is displayed. All other 
possible alpha responses are listed as well.  

 
 

Pending Inquiry 

Overview 

Use Pending Inquiry to view the list of ordered procedures, for a specific test site or sub-section, that have not 
been completed. You have the option to view only the ordered procedures that have been received or all ordered 
procedures for the selected test site. You will be able to select a test site and, optionally, a procedure for which you 
want to view in the pending list. You also have some customization options for Pending Inquiry, such as selecting 
which columns are displayed and rearranging the column order. 

If for some reason a procedure cannot be performed at the test site where it was routed, you can transfer the 
procedure to another appropriate test site. Pending Inquiry will provide a list of orders that are available to be 
transferred. You can select a single order or multiple orders to be transferred. You will also be able to select single 
detail procedures from an order to be transferred. 

You can go directly from Pending Inquiry into Accession Result Entry if you want to enter results for a selected 
accession. From the Result menu, select Accession to open Accession Result Entry. 

Viewing Pending Procedures 

To view the list of pending procedures, perform the following 
steps: 

1. In the Select Pending dialog box (which is open when you first access Pending Inquiry), enter the name 
of the test site or subsection for which you want to view the pending procedures in the Test Site box or 
to view a list of test sites, click the ellipsis button (...)  

2. If you want to view the pending list for a specific procedure, enter the name of the ordered procedure 
in the Procedure box or leave the procedure box blank to display all procedures. If you want to view a 
list of procedures for all test sites, click the ellipsis button (...)  

3. To view the list of pending procedures that have been received into the laboratory, make sure the 
Received Only check box is checked.  

4. Click OK to close the Select Pending dialog box. The list of pending procedures will be displayed.  
5. The pending procedures list is sorted based on the first three columns displayed in the spreadsheet.  
6. Several options are available to customize the display of the spreadsheet in Pending Inquiry. 

To arrange the columns in the spreadsheet display, select Customize Available Procedures 
from the View menu. The first three columns displayed in the spreadsheet will determine 
the sort criteria of the list displayed in the Pending Inquiry window. 

In the Customize Display dialog box, select a column heading and use the Left 
and Right buttons to move the selected column heading to the preferred 
position.  
In the Customize Display dialog box, the red check mark indicates the column 
heading will be displayed. Remove the check mark if a column is not needed in 
the display. Column headings with the term locked next to the check mark are 
required for display.  
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Column widths: When the cursor is in the proper position, it will change to a 
double-sided arrow. Press the primary mouse button and drag the column to 
the preferred size, then release the mouse button.  

7. To return to the original sort, select Default Sort from the View menu.  
8. If you have changed the width of the columns in the Available Procedures spreadsheet, you can return 

all the displayed columns to the predefined width. To reset the column widths, from the View menu, 
select Reset Column Widths. This command resets only the displayed columns, not the columns that 
are not selected in the Customize Display dialog box. 

9. To view comments, select the line, and then select Comments from the View menu. The Comments 
dialog box opens.  

10. To view the container information, select the line, then select Container Details from the View menu. 
The Container Inquiry dialog box opens.  

11. To print the list of pending procedures, select Print from the Task menu.  
12. To select a different test site and, optionally, a procedure, choose Select Procedures from the Task 

menu.  

Accession Result Entry 

Overview 

Use Accession Result Entry to enter results for General Laboratory procedures ordered on a single accession 
number. You can select a specific ordered procedure and a test site to limit the information displayed for the 
selected accession number. The individual discrete assays, included in the ordered procedure, display with columns 
for the result, result flags, result status, and previous results. A check mark next to the result indicates that the 
result is selected when the perform or verify action is applied. 

Accession Result Entry has multiple result entry modes that allow the application to be used in different ways. The 
modes include Accession, Differential, Instrument Queue, Worklist, and Correction. 

While entering results, you can right-click to access a context menu for actions associated with the result, such as 
adding a comment or viewing previous results. You can also view a scattergram image for results received through 
an MDI .  

The Post-It Note icon is displayed to indicate the presence of order comments. Comments are easily accessed from 
the toolbar or a menu option. All comments can be viewed and entered in the same window. 

You can take a particular order from Accession Result Entry directly to Order Result Viewer. From the View menu, 
select Go To Order Result Viewer. 

Entering Results in Accession Mode 

To enter results in Accession mode, you need to enter an accession number and, optionally, the ordered procedure 
name and the test site. The procedures for which results are to be entered then is displayed, along with the 
information about the person for whom the procedure is ordered. Multiple columns are displayed in the result 
portion of the window. 

Complete the following steps to enter results in the accession mode: 

1. In the Accession box, enter the accession number for which you want to enter results.  
2. If you want to limit the display to a single ordered procedure, enter the name of the ordered procedure 

in the Procedure box. To display all ordered procedures for the accession number, leave the Procedure 
box blank.  

3. If you want to limit the display to procedures performed only at the specified test site, enter the name 
of a test site in the Test Site box.  

4. Click Retrieve or press ENTER to display the procedures for which results are to be entered. 
Demographic information is displayed to the right of the accession selection information, and the 
procedures are listed in the bottom portion of the window. 

a. If the results have been received through an instrument interface or have been previously 
performed, they are displayed in the Result column of the spreadsheet. Check marks are 
displayed next to the results.  

b. If the specimen has been repeated, multiple columns of results are displayed.  
c. If you want to change the default result type for a procedure, select Convert Result from 

Note 
You can enter results for a displayed accession by going into Accession Result Entry. Click 
the line of the accession to highlight it. Then, from the Result menu, select Accession. 
Accession Result Entry will open with the selected accession number available so that 
results can be entered. For information about how to use Accession Result Entry, click the 
Help menu in Accession Result Entry.

Release Considerations 
This functionality is available for certain instruments with the 2007.18 Release Update.
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the Task menu or right-click to access context menu, and then select the appropriate result 
type. 

The default result type for a procedure can be changed if necessary. To convert 
a result type to another result type, right-click to access the Result context 
menu, then select Convert Result. You can also access Convert Result from the 
Task menu. The submenu under Convert Result displays the appropriate choices 
for the selected procedure.  

d. For a result type to be converted to an alpha response, the selected procedure must have 
alpha responses defined.  

e. For a result type to be converted to a numeric type, the selected procedure must have a 
numeric format and reference ranges defined.  

5. If the results are to be entered manually, type each result in the Result column and press ENTER to 
move to the Result box for the next procedure. A check mark is automatically entered for each 
procedure whose result you enter. 

6. If you want to remove or add a single check mark, click that check box. To apply check marks from all 
procedures, click the column header. The check mark context menu can be accessed by either right 
clicking on the column header or on any check box.  

7. When all results have been entered, click Perform or Verify.  
8. If you want to add a result-level comment, select the procedure for which you want to add a comment, 

right-click, then select Comments from the result context menu.  

Viewing Instrument Images 

You can view instrument images in Accession Result Entry. They are not displayed in Powerchart or printed on the 
clinical report. When more than one instrument image is associated with an accession number, the Select 
Instrument Image dialog box is displayed. Images associated with one or more orders are displayed in a 
spreadsheet, which includes columns for accession number, order, and performed date and time.  
Complete the following steps to view an instrument image:

1.

a. In the Select instrument image dialog box, select a row and click OK to load the image and 
keep the Select Instrument dialog box open. You also can click Close to close the dialog box 
without viewing an image.  

b. The instrument image is displayed in the viewer appropriate for the format in which the 
image is stored. For example, if the image is a .PDF file, it is displayed using Adobe 
Acrobat. The header of the viewer includes the patient name, accession number, order, and 
image version.  

c. When you have finished viewing the image, close the viewer. For more information on using 
a specific viewer, see the Help that accompanies the viewer.  

d. If the Select Instrument Image dialog box is still displayed, you can select another image 
for view or close the dialog box as needed.  

 

Reviewing Results in Instrument Queue Mode 

The Instrument Queue mode is used to review and verify results received from an interfaced instrument. As the 
results are posted by the interface, the accession number identifying those results is stored in an instrument 
queue. You are able to move from one accession number to the next in the order in which the results were posted 
by the instrument. 

Complete the following steps to view results that have posted to the instrument queue: 

1. In the Test Site box, enter the name of the test site or subsection for which you want to review the 
instrument queued results.  

2. In the Procedure box, enter the name of the ordered procedure to limit the display to a single ordered 
procedure. To display all ordered procedures for the selected test site, leave this box blank.  

3. Click Start to begin the search for accessions in the instrument queue. Accession Result Entry will 
search the instrument queue approximately every three seconds for an available accession. When an 
accession is found, the procedures and results are displayed. Check marks are applied automatically. 
The check mark context menu can be accessed by right-clicking either the column header or any check 
box.  

4. Review the displayed results. A result can be changed and result-level comments can be added from 
the result context menu, which can be accessed by right-clicking on any result.  

5. If you do not want to verify the displayed accession at this time, click the down arrow icon to skip to 
the next accession. The skipped accession will remain in the queue and will be placed at the bottom of 
the queue list.  

Note 
The result flags are applied as the results are entered and displayed in the Flags column. If 
the result is received through an instrument interface, the flags are automatically applied.

Release Considerations 
This functionality is available with the 2007.18 Release Update.
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6. When you have finished reviewing the results, click Perform or Verify. The accession is deleted from the 
queue when the results are verified.  

Viewing Repeat Results 

When a specimen has been repeated on an interfaced instrument, both the original result and the repeat result are 
displayed in Accession Result Entry. For each set of results, the following columns are displayed: 

Check Mark  
Result  
Flags  
Status 
The Previous and Time columns are displayed to the right of the last set of results.  

All results with check marks are performed or verified, depending on which action is selected. Individual results 
may be chosen from different columns by selecting the appropriate check boxes for each result. When repeat 
results are displayed, no results will have check marks. The following options are available for you to perform when 
there are repeated results: 

To select all results in a column, click the column heading of the check mark column.  
If all results are to be performed or verified, click the heading of the check mark column for the results.  

Editing Differential Results 

Results for procedures that are counted, such as the white cell differential, are entered in the Differential mode. 
The window format displayed in the Differential mode is defined by the user. It includes columns for the instrument 
segment, counting segment, and morphology segment. 

Complete the following steps to enter results for counted procedures: 

1. From the Mode menu, select Differential.  
2. In the Accession box, enter the accession number for which you are entering counted results.  
3. In the Procedure box, enter the name of the procedure for which you are entering counted results.  
4. Press the TAB key to move to the Option list and select an option from the list.  
5. Click OK to display the procedures in the Differential window.  
6. Enter the counts by pressing the appropriate key. The appropriate key is listed next to the procedure to 

which it is assigned.  
7. The Total Cells to Count box displays the default number of cells to be counted for the selected 

procedure. To change the default, click Change and enter the number of cells you want to count. Press 
the TAB key to move to the counting position. If necessary, you may stop counting by clicking the Stop 
Light icon.  

8. When you have completed the count or clicked Stop, the system displays a message indicating that the 
counting is complete. Press ENTER to continue.  

9. Enter results for the morphology procedures displayed in the third section of the window.  
10. If you want to add a result-level comment, select the procedure for which you want to add a comment 

and click the Post-It Note icon. You also can right-click in the Result column to display the result 
context menu, which enables you to add comments and view previous results.  

11. If you want to prevent a result from being performed or verified, click the check box to remove the 
check mark. The check mark context menu is available by right-clicking either the column header or 
any check box (except in the counted procedures segment of the window).  

12. When you have finished counting and entering results, click Perform or Verify. All procedures with red 
check marks next to the result will be performed or verified.  

Entering Results in a Worklist Mode 

To enter results in the Worklist mode, you must start by selecting an existing Worklist ID. The first accession in the 
worklist displays automatically. The procedures for which results are to be entered then will be displayed along with 
the information about the person for whom the procedure is ordered. Results can be entered manually, or 
previously performed results can be reviewed and verified. If QC has been included in the worklist, the QC 
accessions will display in the appropriate sequence. 

You can set a preference under the Task Menu to Auto Advance to the next accession number in the worklist upon 
performing of the results. This setting also applies to the Instrument Queue Mode. 

Complete the following steps to enter results in the worklist mode: 

1. Click the ellipsis button next to the Worklist box to display the Select Worklist dialog box.  
2. Select the Worklist ID for which you want to enter results and click OK to return to Accession Result 

Entry.  
3. Select Display only orders with pending assays if you only want to see the orders with pending assays. 

Click OK to return to Accession Result Entry.  
4. The test site and accession for which the worklist is defined displays in the Test Site box and Accession 

list, respectively. If you want to select a specific accession, select that accession from the Accession 
list.  

5. Enter results as in the Accession mode. You also can right-click in the Result column to display the 
result context menu, which enables you to add comments and view previous results.  

6. When you have finished entering or reviewing the results, click Perform or Verify.  
7. When the results for the displayed accession have been verified, the next accession on the worklist is 

displayed automatically. When the last accession on the worklist has been verified, the screen clears so 
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you can select the next worklist to be resulted.  
8. To return to Accession mode, from the Mode menu, select Accession.  
9. The Correction mode also is available from Worklist mode. From the Mode menu, select Correction. See 

Correcting Verified Results for information on the Correction mode. To return to Worklist mode, from 
the menu Mode, select Correction.  

Entering a Result Level Comment 

A result-level comment can be added to any result when the result is first entered or when a result is being 
corrected. Predefined canned comments can be used. Once the comment has been entered, the result must be 
performed, verified, or corrected for the comment to be saved. 
Complete the following steps to add a comment to a result: 

1. Select the result to which the comment is to be added.  
2. Select Comments from the View menu or from the result context menu (accessed by right clicking on 

the result). The Comments dialog box opens.  
3. In the Comments dialog box, select the appropriate tab and click Edit to open the editing window. The 

Result Comment tab is for entering chartable comments. The Result Note tab is for entering non-
chartable comments. The non-chartable result notes are available for viewing within the laboratory 
only.  

4. Enter the comment. If a canned comment is to be used, press CTRL+T, type the name of the canned 
comment, and then press CTRL+T again. You can also type the name of the canned comment, highlight 
the name, and then press CTRL+T.  

5. If the text of the canned comment needs to have information inserted, the underscore character 
displays where the information is to be inserted. Press F3 to move from one underscore to another.  

6. If you want to insert the current system date and time, press F5.  
7. When you are finished adding or editing the comment, click OK to close the editing window.  
8. Click Close to close the Comments dialog box.  
9. Verify that a red check mark is entered next to the result. A comment must have the check mark and 

the result must be performed, verified or corrected (depending on the mode you are in) to be saved.  

Applying Result Flags 

The system automatically applies result flags in the Flags column, based on the numeric reference ranges or alpha 
response report flag defined for each procedure. Numeric reference ranges include normal, critical, review, linear, 
notify, and feasible ranges. Alpha responses can be defined as abnormal, critical or review. The numeric result has 
the appropriate flag appended when the result is less than or greater than a defined range. Other flags displayed in 
the Flags column include the dilution factor, failed delta check, and comment. 

Normal, Critical and Review 

The normal, critical, and review flags are appended to a result when the result is less than the low value defined for 
the range or greater than the high value defined for the range. If a result is flagged as critical, the text displaying 
the result is changed from black to red. 

Linear 

When a result is outside the linear range, the result value entered is stored in the system. The displayed result is 
changed to the linear low or linear high value along with the appropriate less than or greater than symbol. The 
linear flag is also displayed in the Flags column. 

Dilution Factor 

When the linear range is defined in the system, a dilution flag can be set for the high linear range. If the dilution 
flag is set, and the result is greater than the linear high value, the displayed result is not changed and the greater 
than symbol is not appended. You are able to enter a dilution factor for the result, and the system automatically 
calculates the new result. The dilution factor is displayed in the Flags column. 

Feasible 

When a result is outside the feasible range, you are warned that the result exceeds the defined feasible limits for 
the procedure. If you accept the result anyway, the result comment window is opened and you are required to 
enter a comment. 

Failed Delta Check 

When the current result fails the delta check, the delta fail flag is displayed in the Flags column. Delta check criteria 
can be defined based on species, gender, age, service resource, and result range. The types of delta checking that 
can be applied to numeric results include Absolute Prorated, Percent Prorated, Absolute, and Percent. The delta 
value and delta minutes are also defined for numeric results. Alpha responses can be defined to use the Alpha 
Delta check type. 

Release Considerations 
The notify numeric reference range is available with the 2007.18 Release Update. 
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Comment 

A chartable result comment or non-chartable result note can be appended to any result. When either type of result 
comment is added, the comment flag is displayed in the Flags column. 

Viewing Multiple Previous Results 

While entering or reviewing performed results, you can also view previous results. The most recent previous result 
is displayed in the window. If you want to view more than one previous result for a selected procedure, these 
previous results can be viewed in another window. 
Complete the following steps to view multiple previous results: 

1. Select Previous Results from the View menu or from the result context menu (accessed by right-clicking 
the result). The Previous Results dialog box opens and displays the last 15 results, if available, for the 
selected procedure. The results are sorted by Collection Date/Time from newest to oldest. If the current 
result is verified, it is displayed on the top line and is highlighted in yellow. 

2. Click Close to close the Previous Results dialog box.  

Viewing Patient Demographic Information 

You can view additional patient demographic information, including date of birth and encounter history. Complete 
the following steps to view patient demographic information: 

1. From the View menu, select Patient Demographics. The Patient Demographics dialog box opens.  
2. Review the information displayed.  
3. Click Close to close the Patient Demographics dialog.  

Viewing Comments 

The Comment Viewer window allows you to view comments, notes, and footnotes associated with the items you 
select on the screen. You do not need to open a separate window each time you select a different patient, 
accession number, order, or result; the Comment Viewer is updated automatically. 
The types of comments you can view depend on your personal View Option settings. 
To view items in the Comment Viewer window, complete the following steps: 

1. Select an item from the Comments column on the left. Any associated comments, notes, or footnotes 
are displayed in the Viewer box. If there are no comments associated to the selected item, No 
Comments To Display is displayed in the Viewer box.  

2. To return to the previous item you were viewing comments for, click Back.  
3. Click As Of to refresh the comments displayed. Any new comments, notes, or footnotes that have been 

added since you selected the patient, order, accession number, or result are updated and displayed.  
4. To close the Comment Viewer window, click the X in the top right corner.  

 

Viewing Container Details 

You can view information about the containers for the selected accession by opening Container Inquiry. Complete 
the following steps to view container details for the containers associated with the selected accession number: 

1. From the View menu, select Container Details. The Container Inquiry window opens. 

2. To exit Container Inquiry and return to Accession Result Entry, select Exit from the Task menu.  

Correcting Verified Results 

Occasionally, an error is made during the result entry process. Once the result is verified, you must use the 
Correction mode of result entry in order to change the verified result. You may access the Correction mode with an 
accession number displayed in the Accession mode or you may access the Correction mode, then enter the 
accession number. 

Complete the following steps to correct a result: 

1. From the Mode menu, select Correction. The mode is indicated in the title bar, and the Perform and 

Note 
If Equivalent Assays have been defined for this procedure, the previous results for the 
equivalent assays are also displayed in the Previous Results dialog box. The Procedure 
column displays the name of the procedure.

Note 
For more information about how to use Container Inquiry, open Container Inquiry Help 
from Help menu in Container Inquiry.
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Verify buttons are replaced with a Correct button. is displayed in the lower left corner of the window.  
2. In the Accession box, enter the accession number for which you want to correct a result.  
3. You can limit the procedures displayed by entering an ordered procedure or test site, or both. The 

verified results are now unlocked and changes can be made. You also can right-click in the Result 
column to display the result context menu, which enables you to add comments and view previous 
results.  

4. When you are finished making changes, click Correct to save the corrections made. The status of the 
procedure is updated to Corrected.  

5. To return to the Accession mode, select Correction from the Mode menu.  

Documenting an Out-of-Control Situation 

A QC result that is out-of-control (for example, high or low) must be entered and then verified. When the QC result 
is being verified, it is also being evaluated against assigned QC rules in the background. If the QC result is low or 
high or has failed a rule, the QC Correction dialog box opens automatically. 
Complete the following steps to correct and document an out-of-control situation: 

1. Review the information displayed in the (QC Results) spreadsheet.  
2. Review information displayed in the (QC Rules) spreadsheet.  
3. Select the appropriate troubleshooting steps used by clicking the check mark box next to it.  
4. Select the result action option to be taken on this QC result.  
5. Enter additional comments for the QC result in the QC Result Comment box.  
6. When all corrections have been made, click OK to close this dialog box. If another result needs to be 

corrected, the QC Correction dialog reopens.  

Batch Result Entry 

Overview 

The Batch Result Entry application is used to enter results for a specific orderable item for multiple accession 
numbers. You can select the Procedure (orderable item) and Test Site, or select a specific Worklist for which to 
enter results. When entering results, you can select to move vertically or horizontally by selecting the appropriate 
option in the toolbar. 

Batch Result Entry will accept results for numeric, alpha, date and free text result types. To select a specific 
Worklist, the worklist must be defined for only one orderable item. Quality Control results can be entered if the 
appropriate QC accession numbers are included in the selected worklist. 

Selecting a Procedure 

When selecting the procedure to be resulted there are two options from which you can choose in the Select dialog 
box. You can display and result all accession numbers for a specific orderable item and test site, or you can select 
to display and result all accession numbers included on a specific worklist. 

Complete the following steps to select the procedure for entering batch results: 

1. Select either the Procedure tab or the Worklist tab in the Select dialog box.  
2. If you select the Procedure tab, in the Procedure box, enter the name of the orderable item for which 

you want to enter results. If you are unsure of the name of the procedure, enter a partial name and 
click the ellipsis button to display a list from which you can select.  

3. In the Test Site box, enter the name of the test site where the procedure is performed. If you are 
unsure of the name of the test site, enter a partial name and click the ellipsis button to display a list 
from which you can select.  

4. If you select the Worklist tab, in the Test Site box, enter the name of the test site where the procedure 
is performed. If you are unsure of the name of the test site, enter a partial name and click the ellipsis 
button to display a list from which you can select.  

5. In the Worklist box, enter the name of the worklist for which you want to enter results. If you are 
unsure of the name of the worklist, enter a partial name and click the ellipsis button to display a list 
from which you can select.  

6. Click OK to return to Batch Result Entry with the selected information.  

Entering Results 

After selecting the procedure and test site or worklist in the Select dialog box, the procedure information is 
displayed in the Batch Result Entry window. All accession numbers for the selected procedure and test site or 
worklist are displayed in the first column. The second column displays the name of the person for whom the 
procedure was ordered. Each individual discrete assay is a column where the results are to be entered. The flags 
column displays the result flags for each discrete assay. The result flags will be applied as the results are entered. 
If the result is received through an instrument interface, the flags will be applied automatically. For more 
information on result flags, click here.  
To enter results for the displayed accessions, complete the following steps: 

1. If the results are to be entered manually, type each result in the appropriate procedure column and 
press ENTER to move to the result cell for the next procedure. A check mark will be entered 
automatically for each procedure whose result you enter. 
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2. To view previous results, select Previous Results from the Result menu to open the Previous Results 
dialog box.  

3. To remove or add a single check mark, click the box in the (Check Mark) column. To apply check marks 
for all procedures, click the column header. The check mark context menu can be accessed by either 
right-clicking the column header or any check box.  

4. To add a result-level comment, select the procedure for which you want to add a comment, and then 
select Comments from the Result menu to open the Comments dialog box .  

5. When all results have been entered, click Perform or Verify.  

Converting a Result Type 

To change the result type for a procedure, complete the following steps: 

1. Select the result to be converted.  
2. To convert a result type to a different result type, select Convert Freetext, Alpha, or Numeric from the 

Task menu in the Batch Result Entry window to indicate the new result type.  

Result types can be converted to an alpha response only if alpha responses have been defined for the 
selected procedure.  
Result types can be converted to a numeric type only if a numeric format and reference range has been 
defined for the selected procedure.  

Viewing Previous Results 

While entering or reviewing performed results, previous results also can be viewed. To view previous results for a 
selected procedure, complete the following steps: 

1. Select the result for which you would like to view previous results.  
2. Select Previous Results from the Results menu to open the Previous Results dialog box, which displays 

the last 15 results, if available, for the selected procedure. 

3. Click Close to close the Previous Results dialog box.  

QC Correction Overview 

QC Correction is used to document the action taken to correct an out-of-control situation. QC Correction is available 
from Accession Result Entry, Batch Result Entry, Multiple Accession Result Verification, and QC Inquiry. The 
procedure, result, status, and Z score will display along with the in-control range. The QC rules that were applied, 
the error type for each rule, and the status of the rule also display. A list of user defined troubleshooting steps is 
provided to help with the documentation of the out-of-control situation. The result must be accepted, rejected, 
discarded, or changed while in QC Correction. 

When you are correcting a QC result from result entry applications, such as Accession Result Entry, QC Correction 
will open for each out-of-control result. In QC Inquiry, you may select one or more QC results to be corrected. If 
multiple results are selected to be corrected, the first result will be displayed initially. You may scroll through the 
list of results to be corrected by using the arrow keys on the toolbar. 

Documenting an Out-of-Control Situation 

You can correct and document an out-of-control situation in the QC Correction dialog box by completing the 
following steps: 

1. Review the information displayed in the QC Correction dialog box.  
2. Make the appropriate selection from the Troubleshooting Steps list by clicking the box at the start of 

the row. These steps document the action you will take in correcting the out-of-control situation.  
3. Select the appropriate action to be taken on the specified QC result. If the Change option is selected, a 

new result must be entered in the box next to this option. 
Result Actions 
Four actions can be taken on an out-of-control QC result: accept, reject, discard, or change. All QC 
results are maintained within the system even if they are rejected, discarded, or changed. 

a. The Accepted option accepts the QC result displayed at the top of the window. The accepted 
QC result is used when statistics are calculated. The accepted QC result is flagged as high 
or low, but is not considered out-of-control. In QC Inquiry, Accepted is displayed in the 
Action column.  

Note 
You may select whether to move vertically or horizontally through the result cells by 
selecting the appropriate option from the toolbar or the Task menu.

Note 
If Equivalent Assays have been defined for this procedure, the previous results for the 
equivalent assays also will be displayed in the Previous Results dialog box. The Procedure 
column will display the name of the procedure.
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b. The Rejected option rejects the QC result displayed at the top of the window. The rejected 
QC result is used when statistics are calculated. The procedure is considered out-of-control 
until a valid result is verified. In QC Inquiry, Rejected is displayed in the Action column.  

c. The Discard option rejects the QC result displayed at the top of the window. The discarded 
QC result is not used when statistics are calculated. The procedure is considered out-of-
control until a valid result is verified. In QC Inquiry, Discard is displayed in the Action 
column.  

d. The Changed option allows the user to change the QC result displayed at the top of the 
window. The user must enter the new result in the box provided then press the TAB key in 
order for the system to recognize the new result. The original result is stored with an action 
of Prior Result and the new result entered is evaluated against the QC rules for that 
procedure at the performing test site. If the new QC result is in control, the result is verified 
and used in statistics. If the new QC result is out-of-control, then the corrective action also 
must be documented for this result. The new QC result is stored with an action of Changed.  

4. In the QC Result Comment box, enter additional comments for the QC result, if appropriate. If a canned 
comment is to be used, press CTRL+T, type the name of the canned comment, and then press CTRL+T 
again. You also can type the name of the canned comment, highlight the name, and then press 
CTRL+T. To open the Select Template dialog box, press F2.  

5. To correct multiple results, click  or  to scroll through the list.  

6. Click  to view an online graph of QC results for the current procedure.  

7. When all corrections have been made, click OK to close the QC Correction dialog box. 

Multiple Accession Result Verification 

Overview of Multiple Accession Result Verification 

Use Multiple Accession Result Verification to quickly review and verify the results for one or more accession 
numbers. You also are able to perform a variety of other activities, as described below: 

Enter or edit a result by branching to Accession Result Entry.  
View or edit comments associated with an accession.  
Display detailed patient demographic information.  
View previous results for a detail procedure.  
Prevent auto-verification for a specific accession number.  
Turn auto-verification on or off for a selected test site.  
Assign yourself to an instrument.  
View details about a selected container by branching to Container Inquiry.  
View instrument and accession information by branching to Instrument Accession Queue Viewer.  
Define preferences, such as specifying the number of accessions to be displayed.  

Reviewing and Verifying Results 

When you first open Multiple Accession Result Verification, the Select dialog box is displayed. You must select a test 
site or subsection before you can review or verify results. 

Complete the following steps to review or verify results. When you first open Multiple Accession Result Verification, 
the Select dialog box is displayed. You must select a test site or subsection before you can review or verify results. 

1. In the Test Site box, enter the test site or subsection for which you want to review or verify results. If 
you are unsure of the test site name, enter a partial name and click the ellipsis button to display a list 
from which you can select.  

2. Click OK to close the dialog box. The available accession numbers and results for the selected test site 
are displayed in the Multiple Accession Result Verification window.  

3. All results displayed will have a red check mark displayed to the left of the result automatically. The red 
check mark indicates the result is selected to be verified. 

4. Select Verify from the Task menu to verify the results. Deselect any results for the accession that you 
do not want to verify by clicking the displayed check mark before selecting the Verify option.  

5. Select Comments from the View menu to view comments associated with the accession.  
6. Select Patient Demographics from the View menu to view additional patient demographic information.  
7. Select Previous Results from the View menu to display previous results for a procedure.  
8. Select Go To Accession Result Entry from the View menu to transfer the selected accession and results 

to Accession Result Entry. In this application you are able to enter or edit results, as appropriate.  

Note 
When corrected results are verified, the system may prompt you to re-enter your 
password. This occurs if re-authentication logic is turned on at your site for security 
purposes.

Note 
If check marks are not displayed, a global preference preventing this auto-selection has 
been set in the GLBPrefTool application.
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9. Select Retrieve Results from the Task menu to display the next group of accession numbers with 
results.  

10. Choose Select from the Task menu to select a new test site.  

Entering or Editing Results 

Complete the following steps to enter results or edit displayed results: 

1. In the Multiple Accession Result Verification window, select the accession for which you want to enter or 
modify results.  

2. Select Go To Accession Result Entry from the View menu to branch to that application. For information 
about using Accession Result Entry, refer to the Help file in that application.  

Viewing Comments 

Complete the following steps to view or edit comments associated with the selected accession: 

1. In the Multiple Accession Result Verification window, select the accession for which you want to view or 
edit comments.  

2. Select Comments from the View menu to open the Comments dialog box, which displays existing 
comments and notes associated with the selected accession.  

3. To edit the comments, click Edit to open the Edit Comment dialog box.  
4. Click Close to return to the Multiple Accession Result Verification window when you are done viewing or 

editing comments.  

Viewing Container Details 

Complete the following steps to view container details: 

1. In the Multiple Accession Result Verification window , select the accession for which you want to view 
container details.  

2. Select Container Details from the View menu to branch to Container Inquiry. For information about 
using Container Inquiry, refer to the Help file in that application.  

Displaying Patient Demographics 

 
Complete the following steps to display detailed patient demographic information: 

1. In the Multiple Accession Result Verification window, select the accession for which you want to view 
patient demographic information.  

2. Select Patient Demographics from the View menu to open the Patient Demographics dialog box.  
3. Click Close to return to the Multiple Accession Result Verification window when you are done viewing 

the demographic information.  

Viewing Previous Results 

Complete the following steps to view previous results for a detailed procedure: 

1. In the Multiple Accession Result Verification window, select the procedure for which you want to view 
previous results.  

2. Select Previous Results from the View menu to open the Previous Results dialog box.  
3. Click Close to return to the Multiple Accession Result Verification window when you are done viewing 

previous results.  

 

Viewing Instrument Accession Information 

Complete the following steps to view instrument accession details: 

In the Multiple Accession Result Verification window, select Go To Instrument Accession Queue Viewer 
from the View menu to branch to that application. For information about using Instrument Accession 
Queue Viewer, refer to the Help file in that application.  

Instrument Activity Monitor 

Overview of Instrument Activity Monitor 

Use Instrument Activity Monitor to view all activity for any General Lab test site (such as an instrument or bench) 
during a defined time range. The application is used to validate that assays have been auto-verified and 
troubleshoot why assays did not auto-verify. The monitor is very helpful in testing for auto-verification because a 
list of assays can be displayed with their status and auto-verification codes. The auto-verification codes may be a 
success or failure code, depending on the auto-verification parameter. An assay may have multiple auto-
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verification codes assigned. 

Instrument Activity Monitor provides a list of quality control (QC) activity so the user can see the relationship of QC 
to patient results. If a result was failed during auto-verification, the result still will be displayed and the system will 
indicate that an error was present. 

Selecting a Test Site or Accession Number 

To monitor activity for a specified test site: 

1. The Select dialog box opens automatically when the application is started so you can select a test site 
or accession number. If you are in the Instrument Activity Monitor window and need to select a 
different test site, choose Select Instrument from the Task menu.  

2. Select the Test Site option to display activity for a specified test site.  
3. In the Test Site box, enter the test site for which activity is to be monitored. If you are unsure of the 

name of the test site, enter a partial name and click the ellipsis button to display a list from which you 
can select.  

4. In the Begin Date and Time boxes, enter the beginning date and time. All results from the specified 
begin date and time to the specified End Date/Time will be displayed.  

5. In the End Date and Time boxes, enter the ending date and time. 

6. Select the Order or Assay option to indicate whether information should be displayed at the order or 
assay level.  

7. Select the Instrument Results Only option if only results from interfaced instruments are to be included.  
8. Click OK to close the Select dialog box and display the qualifying accession numbers in the Instrument 

Activity Monitor window or click Cancel to close the dialog box without returning information.  

To monitor activity for a specified accession: 

 
1. The Select dialog box opens automatically when the application is started so you can select a test site 

or accession number. If you are in the Instrument Activity Monitor window and need to select a 
different accession number, choose Select Instrument from the Task menu.  

2. Select the Accession option to display activity for a specified accession number.  
3. In the Accession box, enter the accession number for which you want to monitor activity.  
4. In the Test Site box, enter the test site for which activity is to be monitored. If you are unsure of the 

name of the test site, enter a partial name and click the ellipsis button to display a list from which you 
can select. You also can select All to display activity from all test sites associated with the accession.  

5. The Begin Date and Time boxes and the End Date and Time boxes are inactive since the information is 
being retrieved based on the accession. 

6. Select the Order or Assay option to indicate whether information should be displayed at the order or 
assay level.  

7. Select the Instrument Results Only option if only results from interfaced instruments are to be included.  
8. Click OK to close the Select dialog box and display the qualifying accession numbers in the Instrument 

Activity Monitor window or click Cancel to close the dialog box without returning information.  

Reviewing Results 

Complete the following steps to review results in the Instrument Activity Monitor window: 

1. Orderables or assays, and the details associated with them, are displayed in the Instrument Activity 
Monitor window only after you have selected the proper test site or accession and date/time range in 
the Select dialog box.  

2. The spreadsheet of displayed information varies depending on your preferences. From the View menu, 
select Order Level to display order information in the primary spreadsheet or select Assay Level to 
display assay information in the primary spreadsheet.  

3. Results are displayed in the (Assay) spreadsheet. 

Note 
If an assay has any result event within this specified date range, all result events will be 
displayed. For example, if a result is corrected within the entered date range, the 
corrected result will be included in the display with all associated result events, even if the 
associated results occurred prior to the specified date range.

Note 
If an assay has any result event within this specified date range, all result events will be 
displayed. For example, if a result is corrected within the entered date range, the 
corrected result will be included in the display with all associated result events, even if the 
associated results occurred prior to the specified date range.

Note 
A blue circle next to a row in the spreadsheet indicates the item falls within the specified 
date range. This icon changes to a blue arrow for result events that are outside the date 
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4. To view accession numbers and results for another test site, choose Select Instrument from the Task 
menu. This opens the Select dialog box so you can select another test site. For more information on 
selecting a test site, click here.  

QC Inquiry 

Overview 

Use QC Inquiry to review QC results for a specific test site or control name. The QC results for all procedures or a 
single procedure at the specified test site or all test sites will be able to be viewed. You will also be able to select a 
date range. When the QC results are displayed, a specific result can be selected and corrective action can be 
documented for that result. 

Statistics can be calculated and viewed for multiple date ranges for each procedure. You will be able to define a 
date range for which QC statistics are to be calculated. The date range/statistics can be saved for later viewing. 

QC results can be viewed in an online graphical format. Numeric results are displayed in a point-by-point line 
graph; alpha results are displayed in a bar graph. A point on the numeric graph can be selected to display the 
result information for that point. 

Several QC reports can be printed from QC Inquiry. The reports can be printed for a single procedure or all 
procedures within a specified date range. 

Selecting QC Results 

QC results can be viewed for a selected test site, control name, and all procedures or a single procedure. QC results 
can also be selected for a specific control, all test sites, and date range. 

Complete the following steps to select QC results: 

1. Select the option with which you want to view the QC results. 

a. Select the Test Site option to view a specific test site, control within that test site, and all 
procedures or a single procedure.  

b. Select the Control option to view a specific control, all test sites or a single test site within 
that control, and all procedures or a single procedure.  

c. Select the Patient Data option to view Patient Data Maintain results.  

2. In the Results Between and And spin boxes, enter the date range or click the DOWN-ARROW next to 
each spin box to view a calendar from which to select a date.  

3. Under Result Status, select the options to filter the QC results to be viewed. If more than one result 
status option is selected, the QC results with all the selected statuses are displayed in the (QC Inquiry) 
spreadsheet.  

4. Click OK to view the QC results for the selected information.  

 

Viewing QC Results 

Once the results are displayed, you may select one or more of the results to assign the date, time, and name of the 
current user in order to document when and by whom the QC results were reviewed. You also can view a comment 
attached to QC result, correct a QC result, or discard a QC result. 

The following options are available for you to view in QC Inquiry: 

To view a comment attached to a QC result, select the row, and from the View menu, select Comments 
or double-click Yes in the Comment column.  
To correct a QC result, select the row, and from the Task menu, select Correct QC Results.  
To correct and document an out-of-control situation, perform the following steps:  

1. Review the (QC Results) spreadsheet displayed at the top of the window.  
2. Review the (QC Rules) spreadsheet displayed below the (QC Results) spreadsheet. For more 

information about QC Rules, click here.  
3. Select the appropriate troubleshooting steps by clicking the check mark box  
4. Select a result action option to indicate the action to be taken on this QC result. If the Change option is 

selected, a new QC result must be entered.  
5. Enter additional comments for the QC result in the QC Result Comment box.  
6. If multiple results have been selected from QC Inquiry to be corrected, use the Arrow toolbar buttons to 

scroll through the list.  
7. Click the Levey Jennings Chart icon to view an online graph of QC results for the current procedure.  
8. When all corrections have been made, click the OK button to close the QC Correction task. 

a. To mark a QC result as reviewed, select the row, and from the Task menu, select Mark as 
Reviewed.  

range, but are associated with the selected assay.
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b. To mark a QC result as secondary reviewed, select the row, and from the Task menu, select 
Mark as Secondary Reviewed.  

c. To discard a QC result, select the row, and from the Task menu, select Discard QC Results.  
d. To view QC rules that were applied to a selected QC result and its status, from the View 

menu, select Rule Status.  

Viewing QC Statistics 

The QC Statistics window includes two tabs, one for calculating statistics and one for viewing the saved, previously 
calculated statistics. Statistics can be calculated for any date range that you select. You can then save that date 
range for those statistics to be viewed later. 

To view or calculate QC statistics, select QC Statistics from the View menu. 

Complete the following steps to calculate QC statistics: 

1. Click the Calculate a New Statistical Period tab. The selected test site and control are displayed.  
2. Make a selection from the Procedure list by clicking the DOWN-ARROW.  
3. In the From and To spin boxes, enter the date range or click the DOWN-ARROW next to each spin box 

to view a calendar from which to select a date.  
4. Click Calculate to calculate and display the statistics at the bottom of the window.  
5. If you want to remove a row from the (Statistics) spreadsheet in this tab, select the row, and then click 

Remove Row.  
6. Click Save to save the calculated statistics for the selected date range. 

Complete the following steps to view QC statistics: 

1. Click the View Existing Statistical Periods tab. The selected test site and control are displayed.  
2. Make a selection from the Procedure list by clicking the DOWN-ARROW.  
3. In the From and To spin boxes, enter the date range or click the DOWN-ARROW next to each spin box 

to view a calendar from which to select a date.  
4. Click the View Stats button to view the selected statistics. The list at the bottom of the window displays 

the QC statistics. If statistics have been calculated and saved for multiple date ranges within the date 
range you specified, all of the date ranges and statistics that qualify are displayed.  

Viewing the QC Graph 

QC results can be viewed online in a graphical format. A point can be selected on the graph and the detail 
information about that result will be displayed. Different types of graphs can be displayed. Currently the options 
are Levey-Jennings Chart, Online Graphs, and Youden Plot . If you choose Online Graphs, you have display options 
of Horizontal, Horizontal scatter plot, Vertical, Standard cusum chart , and Decision limit cusum chart. 

Complete the following steps to view the QC online Levey-Jennings graph: 

1. From the View menu, select Online Levey-Jennings Chart. The Levey-Jennings Chart Parameters 
window is displayed. The name of the selected control is displayed at the top of the window.  

2. Make a selection from the Test Site list by clicking the DOWN-ARROW.  
3. Make a selection from the Procedure list by clicking the DOWN-ARROW.  
4. In the Begin Date and End Date spin boxes, enter the date range or click the DOWN-ARROW next to 

each spin box to view a calendar from which to select a date.  
5. Click OK to view the graph. Numeric QC results are displayed in a line graph and alpha QC results are 

displayed in a bar graph. 

Complete the following steps to view the QC online Youden Plot graph:  
6. From the View menu, select Youden Plot.  
7. From the Procedure list, select the assay you want to graph.  
8. From the Test Site box, select one or more test sites that you want to measure using the graph.  
9. In the X and Y Parameters box, select to measure either two controls against each other (Two Controls 

Option) or two different time periods for the same control (Two Date Ranges option).  
10. Enter values in the Results Per Test Site boxes to set the minimum and maximum number of data 

points you want to view on the graph.  

Note 
You can calculate statistics for multiple date ranges by selecting a new date range after 
the previously calculated date range has been saved.

Release Considerations 
The Youden Plot, Standard cusum chart, and Decision limit cusum chart became available with the 
2007.18 Release Update. 

Note 
To view more information about a specific numeric result, click the point on the graph. The 
detailed information is displayed at the bottom with a tab for Lot information and a tab for 
Result information.
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11. If you selected to measure two controls, select the controls you want from the Control 1 and Control 2 
lists. You cannot select the same control in both lists. If you selected more than one test site in Step 3, 
only those controls that are common to all test sites are available for you to select. 

If you selected to measure two time periods for the same control, select the control you 
want from the control list. In the Range 1 boxes, enter the dates and times you want to 
include for the first time period. In the Range 2 boxes, enter the dates and time you want 
to include for the second time period. The date and time ranges cannot overlap. (Note: If 
more than one lot was used during a date range, the Select Lot Number dialog box is 
displayed.)  

12. Select the Use Analytical Series option if you want a single result to be selected from a series of QC 
results during a specified time period. If you do not select this option, all valid results qualify.  

13. If you selected the Use Analytical Series option, in the Interval Hours box, enter the number of hours 
for the analytical series. You must enter a whole number that is a factor of 24.  

14. If you selected the use Analtyical Series option, select one of the Result Sequence in Series options. 
Selecting First Indicates that the first result within the specified time period is included on the report. 
Selecting Last indicates that the last result within the specified time period is included on the report. If 
you select Other, you can enter the number of the specific result in the series that you want to include 
on the report. For example, if you enter 5, the fifth result during that time period is included on the 
report. You can enter a whole number between 1 and 99.  

15. Click OK. The graph or graphs are displayed according to the parameters you selected.  

 

Printing the QC Results Listing 

The QC Results Listing report prints a QC report based on the selected criteria. 

Complete the following steps to print QC Results Listing report: 

1. From the Report menu, select QC Results Listing. The Print QC Results Listing dialog box is displayed. 
The name of the selected control is displayed at the top.  

2. Make a selection from the Test Site list by clicking the DOWN-ARROW to select a test site.  
3. Make a selection from the Procedure list by clicking the DOWN-ARROW for a list of procedures to select 

a procedure within the selected test site and control.  
4. In the Printer box, enter the printer ID.  
5. In the Begin Date and End Date spin boxes, enter the date range or click the DOWN-ARROW next to 

each spin box to view a calendar from which to select a date.  
6. Select the result status options to filter the QC results to be printed. If more than one result status 

option is selected, the QC results with all the selected statuses will be printed in the report.  
7. If you want to print only the out-of-control results, select the Outliers Only option.  
8. Click OK to print the QC report based on the selected criteria.  

Printing the (Vertical) Levey-Jennings Chart 

The Levey-Jennings Chart can be printed as a vertical graph. This graph is a point by point, vertical graph of the 
QC results within the selected date range. Statistics and comments are printed at the bottom of the graph. 

Complete the following steps to print the (Vertical) Levey-Jennings Chart: 

1. From the Report menu, select Levey-Jennings Chart Vertical LJC. The Print Levey-Jennings Chart dialog 
box is displayed. The name of the selected control is displayed at the top.  

2. Make a selection from the Test Site list by clicking the DOWN-ARROW.  
3. Make a selection from the Procedure list by clicking the DOWN-ARROW.  
4. In the Printer box, enter printer ID.  
5. In the Begin Date and the End Date spin boxes, enter the date range or click the DOWN-ARROW next 

to each spin box to view a calendar from which to select a date  
6. If you want to include all cross controls associated with the selected control, select the Include Cross-

Controls option.  
7. If you want to include the expected statistics, select the Show Expected Statistics option.  
8. If you want to include the manufacturer suggested statistics, select the Show Manufacturer Statistics 

option.  
9. Click OK to print the report based on the selected criteria.  

Printing the Monthly Levey-Jennings Chart 

The Levey-Jennings Chart can be printed as a monthly graph. The monthly Levey-Jennings Chart provides a 
monthly summary, up to 31 days, of QC results in a graphical format. The statistics are printed at the bottom of 
the graph. This report also can be set up to print from system operations each month. 

Complete the following steps to print the Monthly Levey-Jennings Chart: 

1. From the Report menu, select Levey-Jennings Chart Monthly LJC. The Print Monthly Levey-Jennings 
Chart dialog box is displayed. The name of the selected control is displayed at the top.  

2. Make a selection from the Test Site list by clicking the DOWN-ARROW.  
3. Make a selection from the Procedure list by clicking the DOWN-ARROW.  
4. In the Printer box, enter printer ID.  
5. In the Begin Date spin box, enter a date or click the DOWN-ARROW next to the spin box to view a 

calendar from which to select a date. The report will print QC information for the 31 days before the 
date selected (for example, looks back from the selected date for 31 days).  
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6. Click OK to print the report based on the selected criteria.  

Printing the QC Statistics Report 

The QC Statistics Report prints statistics that have been calculated for the selected control, test site, and 
procedures within the specified date range. You can elect to include only statistics calculated for specified date 
ranges during operations or user-defined ad hoc statistical date ranges. 

Complete the following steps to print the QC statistics report: 

1. From the Report menu, select the QC Statistics Statistics Report. The Print QC Statistics Report dialog 
box is displayed. The name of the selected control is displayed at the top of the window.  

2. Make a selection from the Test Site list by clicking the DOWN-ARROW.  
3. Make a selection from the Procedure list by clicking the DOWN-ARROW.  
4. In the Printer box, enter the printer ID.  
5. In the Begin Date and End Date spin boxes, enter the date range or click the DOWN-ARROW next to 

each spin box to view a calendar from which to select a date.  
6. If you want to print only QC statistics calculated in Operations, select the Operations Only option.  
7. Click OK to print the report based on the selected criteria.  

Printing the Cross Test Site Report 

QC statistics can be printed as a cross test site report. The QC Statistics Cross Test Site report includes statistics 
that have been calculated for the selected control and procedures within the specified date range. The statistics are 
calculated separately for each instrument but the report includes all of these statistics on one report. You can elect 
to include only statistics calculated for a specified date range during Operations or user-defined ad hoc statistical 
date ranges. 

Complete the following steps to print the Cross Test Site report: 

1. From the Report menu, select QC Statistics Cross Test Site Report. The Print Cross Test Site Report 
window is displayed. The name of the selected control is displayed at the top of the window and the 
test site is defaulted to (All Test Sites).  

2. Make a selection from the Procedure list by clicking the DOWN-ARROW.  
3. In the Printer box, enter the printer ID.  
4. In the Begin Date and End Date spin boxes, enter the date range or click the DOWN-ARROW next to 

each spin box to view a calendar from which to select a date.  
5. If you want to print only QC statistics calculated in Operations, select the Operations Only option.  
6. Click OK to print the report based on the selected criteria.  

Documenting an Out-of-Control Situation 

To correct and document an out-of-control situation, perform the following steps: 

1. Review the (QC Results) spreadsheet displayed at the top of the window.  
2. Review the (QC Rules) spreadsheet displayed below the (QC Results) spreadsheet. 

3. Select the appropriate troubleshooting steps by clicking the check mark box  
4. Select a result action option to indicate the action to be taken on this QC result. If the Change option is 

selected, a new QC result must be entered.  
5. Enter additional comments for the QC result in the QC Result Comment box.  
6. If multiple results have been selected from QC Inquiry to be corrected, use the Arrow toolbar buttons to 

scroll through the list.  
7. Click the Levey Jennings Icon to view an online graph of QC results for the current procedure.  
8. When all corrections have been made, click the OK button to close the QC Correction task.  

Customizing the Display 

Note 
A QC Rule is assigned to a procedure based on the test site where the procedure is 
performed. If necessary, different rules can be evaluated for the same procedure at 
different test sites. A QC Rule is really one or more individual rules that are to be 
evaluated for a QC result. Typically, more than one rule is necessary to provide proper 
error detection. In the QC Reference Build task, each QC Rule is defined with the 
appropriate individual components. Each QC rule component is defined as checking for 
Random or Systematic error. Then, when the control is defined in the QC Maintain task, 
each procedure is assigned the appropriate QC Rule. 
To perform cross accession checking, the QC Rule must be defined correctly. When 
individual components of a QC Rule are defined, you can set the rule to evaluate within 
accession or across accession and within run or across run. When a QC rule component is 
defined to evaluate across accession, the evaluation will automatically cross check the 
current QC results against the other QC accession numbers for this procedure at the 
specified test site. 
An individual QC rule component can be designated as the trigger rule in QC Reference 
Build. When a QC Rule has a specified trigger rule, the trigger rule must fail before any 
other rule components are evaluated.
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You can customize the display of the (QC Inquiry) spreadsheet. All of the possible column headings for which 
information can be displayed are shown in a spreadsheet in the Customize Results List: Customize Display dialog 
box. You can specify which columns are to be visible and rearrange the order in which the columns are displayed. 

In the Visible row, you can specify the columns that are to be included in the display by clicking the 
option under each heading. Column headings that already are specified as visible and have the term 
Locked next to the check box are required for display, thus their visible status cannot be changed.  
If the <<Left and Right>> buttons are displayed, you can move a selected heading to a different 
position by selecting the column heading in the Heading row, then clicking <<Left or Right>>. Each 
time you click <<Left or Right>>, the heading moves one position to the left or right.  

QC Maintain 

Overview of QC Maintain 

Use QC Maintain to identify each control in the system. As the controls are identified, the lot information also is 
specified. For each control, you will select the test sites at which that control will be performed and the procedures 
on which the control will be performed. 

As the procedures are selected, each one is assigned a quality control (QC) rule, a mean, and a standard deviation. 
When a new lot number is received, the new lot information is entered using DB QC Maintain. At that time, the 
procedures on which the control will be performed can be adjusted. 

The information related to each control can be defined and modified using DB QC Maintain. You can modify 
information for an existing lot. You also can change the control name after the control is defined. 

DB QC Maintain has three tabs: 

Define Lot  
Define Test Site  
Define Procedures  

When you are defining procedures, you can save time by copying procedures defined for a previous lot to the 
current lot (when those procedures are the same). 

DB QC Maintain also enables you to print bar-code labels for controls at a particular test site. Another feature is the 
ability to define a numeric map format. The numeric map controls how results are entered in Accession Result 
Entry and how statistics are displayed in QC Inquiry. 

Adding and Defining a New Control 

To add a new control for which you want to define lot information, complete the following steps when the Define 
Lot tab is active: 

1. Select New Control from the Task menu to open the New Control Name dialog box.  
2. In the Control Name box, enter a name for the new control. This control name will be displayed in QC 

Inquiry, on reports, and during result entry.  
3. In the Long Description box, enter a long name (up to 20 characters) for the control.  
4. In the Manufacturer list, select the manufacturer of the control.  
5. In the Control Type list, select the type of control being defined or modified.  
6. Click OK to save the information and close this dialog box. The information you defined is displayed in 

the top portion of the Define Lot tab. 

Specifying Cross Controls 

This is an optional step. If you define cross controls, the current results are checked against the results of the 
specified cross controls as well as the result of the primary control when rule evaluations are being performed. To 
specify cross controls, complete the following steps: 

1. Select Define Cross Controls from the Action menu when the Define Lot tab is active to open the Define 
Cross Controls dialog box .  

2. The Available Controls box displays the controls that are available to be selected as cross controls. 
Move the controls you want to define as cross controls into the Selected Controls box. (Controls in the 
Available Controls box can be deselected by moving them back to the Available Controls box.)  

Note 
If the control information already is identified in the system and a new lot is received, only the lot 
information will need to be added. See Maintaining Lot Information for more information.

Note 
If you do not want to use cross controls with the control being defined, you can skip the 
task of specifying cross controls.
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Defining the Lot Number Information 

To record the lot number information for a new control, complete the following steps in the Define Lot tab: 

1. In the Lot box (under New Lot Information), enter the new lot number of the selected control.  
2. In the Received Date/Time boxes, specify the received date and time of the new lot being defined.  
3. In the Expiration Date/Time boxes, specify the expiration date and time of the new lot being defined.  
4. Select Save from the Task menu to save the information entered. This information then is moved to the 

Current Lot Information section of the window.  

To add test sites to the new control, click the Define Test Site tab. For more information on adding a test site and 
defining test site information, see Steps in Defining a Test Site. 

Changing the Control Name 

Complete the following steps to change the control name: 

1. Select Modify Control Name from the Action menu to open the Change Control Name dialog box .  
2. In the Control Name box, enter a new name for the control.  
3. In the Long Description box, change the long name or enter a new long name (up to 20 characters) for 

the control.  
4. Click OK to save your changes.  

Adding a New Lot to an Existing Control 

To add a new lot to an existing control, complete the following steps: 

1. Select Open Control from the Task menu to open the Select Control Name dialog box .  
2. Select the control for which you want to add the new lot.  
3. Click OK to close the dialog box and return to the Define Lot tab with the selected control. The lot 

information for the current lot is displayed in the Current Lot Information section of the window.  
4. In the New Lot Information section of the window, enter the new lot information described below. 

a. In the Lot box, enter the lot number.  
b. In the Received Date/Time boxes, specify the received date and time.  
c. In the Expiration Date/Time boxes, specify the expiration date and time.  

5. From the Task menu, select Save to save the lot information entered. 

6. To add test sites to the new lot, click the Define Tests Site tab. For more information, see Adding a Test 
Site and Defining Test Site Information .  

Modifying the Information for the Current Lot 

To modify the information for the current lot, complete the following steps: 

1. Select Modify Current Lot from the Action menu when the Define Lot tab is active to open the Modify 
Current Lot dialog box .  

2. Modify the appropriate information.  
3. Click OK to save the information and close the dialog box. The changes will be reflected in the 

information displayed under Current Lot Information in the Define Lot tab.  

Adding a New Lot to an Existing Control 

To add a new lot to an existing control, complete the following steps: 

1. Select Open Control from the Task menu to open the Select Control Name dialog box .  
2. Select the control for which you want to add the new lot.  
3. Click OK to close the dialog box and return to the Define Lot tab with the selected control. The lot 

information for the current lot is displayed in the Current Lot Information section of the window.  
4. In the New Lot Information section of the window, enter the new lot information described below. 

a. In the Lot box, enter the lot number.  
b. In the Received Date/Time boxes, specify the received date and time.  
c. In the Expiration Date/Time boxes, specify the expiration date and time.  

5. From the Task menu, select Save to save the lot information entered. 

Note 
If the current lot is still active and the new lot is preactive, the new lot information will 
remain in the New Lot Information section of the window.
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6. To add test sites to the new lot, click the Define Tests Site tab. For more information, see Adding a Test 
Site and Defining Test Site Information.  

Viewing Lot History 

You can view the history of a lot by completing the following steps: 

1. Select Lot History from the View menu in the QC Maintain window to open the Lot History dialog box.  
2. In the Control box, select the lot whose history is to be viewed.  
3. In the Test Site box, select the test site associated with the lot history to be viewed. You can accept the 

default of All to view lot history for all test sites.  
4. In the Begin and End Date and Time boxes, enter the time range for which you want to view the lot 

history.  
5. Click OK to open the QC Lot History window and display the lot based on the specified parameters.  
6. Click Close to exit the QC Lot History window and return to the Lot History dialog box.  

Steps in Defining a Test Site 

Test sites are added and defined using the Define Test Site tab. This tab also is used to define when the lots at 
each test site are active. The tasks involved in defining a test site are listed below. 

1. Identify the test site, specifying a quality control identifier for the control and test site combination.  
2. Specify the active and inactive dates for the lot or lots at this test site.  

After you add a test site and define the information for it, continue to the next tab so you can identify the 
procedures for which the control will be performed at this test site. 

Adding a Test Site and Defining Test Site Information 

To identify a test site and define the test site information, complete the following steps in the Define Test Site tab: 

1. Select Add Test Site from the Action menu to open the New Test Site dialog box.  
2. In the Test Site box, enter the name of the test site where the control is to be performed. If you are 

unsure of the name of the test site, enter a partial name, then click the ellipsis button to open the Test 
Site Lookup dialog box and display a list from which you can select.  

3. Tab to the Active QC Identifier box.  
4. In the Active QC Identifier box, enter an accession number that will be used to identify the control for 

the selected test site when the control is active. A prefix of QC is required. This identifier will be used in 
Accession Result Entry to display the selected procedures for the active lot of the control.  

5. If the control is for instruments, in the Active Cross Reference box enter a cross-reference for the 
accession number that will be used to identify the control for the selected test site when the control is 
active. If a control is for a manual bench area, this box can be left blank. 

6. Tab to the Preactive QC Identifier box.  
7. Enter an accession number that will be used to identify the control for the selected test site when the 

control is preactive. A prefix of QP is required.  
8. If the control is for instruments, in the Preactive Cross Reference box enter a cross-reference for the 

accession number that will be used to identify the control for the selected test site when the control is a 
preactive control. If a control is for a manual bench area, this box can be left blank.  

9. Click OK to save the information and close the New Test Site dialog box. The information you just 
defined is displayed in the top portion of the Define Test Site tab. 

Note 
If the current lot is still active and the new lot is preactive , the new lot information will 
remain in the New Lot Information section of the window.

Note 
The Define Test Site tab also enables you to print bar-code labels for the controls at a specified test 
site. For more information, see Printing Bar-Code Labels.

Note 
It is important that, before you assign the QC and cross-reference identifiers, you develop 
a logical plan for assigning these numbers. 

The format of accession numbers at your site is defined using the Accession 
Setup application.  
The required length is determined by the interfaced instrument.  
The cross-reference accession number is the number that is printed on bar 
code labels.  

You must press TAB after entering the accession numbers for the system to recognize that 

Page 60 of 75Use PathNet General Laboratory - Reference Pages - uCern Wiki

4/28/2010https://wiki.ucern.com/pages/viewpage.action?pageId=705638

SUNY DMC CLINICAL LABORATORIES Page 57 of 72



Modifying Test Site Information 

To modify test site information that has been defined previously, complete the following steps: 

1. Identify the test site by selecting it from the Test Site list in the Define Test Site tab. The information 
that has been defined for that test site for the specified control is displayed.  

2. Make the necessary changes. For information on completing the boxes, see Adding a Test Site and 
Defining Test Site Information 

3. From the Task menu, select Save.  

Defining the Active and Inactive Dates 

The current lot number is displayed in the bottom portion of the Define Test Site tab. If a new lot is defined, its lot 
number also is displayed. After you identify a test site, you can specify the period of time when a lot is active by 
completing the following steps: 

1. In the Active Date box under Current Lot, specify the active date and active time for the current lot at 
this test site, if they are different from the date and time the current lot was received. The received 
date and time are displayed as the defaults. In the Inactive Date and Time boxes, specify the inactive 
date and inactive time for the current lot at this test site, if they are different from the date and time 
the current lot will expire. The expiration date and time are displayed as the defaults.  

2. If a new lot is defined, you can specify an active date and time, and an inactive date and time, for that 
lot as well. In the Active Date and Time boxes under New Lot, select the active date and active time for 
the new lot at this test site, if they are different from the date and time the new lot was received. The 
received date and time are displayed as the defaults. In the Inactive Date and Time boxes under New 
Lot, specify the inactive date and inactive time for the new lot at this test site, if they are different from 
the date and time the new lot will expire. The expiration date and time are displayed as the defaults.  

3. From the Task menu, select Save to save your changes.  

Steps in Defining Procedures 

The Define Procedures tab is used to identify the procedures for which the control will be performed at the selected 
test site. The control, lot number, and test site information are displayed at the top of this tab. The available 
procedures for the specified test site are displayed in the lists on the left side of the tab. You can select numeric 
procedures, alpha procedures, or both. 

Select the numeric procedures to be included for this control, and specify the quality control rule and 
statistics to be used with each one. See below  
Select the alpha result-type procedures to be included for this control, and specify the status of each 
alpha response. See below 

Identifying Numeric Procedures 

To identify numeric procedures at the selected test site to be included for this control, and specify the appropriate 
information for them, complete the following steps: 

1. Select the Define Procedures tab.  
2. Transfer the procedures to be included from the Available Numeric Procedures box to the Selected 

Numeric Procedures spreadsheet. 

values have been entered in those boxes.

Before you can modify the Active QC Identifier and Preactive QC Identifier boxes, you 
must select Modify Accession QC or Modify Accession QP from the Action menu.

If the procedures for the lot being defined are the same as the procedures defined for a 
previous lot for this control, you can copy them from the previous lot by selecting Import 
Procedures from the Action menu. You can, optionally, change the information for numeric 
procedures, or the response status for alpha procedures, after you copy the procedures.

Before you can select numeric procedures, you must have selected the test site for which you want to 
identify procedures in the Define Test Site tab . If two lot numbers are defined for the specified 
control, you also must have indicated the one for which you want to identify procedures by selecting 
either the Current Lot option or the New Lot option in the Define Test Site tab.

If the procedures for the lot being defined are the same as the procedures defined for a 
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3. For each numeric procedure selected, complete the columns in the Selected Numeric Procedures 
spreadsheet. 

In the Rule column, indicate the quality control rule that is to be used to evaluate QC results for the 
procedure by clicking in the cell, then selecting the appropriate option from the displayed list. 

In the Mean column, enter the expected mean for the procedure. If you attempt to modify the mean, 
the system will search for QC results that have not been verified. The mean cannot be modified until all 
QC results that could be affected have been verified.  
In the Std Dev column, enter the expected standard deviation for the procedure. The system then 
completes the remaining two columns with low and high values that are two standard deviations from 
the defined mean. To change this default value, see Changing the Standard Deviation Interval. If you 
attempt to modify the standard deviation, the system will search for QC results that have not been 
verified. The standard deviation cannot be modified until all QC results that could be affected have been 
verified.  
In the Low column, modify the displayed expected low value, if necessary. This default is two standard 
deviations below the mean you entered.  
In the High column, modify the displayed expected high value, if necessary. This default is two 
standard deviations above the mean you entered. 
You also can change the values entered in the last four columns of the spreadsheet, if they are 
displayed (manufacturer's mean, standard deviation, low, and high).  

1. To change the numeric map format, select Define QC Data Map from the Action menu. The Define QC 
Data Map dialog box opens so you can change the specifications for maximum digits, minimum digits, 
and minimum decimal places. For more information about changing this information, see Defining a 
Numeric Map Format.  

2. From the Task menu, select Save to save your information.  

Defining a Numeric Map Format 

A numeric map format affects how results are entered in Accession Result Entry and how statistics display in QC 
Inquiry. To define a numeric map specific to quality control for the procedures at the specified test site, complete 
the following steps: 

1. Select a test site in the Define Test Site tab.  
2. Select the Define Procedures tab.  
3. Select Define QC Data Map from the Action menu to open the Define QC Data Map dialog box.  
4. Make a selection from the Selected Numeric Procedure list. The defaults for the numeric map for this 

procedure at the selected test site are displayed under Default Data Map. If other format specifications 
have been defined for the procedure previously, they are displayed under QC Data Map.  

5. Select the Active option.  
6. Make the necessary changes in the fields under QC Data Map: 

* In the Maximum Digits box, enter a number to indicate the maximum number of digits to be used for 
entering a QC result for this procedure by entering the appropriate number.  

In the Minimum Digits box, enter a number to indicate the minimum number of digits to be used for 
entering a QC result for this procedure.  
In the Minimum Decimal Places box, enter the minimum number of decimal places to be used for 
entering a QC result for this procedure.  

1. Click OK to save your changes.  
2. Select another procedure and repeat this process until you have made modifications to all of the 

previous lot, you can copy them from the previous lot by selecting Import Procedures from 
the Action menu. The system then imports the procedure names and information, 
displaying them in the Selected Numeric Procedures spreadsheet. You can change the 
quality control rule and statistics, if necessary.

If Options Show Manufacturer Suggested Range is selected from the View menu, the 
Selected Numeric Procedures spreadsheet also displays the following four columns: Manf 
Mean, Manf SD, Manf Low, and Manf High. If this command is not selected (no check mark 
is displayed next to it in the menu), click it to display these columns.

For the columns described below, you can enter the Low and High values without entering 
the mean and standard deviation. The system will provide those numbers based on the 
range you entered.

Modifying the data map boxes described below could cause your mean and standard 
deviation values to become invalid. If this occurs, you will need to redefine those values 
based on the applied data map values. 
The data map values described below are applied for expected values. When the system 
calculates QC statistics, those values will be calculated to one decimal place beyond the 
defined data map, based on QC industry standards.
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necessary procedures for the specified test site.  

Identifying Alpha Result-Type Procedures 

To identify the alpha result-type procedures to be included for this control at the selected test site, and specify the 
status of each alpha response, complete the following steps: 

1. Transfer the procedures to be included from the Available Alpha Procedures box to the Selected Alpha 
Procedures box. 

2. Right-click each alpha procedure to open the Alpha Responses dialog box and view the alpha responses 
for it. Select the appropriate status of each alpha response for the specified control and then click OK to 
save the alpha response information.  

3. From the Task menu, select Save to save your information.  

Changing the Standard Deviation Interval 

In the Selected Numeric Procedures spreadsheet displayed in the Define Procedures tab of the QC Maintain 
window , you are able to specify the expected mean and expected standard deviation for procedures associated 
with the control. The system then displays expected low and high values based on a default standard deviation 
interval of 2.0. To change this value, complete the following steps: 

1. Select Change SD Interval from the Action menu in the QC Maintain window when the Define 
Procedures tab is active to open the Change Standard Deviation Interval dialog box .  

2. Enter the new interval value in the Standard Deviation Interval box.  
3. Click OK to close the dialog box and apply the new value.  

Printing Bar-Code Labels 

Bar-code labels can be printed when the Define Test Site tab is active. To print bar-code labels for controls at a 
particular test site, complete the following steps: 

1. Identify the test site for which you want to print bar-code labels by selecting it from the Test Site list.  
2. Select Print Bar-Code Labels from the Action menu to open the Print Bar-Code Labels dialog box.  
3. To print bar-code labels for only the active control for this test site, deselect the Preactive QC Identifier 

option.  
4. To print bar-code labels for only the preactive control for this test site, deselect the Active QC Identifier 

option.  
5. To print bar-code labels for both the active and preactive controls, leave both options selected.  
6. Make a selection from the Label Printer box to indicate to which label printer the bar-code labels should 

be sent.  
7. Click OK to send the labels to the specified printer and close this dialog box.  

Defining a Quality Control Schedule 

When you are in the Define Test Site tab and a test site is selected you can define a schedule of controls to be 
performed at the instrument. One or more steps can be defined, with one or more controls being required for the 
completion of each step. Setting up a quality control schedule is done in the QC Scheduler window. To open this 
window, select QC Scheduler from the Action menu in the QC Maintain window. For specific information about how 
to use the QC Scheduler application, refer to the Help file in that application. 

Printing QC Audit Reports 

You can print a QC audit report of all active lots to ensure that your system is set up properly. You also have the 
option to print all active and inactive lots. To print a QC audit report, complete the following steps: 

1. Select Print QC Audit Report from the Action menu to open the Print QC Audit dialog box opens.  
2. In the Printer box, enter the printer ID of the printer where the report is to be printed.  
3. To include all inactive lots along with all active lots, select the Include Inactive Lots option.  
4. Click OK to print the QC audit report and close the Print QC Audit dialog box.  
5. Click Cancel to close the Print QC Audit dialog box without printing the report.  

Order Result Viewer 

Overview 

Use Order Result Viewer to display information pertaining to the ordered procedure and associated results. This 
information can be requested for a specified person or for a single accession number. You also can specify the type 

If the procedures for the lot being defined are the same as the procedures defined for a 
previous lot for this control, you can copy them from the previous lot by selecting Import 
Procedures from the Action menu. The system then copies the procedure names, 
displaying them in the Selected Alpha Procedures box.
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of activity for which information is to be viewed (anatomic pathology, blood bank, general laboratory, HLA, or 
microbiology). 

To view order and result information for a person, the person's name or medical record number must be entered. 
(You determine whether the name or ID field is displayed by selecting the appropriate option for the Options dialog 
box, which you can open from the View menu.) The system can retrieve orders for all dates or for a specified date 
range. To view the ordered procedures and results for a single accession number, enter the accession number. To 
display the orders for only one type of activity, select the appropriate type of activity. 

Order Result Viewer displays, at the top of the window, demographic information about the person whose orders 
were retrieved. The ordered procedures are listed below that. You can view the results of each ordered procedure. 
All pertinent comments, as well as specimen information, can be viewed. 

Order Result Viewer has two modes, Order list and Flowsheet mode. Order list mode displays all orders in 
chronological order no matter if results exist or not. Flowsheet mode displays only those order that have clinical 
results for a certain time span. Those results are arranged on a grid containing cells sorted by categories and time. 

Retrieving Person-Level Information 

1. From the Task menu, select Find Orders to open the Find Orders dialog box. The Find Orders dialog box 
is displayed automatically when you first open the application.  

2. Select the person search option. There are five possible person identifiers used: Name, Social Security 
number, medical record number, financial number, or provincial health number. You can change the 
person search option used to search by right-clicking in the first box in the Person box and selecting a 
different identifier from the context menu.  

3. If you want to select a single encounter for a person, select the Single Encounter option. If this option 
is selected, you are prompted to select an encounter as well as a person when you search for a person. 
If you do not select this option, all results for all encounters are displayed for the selected person.  

4. In the Name box, enter the person identifier of the person for which you want to search. If you are 
unsure of the person identifier, enter a partial name or number, then click the ellipsis button to display 
a list fro which you can select. Select eh Single Encounter option if you want to.  

5. In the Date Range group box, select the All Orers option to view all orders belonging to the specified 
person. Select the Orders Between Option to view all orders within a specified date range for the 
person. If this option is selected, you must specify the beginning and ending dates in the corresponding 
boxes. 

6. In the Type of Activity group box, select only the activity type options for which you want to view order 
and result information. For example, if you want to limit the orders displayed to only those for General 
Laboratory and Microbiology, deselect the Anatomic Pathology, Blood Bank, Case Integration, Helix, 
HLA, and Protocol options. If all activity types are selected, all orders from all areas of the laboratory 
will be displayed.  

7. Click OK to retrieve the orders for the specified person based on the entered date range and activity 
types.  

Retrieving Accession-Level Information 

Complete the following steps to retrieve orders and results by accession number: 

1. Select Find Orders from the Task menu to open the Find Orders dialog box. The Find Orders dialog box 
is displayed automatically when you first open the application.  

2. Select the Accession option.  
3. In the Accession box, enter the accession number for which you want to view order and result 

information.  
4. In the Type of Activity group box, select only the activity type options for which you want to view order 

and result information. For example, if you want to limit the orders displayed to only those for General 
Laboratory and Microbiology, deselect the Anatomic Pathology, Blood Bank, Case Integration, Helix, 
HLA, and Protocol options. If all activity types are selected, all orders from all areas of the laboratory 
will be displayed.  

5. Click OK to retrieve the orders for the selected accession number and activity types.  

Retrieving Group-Level Information 

Note 
The functionality used to display results in any application utilizing the flowsheet displays results using 
the collection date and time. If an orderable is ordered 2 times for the same collection date and time, 
for example if a Body Fluid Panel were ordered twice, noting 2 different body sites or a Blood Culture 
was ordered twice, then the results for the like assays in the Body Fluid Panel would display in the 
same cell. Similarly the results for the Blood Culture, since it was ordered twice for the same collection 
date and time, would appear in the same cell. Upon receipt of the specimen from the floor the 
laboratory can update the collection date and time of one of the orderables by 1 minute which will 
eliminate this concern.

If you are using Order Result Viewer for the first time, the date range is defaulted to the 
last 30 days. You can change this range by modifying the dates displayed in the boxes. 
You also can change the default number of days in the Options dialog box.
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Complete the following steps to retrieve order sand result by group ID (available in 2007.18): 

1. Select Find Orders from the Task menu to open the Find Orders dialog box. The Find Orders dialog box 
is displayed automatically when you first open the application.  

2. Select the Group ID option.  
3. In the Group ID box, enter the number of the group you want. If you do not know the group number, 

click the ellipsis to open the Group Identification Assignment window and search for the group.  
4. From the Show Orders From list, you can select whether to vie wonly the orders for the group, all 

orders for the encounter, or all orders for the person.  
5. In the Date Range group box, select the All Orders option to view all orders belonging to the specified 

person. Select the Orders Between option to view all orders within a specified date range for the 
person. If this option is selected you must specify the beginning and ending dates in the corresponding 
boxes.  

6. In the Type of Activity group box, select only the activity type options for which you want to view order 
and result information. For example, if you want to limit the orders displayed to only those for General 
Laboratory and Microbiology, deselect the Anatomic Pathology, Blood Bank, Case Integration, Helix, 
HLA, and Protocol options. If all activity types are selected, all orders from all areas of the laboratory 
will be displayed.  

7. Click OK to retrieve the orders for the specified group based on the entered date range and activity 
types. The patients with orders in the group are displayed in the Person List box. As you select a 
person, the associated orders for the group are displayed.  

Setting the Default Date Range 

Complete the following steps to change the date range this is displayed by default in the Find Orders dialog box: 

1. Select Options from the View menu to open the Options dialog box.  
2. In the Date Range group box, specify the date range. 

Select the Default All Orders option to display all orders for the selected person or accession 
number.  
To define the default number of days to look ahead from the current date, enter that 
number in the Look Ahead Days for Future Orders box.  
To define the default number of days to look back from the current date, enter that number 
in the Look Back Days for Existing Orders box.  

3. Click OK to save the selected date range as the default and close the dialog box. 

 

Setting the Default Person Search Options 

Complete the following steps to change the person search options that are displayed by default in the Find Orders 
dialog box: 

1. From the View menu, select Options to open the Options dialog box  
2. In the Find Person group box, select Name, SSN, MRN, FIN NBR, or PHN. Your selection sill be the 

person identifier displayed when you open the Find Orders dialog box. 

3. If you want the Single Encounter option to be selected by default when you open the Find Orders dialog 
box, select the Order List Single Encounter option.  

4. Click OK to save the selected default settings and close the dialog box.  

Order List Tasks 

Viewing Orders 

Regardless of whether the information is retrieved at the person or accession level, the same information is 
displayed. The demographics for the person are displayed at the top of the window, and the orders are displayed in 
a spreadsheet below. The list of orders is based on the type of activity and the dates specified. 

To view the results associated with a specific order, select the order, then select Results from the View 
menu to open the [Activity type] Result window to display the results associated with the selected 
order. You also can double-click the selected row to open this window. When you are finished reviewing 
the results, click Close to close this dialog box and return to the Order Result Viewer [Order List] 
window.  
To view detailed container information for a particular order, select the order, then select Container 
Details from the View menu. You can also choose the Container Inquiry shortcut on your Toolbar menu. 
The Container Inquiry application opens and the selected order is displayed.  

You can view only results for a specified date range in the Flowsheet mode. If you select 
the Default All Orders option in the Options dialog box, the Flowsheet still will default to 
the date range specified. The default all orders option can be used only in the Order List 
mode.

Not all person search options may be available at your site. 
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To branch to Accession Result Entry with a particular order, select the order, then select Go To 
Accession Result Entry from the View menu. You can also choose the Accession Result Entry shortcut 
on your toolbar menu. The Accession Result Entry application opens and the selected order is displayed.  
To branch to Specimen Login with a particular order, select the order, and then select Go To Specimen 
Login from the View menu. You can also choose the Specimen Login shortcut on your toolbar menu. 
The Specimen Login application opens and the selected information is displayed.  
To add or view non-clinical document images associated with the patient, encounter, request ID, or 
order, select Images from the View menu to open the Document Image Library. If existing non-clinical 
document images are associated with an order, the View Image icon is displayed in the spreadsheet.  
To view results for another person or another accession number, select Find Orders from the Task 
menu to open the Find Orders dialog box.  

Cancelling Orders 

You can cancel orders from Order Result Viewer, expect for orders that are Complete, Canceled, Discontinued, and 
In Process. Complete the following steps to cancel orders: 

1. Select the order you want to cancel.  
2. From the Task Menu, select Cancel Order. The Cancel order dialog box is displayed.  
3. Select a cancel reason from the Cancel Reason box, and then select Cancel Order. The eslected order is 

canceled and the Cancel Order dialog box is closed.  

Resending Results to an Outbound Interface 

If your site sends PathNet results through an outbound interface, it may sometimes be necessary to resend results 
through that interface. Order Result Viewer allows you to resend results without marking the results as Corrected. 

Complete the following steps to resend results to an outbound interface: 

1. Select the order for which you want to resend results.  
2. From the Task menu, select Resend Result to ESO. The system displays a message asking you to 

confirm the command.  
3. Click OK to close the message and resend the results.  

Assigning Orders to Groups 

You can assign orders to a group, which allows you to associate related orders for viewing in a batch. You can view 
the orders in a group when you search by group ID. Complete the following steps to associate an order with a 
group (available in 2007.18): 

1. In Order List mode, search for the order you want to associate with a group.  
2. Select the order, and select Assign Order to Group from the Task menu. The Group Identification 

Assignment window is displayed.  
3. Select the criteria you want to search on. You can search based on the type of group, the group name 

or number, the status of the group, and a date range. If you do not know the name of the group you 
are searching for, you can enter an asterisk (*y) in the Group Name box.  

4. Once you entered your search criteria, click Search. Any groups meeting the selected criteria are 
displayed in the spreadsheet on the right.  

5. Select the group you want to add the order to, and click Assign. The Group Identification Assignment 
window is closed, and the name and number of the group are displayed in the Group ID Name and 
Group ID Number columns for the order.  

Exporting Group Details to XML 

You can export information about a group of orders to an XML file, which allows you to use the data outside the 
system. Complete the following steps to export a group : 

1. In Order List mode, search for the group you want to export.  
2. Once the group is displayed, select Export Group Details To XML from the Task menu. The Save As 

dialog box is displayed.  
3. Select the location where you want to save the file.  
4. In the File Name box, enter the name you want to associate with the file.  
5. Click Save. The group information is saved as an XML file.  

Customizing the Order List Display 

You can customize the display format for the spreadsheet in the Order Result Viewer [Order List] window to suit 
your needs using the Customize Order List: Customize Display dialog box. You can specify which columns are 
displayed in the spreadsheet and the order of the columns. 

Complete the following steps to customize the spreadsheet: 

1. Select Customize Orders List from the View menu to open the Customize Order List: Customize Display 
dialog box.  

Release Considerations 
This functionality is available with the 2007.18 Release Update. 
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2. To select a column heading for display, click the check box under the heading. (Red check marks 
indicate the column headings that will be displayed.) To deselect a column heading for display, click the 
check box with a red check mark in it. 

3. To arrange the order in which the columns display, select the heading you want to move and click Left 
or Right to move it to the preferred position. Continue to move columns until the arrangement you 
want is achieved.  

4. Click OK to save the changes and close the dialog box.  

Customizing the Person List Display 

You can customize the display format for the Person List spreadsheet in Order List mode of Order Result Viewer. 
The Person List is displayed when you search for orders by Group ID. You can specify which columns are displayed 
in the spreadsheet and the order of the columns. 

Complete the following steps to customize the spreadsheet: 

1. Select Customize Person List from the View menu to open the Customize Person List dialog box.  
2. To select a column heading for display, select the check box under the heading. (Red check marks 

indicate the column headings that are displayed.) To deselect a column heading for display, select the 
check box with a red check mark in it. 

Select from the following options to customize the Person List: 

1. MRN--displays the medical record number of the patient.  
2. Gender---displays the sex of the patient.  
3. Age---displays the age of the patient.  

1. To arrange the order in which the columns display, select the heading you want to move and click Left 
or Right to move it to the preferred position. Continue to move columns until the arrangement you 
want is achieved.  

2. Click OK to save the changes and close the dialog box.  

Viewing the Review Path 

You can view the review path that a selected item must pass through to be approved. Complete the following steps 
to view the review hierarchy. 

1. Select the row whose review hierarchy you want to view.  
2. From the View menu, select View Review Path. The Review Path dialog box is displayed. It displays 

information about the order along with the various levels of review the result must pass through. For 
each level of the hierarchy, the queue name, review type, and approver ID and actions taken are also 
displayed.  

3. When you are finished viewing the hierarchy information, click Close to close the Review Path dialog 
box.  

Generating Manual Expedite Charts 

Complete the following steps to generate a manual expedite chart: 

1. From the Task menu, select Manual Expedite. The Manual Expedite window opens.  
2. In the Print to options group box, select the appropriate option. A list of devices available at the 

selected destination is displayed. If no device is found, then the manual expedite request is not 
allowed. The following options require a device cross-reference. 

Select the Locations option to displays all the locations from which the chart can be printed.  
Select the Related Providers option to display the providers to which the chart can be 
printed. By default, on the related providers are shown, but you can display all providers by 
right-clicking on the Related Providers option button, and then select All Providers from the 
context menu.  
Select the Service Resources option to display all the service devices to which the chart can 
be printed.  
Select Printers option to display all the output devices to which the report can be chart, 
such as a printer or fax.  

3. Make a selection of the chart format to be used in the Select Chart Format option.  
4. In the Print time option group box, select the appropriate option. Print Now expedites a chart 

immediately for reports in transcribed or final status. Print upon verificiation/authentication enables a 
chart to print immediately after being signed out or verified.  

5. Choose the number of Copies you would like to print.  

Note 
Column headings with the term Locked next to the check mark are required for display. 
Typically, Collect Date and Order are required. 

Note 
Column headings with the term Locked next to the check mark are required for display.
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6. Select the Cumulative box if you would like to print everything that has been verified since the patient's 
admit date.  

Flowsheet Tasks 

Getting More Information About a Result in Flowsheet Mode 

As you are viewing the posted results for a patient in Flowsheet mode, you also can view details regarding the 
displayed results. Complete the following steps to view additional information about a result: 

1. While in Flowsheet mode, right click and select View Details from the context menu to open the Result 
Details window. You also can double-click a result to open the Result Details window. 

* If a result document image is associated with the case or result assay, click Images to open the 
Result Document Image Viewer and view the image.  

2. Click a tab to display the aspect of the result you want to view. For example: Click the Action List tab to 
see who performed or modified the result or the Comments tab to read comments associated with the 
result, if any.  

3. Click Close to close the dialog box and return to the previous window.  

Using the Seeker to Find Results 

The Flowsheet Seeker is a quick locator tool that enables you to view a thumbnail sketch of the selected flowsheet 
and hone in on an area that contains results. Results are represented graphically by vertical line segments placed 
in the time sequence that they occurred. Critical result values are represented by red lines. A period of intense 
result activity causes the lines to merge into solid blocks or rectangles. The Flowsheet Seeker enables you to scroll 
quickly to a location in the Flowsheet for a closer look. Since it is small, you can drag the Seeker to a corner of your
desktop and continue working with the Flowsheet. 

Complete the following steps to use the Flowsheet Seeker: 

1. While in Flowsheet mode, select Flowsheet Seeker from the View menu. The Flowsheet Seeker is 
displayed representing the portion of the Flowsheet that matches the search criteria you entered. The 
outlined rectangle represents the area currently displayed on screen.  

2. Drag the rectangle to any part of the Seeker. Simultaneously, the view in your Flowsheet window 
changes to correspond.  

3. Click the close icon at the far right of the title bar to close the Flowsheet Seeker.  
h.3 Graphing a Patient's Test Results  

While you are viewing a patient's flowsheet, you can graph the numeric result values. The graph plots the values 
and displays units of measure along the y-axis. The values must all have the same units of measure in order for a 
graph to be generated. If no units are displayed, the graph is generated, but no unit label is displayed along the y-
axis. 

Complete the following steps to view or print a graph of results: 

1. In Flowsheet mode, select the name of a specific procedure for which results are given in a numeric 
value. (You can select either the row or the check box to the left of it.) A check mark is displayed in the 
check box.  

2. If you want more than one graph generated at the same time, select another procedure name.  
3. Select Graph from the View menu. The system generates and displays a graph for each selected 

procedure in the Flowsheet Graph window.  
4. Click Combine to plot the selected results on the same axis (without units displayed).  
5. Click Split to plot each result on a separate graph. 

6. To access additional information about any value represented on the graph, click the circle or shape 
surrounding the plotted value.  

7. To print the graph you are viewing, click Print. If you are viewing a set of graphs, a dialog box prompts 
you to select which graph or graphs you want to print.  

8. To copy a graph to the clipboard, select Copy. This stores the graph as a bitmap (graphic) that can be 
pasted into a document. Only one graph can be copied at a time.  

9. Click Close to return to the previous window.  

Customizing the Flowsheet Display 

The Customize Flowsheet window enables you to customize the display formats used in the Order Result Viewer 
[Flowsheet] window to suit your needs. You can specify the time scale and orientation of the data displayed, as well 

Note 
The window displays a set of tabs appropriate to the result selected. Not all of the tabs are 
available for each result.

Note 
Whether the results are graphed together or separate, the time continuum represented 
along the x-axis is consistent for all graphs. This enables you to compare one result to 
another for possible cause/effect relationships.
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as the font size and column width. You also can choose to display the units of measure next to numerical values. 

Complete the following steps to customize the flowsheet: 
1. Select Customize Flowsheet from the View menu to open the Customize Flowsheet window. 
2. Select the following options to customize the flowsheet: 

To display the results in the earliest to the latest order, select the Chronological option. The most 
recent result is at the bottom of the list.  
To display the results in the latest to earliest order, select the Reverse Chronological option. The most 
recent result is at the top of the list.  
To display the time increments horizontally at the top of the flowsheet, select the Horizontal option. The 
result categories are vertical on the left of the flowsheet.  
To display the time increments vertically on the left of the flowsheet, select the Vertical option. The 
result categories are horizontal on the top of the flowsheet.  
To define the font size, select a larger or smaller point size from the Font Size list. The current font size 
is displayed.  
To define the column width, select a value from 5 to 50.  
To display the units of measurement next to the numerical values, select the Units of Measure option.  

3. Click OK to close the window and save the changes. 

Container Inquiry Overview 

Overview 

Use Container Inquiry to view detailed information about specimen containers based on the accession number 
assigned to the collection. You also can view the orders included in each container. The list includes containers that 
have been split into aliquots; you can view the orders included in each aliquot. 

Individual containers can be selected in Container Inquiry and an event log is displayed. This log shows when the 
container was collected, who collected it, and where it was collected. There is a separate event each time the 
container is logged in at a new location, with the date, time, the ID of the person who logged it in, and the log-in 
location. If a container is logged as missed, the log will show a missed event, including the reason it was missed. 

Chart Request Overview 

(Chartrequest.exe) 

 

Chart Request is Charting's interactive tool for producing on-demand charts. Rather than waiting for charts to be 
produced by distributions or triggered by order or result activity, you can use Chart Request to generate a chart 
immediately for any patient you identify using any chart format you specify. This on-demand capability can be 
particularly useful when a chart is misplaced, when a provider unexpectedly requests an additional copy, or when a 
user is testing the database. 

Chart Request provides the user with a great deal of flexibility. It allows you to specify the level at which a patient's 
results should be printed (person-, encounter- or accession-level), the chart format with which to produce the 
chart, and the output destination from which the chart will be printed. You can also use Chart Request to determine 
which pages and dates to include in the range, whether pending procedures should be included on the chart, which 
physicians will receive chart copies, and if additional copies should be produced. In addition, Chart Request 
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provides extensive search capabilities, allowing you to locate a patient for whom you have very limited 
demographic information. 

On-Demand Chart 

To request an on-demand chart, you must identify the patient for whom the chart will be produced. In order to 
identify the patient, you are first required to define the scope of the chart. The chart scope determines the level at 
which procedure results will be included in the chart. Chart Request provides the following chart scopes, each of 
which can be used regardless of the patient's discharge status. 

Person. The Person scope produces charts that contain result information for all encounters associated with the 
specified patient. For example, a patient was admitted to your institution to undergo testing three weeks ago and 
was then released. That same patient was admitted again to undergo additional procedures three days ago. When 
you request an on-demand chart for this patient using the Person scope, the chart produced will contain results 
from the previous encounter as well as any procedure results that have been verified during the present encounter. 
This type of chart scope facilitates monitoring the condition of patients who are admitted to your institution more 
than once. 

 

1. In the Chart Scope frame on the Initial screen, select the Person option  
2. If you know the medical record number of the patient for whom the chart will be produced, enter it in 

the Med Rec Nbr field. You can select a patient using this field alone.  
3. If you know the financial number of the patient for whom the chart will be produced, enter it in the Fin 

Nbr field. You can select a patient using this field alone as well.  
4. If you know the name of the patient for whom the chart will be produced, enter it in the Name field. 

You can select a patient using this field alone, but keep in mind that because patient names are not 
unique, the system will display all patients and encounters whose names match your entry to this field.  

5. Click Find Match. This will open the Patient Search window, picture here . If you entered a valid value in 
the Med Rec Nbr or the Fin Nbr field, the system displays the patient's name in the list box of the 
Patient Search window. If this is the correct patient, highlight the patient's name and click OK. The 
Request A Chart screen is redisplayed with the Name, Med Rec Nbr, and Fin Nbr fields as well as the 
Related Providers spreadsheet filled. 

a. If the only field you completed was the Name field and there is only one patient with the 
name you entered, or if you completed the Name field and entered a valid value in the Med 
Rec Nbr or the Fin Nbr field, the system displays the patient's name in the list box of the 
Patient Search window. If this is the correct patient,highlight the patient's name and click 
OK. The Request A Chart screen is redisplayed with the Name, Med Rec Nbr, and Fin Nbr 
fields as well as the Related Providers spreadsheet filled.  

b. If you only field you completed was the Name field and there is more than one patient or 
encounter with the same name that you entered, the system displays all patient names that 
match the existing criteria in the list box of the Patient Search window. Select the 
appropriate name from the list and click OK. The Request A Chart screen is redisplayed with 
the Name, Med Rec Nbr, and Fin Nbr fields as well as the Related Providers spreadsheet 
filled.  

6. If at any point you wish to amend your search, you can either click the Reset button to clear the fields 
in the Patient Search window, or you can click Cancel to return to the Request a Chart screen. 

a. When you select the Person scope and click More Filters, the system displays the Patient 
Search window. This window contains six fields you can use to narrow your search for a 
patient. You can use any one of the fields or any combination of them in your search. 
Obviously, the more fields you fill in, the better a chance you will find the exact patient for 
which you are searching. The fields you can complete are listed below. 

Name- Enter a full or partial name into this field. Partial names will bring up all 
names containing the portion you have entered. This field is also present on the 
Request a Chart screen.  
MRN- Enter a Medical Record Number into this field. This field is also present on 
the Request a Chart screen.  
SSN- Enter a Social Security Number into this field.  
Birth Date- Enter a birth date into this field. You can also use the spin box or 
the drop-down calendar to select a date.  
Gender- Select a gender from the drop-down list. Your choices are Male, 
Female, and Unknown.  
FIN NBR- Enter a Financial Number into this field. This field is also present on 
the Request a Chart screen.  

7. When you have finished filling out fields, click the Search button to bring up a list of potential patients. 
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a. Encounter. The Encounter scope generates charts that include all the result information 
that has been verified throughout a patient's encounter. This type of chart scope is used by 
audiences who generally require comprehensive records of a patient's stay, such as 
physicians or Medical Records.  

b. Accession. The Accession scope produces a chart that contains the verified results for a 
single accession number, which is assigned during order entry. This type of chart scope is 
typically used for Radiology, Anatomic Pathology, Pulmonary Studies, and Laboratory 
results. 

  

When you select the Accession scope and click More Filters, the system displays the Select Chart screen. Complete 
the following steps to select a patient. 

 

1. Enter the name of the patient for whom you want to produce a chart in the Name field.  
2. If you are uncertain how to spell the patient's name, you can select the Soundex Search option to help 

you locate the patient. The Soundex Search is an intuitive tool that searches for patient names based 
on phonetics, rather than spelling. For example, if you are trying to locate a patient with the last name 
of CLINE, but spell it K-L-E-I-N, the Soundex Search will locate all names whose spellings make a 
sound similar to that of CLINE, regardless of their actual spellings.  

3. Use the drop-down list in the Sex field to select the gender of the patient for whom you want to 
produce a chart. The list includes an UNKNOWN option.  

4. In the Birthdate field, enter the date of birth of the patient for whom you want to produce a chart.  
5. In the Age frame, complete the three following fields:  

Start. Enter a number to begin the range of the patient's age.  
End. Enter a number to end the range of the patient's age.  
Units. Enter a unit of time to correspond to the patient's age range (days, months, or years).  

1. Use the drop-down list in the Facility field to select the name of the facility at which the patient is 
registered. If the facility you selected has no nursing stations associated with is, advance to the Medical 
service field. If you select a facility for which nursing stations are defined, the Nurse Unit field is 
activated.  

2. Use the drop-down list in the Nurse Unit field to select the nursing station in which the patient is 
located. If you enter a nursing station for which rooms have been defined, the Room field is activated.  

3. Use the drop-down list in the Room field to select the room in which the patient in located. If you select 
a room for which beds are defined, the Bed field is activated.  

4. Use the drop-down list in the Bed field to select the bed in which the patient is located.  
5. Use the drop-down list in the Medical Service field to select the type of medical service the patient has 

received.  
6. In the Start Order Date field, enter a date to begin the range of dates the system will include in the 

search or use the drop-down calendar to select a starting date.  
7. In the End Order Date field, enter a date to end the range of order dates the system will include in the 

search or use the drop-down calendar to select an ending date.  
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8. In the Catalog Type field, enter or select from the drop-down list the type of procedure (such as 
radiology, pharmacy, or surgery) the patient you are trying to locate has received to be included in the 
search.  

9. In the Procedure field, type the first few letters of the procedure (related to the catalog type you 
defined in the previous field) that was ordered for the patient you are trying to locate. The system 
populates the drop-down list with valid procedures from which you can select the appropriate one to be 
included in the search.  

10. Click Find Matches. The system displays the patient or patients who match the search criteria in the 
Matches spreadsheet below. 

Changing the Column order 

If you have selected Accession scope and have not entered sufficient patient information to narrow the search to 
just one patient (or if you click the More Filters button), you will be taken to the Select Chart window. This window 
displays patient information in a particular order. For example, you may see Patient Name followed by Medical 
Record Number followed by Date of Birth and so on. In some cases, you may want to change the order in which 
this information is displayed. To change the display order, complete the following steps. 

1. In the View drop-down menu, select Options. This will open the View Options window.  
2. Click on the Preferences tab.  
3. On the right side of the window, you will see a box with the heading Chart Details. Within this box are 

all of the patient details that are included in the Match window, along with the order in which they are 
displayed. If there is a particular field in this box you wish to move, single-click on it. This will highlight 
the field.  

4. Using the up and down arrow keys next to the box, move the highlighted field to a new position. For 
example, let's say that Medical Record Number was originally fifth in the list. This means that the 
Medical Record Number would be the fifth patient detail displayed in the Match window as you scrolled 
right. Now if you highlighted the Medical Record Number field and used the up arrow key to move it to 
third on the list, then it would appear as the third patient detail displayed in the Match window as you 
scrolled right instead of fifth.  

5. When you have finished moving all of the fields you wish to reorder, click OK. This will take you back to 
the main Chart Request window. 

After you have entered all of your search criteria and generated a list of potential matches, you may wish to sort 
the patient list to aid in your search for the correct patient. You can sort the list by any of the columns present in 
the Patient or Encounter Search windows or in the Select Chart spreadsheet. To do this, click on the column 
heading of the field you wish to sort by. This will rearrange the list to sort by the selected field. For example, if you 
click the MRN column in the Patient Search window, the list of patients will be listed in order of Medical Record 
Number, from smallest to largest. Clicking the column again will reverse the sorting to go from largest number to 
smallest number. 

Selecting a Format 

When you request a chart to be printed for a patient, you must specify which chart format you want to use to 
produce the chart. To do this, select a chart format from the Chart Format drop-down list. Your selection will then 
appear in the Chart Format field. 

 

 

When you request a chart to be printed for a patient, you must specify which chart format you want to use to 
produce the chart. To do this, select a chart format from the Chart Format drop-down list. Your selection will then 
appear in the Chart Format field. 

Note 
It is generally not necessary to enter values in all fields to locate a patient. However, the 
more fields you complete, the more the search for the patient will be narrowed.

Note 
Do not click on and alter settings in the Troubleshooting tab in the View Options window. 
This is for engineer use only and will not impact the performance of your application.
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When you request a chart, you must specify whether pending events will be printed on the chart. To do this, select 
a value from the Events drop-down list. The possible selections are listed below. 

Print verified results only. Select this option if you want only verified procedures to be included in 
the chart.  
Print verified and pending. Select this option if you want the chart to include both verified and 
outstanding procedures.  
Print verified and performed. Select this option if you want the chart to include verified procedures 
as well as those that have been performed but are awaiting verification. 
Your selection will then appear in the Events field.  

Selecting a Printer 

You must specify the output device (such as a printer or fax machine) that will be used to print a chart. To do this, 
select a device from the Printer drop-down list. Your selection will then appear in the Printer field. 

 

 

If the printer you selected is an ASCII printer or a fax machine, then the Remote Report Distribution Selection 
window, pictured here, appears. The instructions below concern this new window. If you have selected an ASCII 
printer or a fax machine, follow the instructions below. 

1. If a fax machine has been designated, you will have to enter a phone number in the Phone # box to 
proceed. This field will be blocked out if you have selected an ASCII printer.  

2. If you want the chart to be ad hocked immediately, select Scheduled in the bottom portion of the 
window. This will block out the date and time from being changed. If you would like to designate the 
date and time the chart will be ad hocked, select Non-Scheduled in the bottom portion of the window. 
You can then enter a specific date and time to send the chart to your specified RRD device.  

3. Click OK when you have completed filling out the RRD selection window.  

Creating Defaults 

You may find yourself consistently sending charts to the same printer, or using the same chart format on a regular 
basis. For this reason, Chart Request allows you to set up some defaults in the request window to simplify the 
requesting procedure. You can set up person-, encounter- or accession-level defaults with the following variables: 
chart format, printer, and pending event print selection (determining pending events). To set up these defaults, 
complete the steps below. 

1. In the View drop-down menu, select Options. This will open the View Options window, illustrated here. 

 
2. Click on the Preferences tab.  
3. In the Chart Scope section, select Person, Encounter, or Accession. This will set the default request 

scope.  
4. (Optional) From the chart format list box, select the chart format that you wish to have displayed as 

the default. If you don't want a particular chart format displayed as the default, leave this box blank.  
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5. (Optional) From the events list box, select the event category that you wish to have displayed as the 
default. If you don't make a selection, the default already in place will remain.  

6. (Optional) From the printer list box, select the printer that you wish to have displayed as the default. If 
you don't want a particular printer displayed as the default, leave this box blank.  

7. Click OK. The new defaults will now be in place.  

You can change the defaults at any time by going back into the View Options window and altering the settings. 

Define print range 

In the Print Range frame, the default print range is set to All Dates and All Pages. When a chart is requested using 
these settings, the chart will include information for all dates of the patient's stay, and all pages of the chart will be 
produced. 

 

You can keep these settings or change them to specify a range of dates or pages, or both. For example, you may 
be missing the first two pages of a patient's chart in which case, rather than reprinting the chart in its entirety, you 
can specify that only the first two pages be printed. Or, if a patient has been in the hospital for an extended period 
of time, you might not want a chart containing procedures for every day of that patient's stay and can therefore 
specify that procedures only be included for a particular range of dates. 

Complete the following steps to specify a range of dates. 

1. Clear the All Dates option. 

  

2. In the Start Date field, enter a date to begin the range of dates for which procedures will be included in 
the chart or click the button to use the drop-down calendar to specify the beginning date. You can also 
use the arrows in the spin box to modify the dates.  

3. In the Start Time field, enter a beginning time to correspond with the beginning date. You can also use 
the arrows in the spin box to modify the time.  

4. In the End Date field, enter a date to end the range of dates for which procedures will be included in 
the chart or use the drop-down calendar to specify the ending date. You can also use the arrows in the 
spin box to modify the dates.  

5. In the End Time field, enter an ending time to correspond to the ending date. You can also use the 
arrows in the spin box to modify the time  

Complete the following steps to specify a range of pages. 

1. Clear the All Pages option. 

  

2. In the Page From field, enter the page number to begin the range of pages of the chart to be printed.  
3. In the Page To field, enter the page number to end the range of pages of the chart to be printed.  

Requesting Provider/Additional Copies 

Once a patient has been selected and appears in the Chart Scope frame, the physician or physicians associated 
with that patient are displayed in spreadsheet format in the Copies frame. The default setting for this frame is to 
generate a copy only for the person requesting the chart. 

You can keep this setting, or you can change it to specify particular physicians for whom copies of the chart are to 
be produced. Complete the following steps to do so. 

1. In the Related Providers spreadsheet, click on the names of the providers who are to receive a chart. 
This will highlight the names of the providers. To deselect a provider, simply click them again.  

2. If you wish for all of the providers associated with the patient to receive a chart, select the All Providers 
box.  

You can also specify the number of additional copies of the chart--besides the physician copies--that are to be 
produced by using the spin box in the Additional Copies field. You can specify up to 25 copies. 

When doctors appear in the Related Providers spreadsheet, they are initially sorted in alphabetical order. This may 
not be the most convenient way for you to view the list of physicians. For this reason, you can sort the list by any 
of the columns present in the spreadsheet. To do this, click on the column heading of the field you wish to sort by. 
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This will rearrange the list to sort by the selected field. For example, if you click the Role column, the list of doctors 
will be listed in alphabetical order by their role. Clicking the column again will reverse the sorting and list the 
doctors in reverse alphabetical order by their role. 

Submitting the Request 

When you have identified the patient for whom you want to generate a chart and defined all the necessary 
parameters, you are ready to submit the request to print the chart. Complete the following steps to do so.  

1. On the Initial screen, click Print Chart.  
2. Click OK.  
3. If there are any parameters that have not been defined, the system issues a prompt similar to the one 

below, depending on the missing parameter.  
4. Click OK.  
5. Define the missing parameter and resubmit the request.  

If you decide while filling out patient parameters that you would like to start over entering the information, you 
don't need to clear all of the Request a Chart fields manually. There is a simple procedure to take care of this. 
Simply click the Clear Chart button and all of the fields relating to the patient (Name, Medical Record Number, 
Financial Number, and Accession Number) will be cleared. 

To exit Chart Request at any time, select Exit from the Task menu or click the X button in the upper right-hand 
corner of the application. 
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